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Getting Started 
 

Welcome to Zoho CRM, an On-demand 

Customer Relationship Management software 

for managing your customer relations in a 

better way. Zoho CRM software helps 

streamlining your organization-wide sales, 

marketing, customer support, and inventory 

management functions in a single system. 

Target Audience 

 Sales Reps, Managers and Executives  

 Lead Managers, Event Managers and 

Marketing Managers 

 Customer Support Agents, Support 

Managers and Executives 

 Accounting Managers and Stock 

Handlers 

 Business Managers, Executives and Top Management 

 CRM System Integrators  

  

 

 

 

 

 

 

 

 

http://zohocrm.wiki.zoho.com/Customer-Support.html
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The Zoho CRM software comprises of the following business functions: 

Sales Force Automation Marketing Automation 

 Lead Management  

 Account Management  

 Contact Management  

 Sales Management  

 Sales Forecasts  

 Sales Quotes Management  

 Sales Orders  

 Invoice Management  

 Campaign Management  

 Lead Generation  

 Email Marketing  

Customer Support & Service Inventory Management 

 Case Management  

 Solution Management  

 Products Catalog  

 Price Books  

 Vendor Management (Procurement 

Process)  

 Purchase Orders  

Analytics Add - Ons 

 Reports  

 Dashboards  

 Outlook Plug-in  

 Web-to-Lead forms  

 Web-to-Case forms  

 

 

 

 

 

 

 

 

http://zohocrm.wiki.zoho.com/WorkingWithLeads.html
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html
http://zohocrm.wiki.zoho.com/Working-with-Campaigns.html
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html
http://zohocrm.wiki.zoho.com/Email-Templates.html
http://zohocrm.wiki.zoho.com/Working-with-Cases.html
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html
http://zohocrm.wiki.zoho.com/Working-with-Products.html
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html
http://zohocrm.wiki.zoho.com/Working-with-Reports.html
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html
http://zohocrm.wiki.zoho.com/Outlook-Plugin.html
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html
http://zohocrm.wiki.zoho.com/Working-with-Cases.html
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Zoho CRM Modules 

The following table describes various icons in Zoho CRM. 

Module  Icon  

   

  

  

  

  

  

  

  

  

  

  

Module  Icon  

Task 
 

Product 
 

Event 
 

Price Book 
 

Lead 
 

Quote 
 

Account 
 

Purchase 

Order  

Contact 
 

Sales Order 
 

Potential 
 

Invoice 
 

Forecast 
 

User 

Lookup  

Campaign 
 

Calendar 

Day  

Case 
 

Calendar 

Week  

Solution 
 

Calendar 

Month  
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Campaign Management 

Campaign management allows you to manage your entire marketing process by which marketing 

campaigns are planned, produced, distributed and analyzed. This includes planning the 

campaign, preparing your mailing list, executing the campaign and then analyzing the results.  

You can use the Campaigns module for the following:  

 Planning marketing activities and developing campaign hierarchies 

 Outlining marketing campaign objectives 

 Defining campaign success metrics 

 Building and testing sample campaigns on a subset of customer data 

 Storing and reusing content from previous marketing campaigns 

 Measuring campaign effectiveness by linking directly to the leads and potentials 

 Tracking customer inquiries related directly to campaigns.  

 Tracking sales force closures related directly to campaigns.  

You can perform the following operations in the Campaigns module:  

 Navigate campaigns  

 Search campaigns  

 Create list views  

 Create campaigns  

 Associate campaign with other records  

 Change campaign owner  

 Export campaigns  

 Print campaign details  

 View reports  

 Delete campaigns  

 Customize campaigns  

Navigating Campaigns  

(Access Privilege: Read permission)  

You can navigate the campaigns according to the status of the campaigns.  

To navigate campaigns  

1. Click the Campaigns tab.  

http://zohocrm.wiki.zoho.com/#Navigating_Campaigns
http://zohocrm.wiki.zoho.com/#Searching_Campaigns
http://zohocrm.wiki.zoho.com/#List_Views
http://zohocrm.wiki.zoho.com/#Creating_Campaigns
http://zohocrm.wiki.zoho.com/#Associating_Campaigns
http://zohocrm.wiki.zoho.com/#Exporting_Campaigns
http://zohocrm.wiki.zoho.com/#Exporting_Campaigns
http://zohocrm.wiki.zoho.com/#Printing_Campaign_Details
http://zohocrm.wiki.zoho.com/#Viewing_Campaign_Reports
http://zohocrm.wiki.zoho.com/#Deleting_Campaigns
http://zohocrm.wiki.zoho.com/#Customizing_campaigns
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2. In the Campaigns Home page, under the Campaign List section, select one of the views 

from Select View drop-down list to display the list of Campaigns according to the status 

of the Campaigns (For example, Contacted, Hot, Won, and others).  

3. In the Campaign List section, click the Start, Previous, Next, or End links to access the 

respective list of Campaigns.  

Searching Campaigns  

(Access Privilege: Read permission)  

You can search the campaigns alphabetically or filling the required information in Search box.  

To search campaigns  

1. Click the Campaigns tab.  

2. In the Campaigns Home page, under Campaign Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Campaign List page, a list of Campaigns is displayed as per search criteria.  

(Access Privilege: Read/Write permissions)  

Creating List Views  

In the Campaign List you can create/modify/delete the custom views, sort columns in the list 

view (ascending/descending order), search the records available in the current list view. In 

addition, you can modify some of the columns in standard list views. By default, the following 

standard list views are available in the Campaigns module:  

 All Campaigns  

 All Active Campaigns  

 My Active Campaigns  

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

20 ©2007, AdventNet Inc. All rights reserved.  

 

To create custom views  

1. Click the Campaigns tab.  

2. In the Campaigns Home page, under Campaign List section, click the Create View link. 

Note: Under Campaign List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Campaigns  

(Access Privilege: Read/Write permission)  

In Zoho CRM, you can create campaigns by manually entering the data in Campaign Details 

form, quickly from the Quick Create section, or duplicating from the existing campaign 

information.  

In the Campaign: Edit form, you need to specify the campaign-related information. The 

following table provides descriptions of the various fields in the form.  

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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List of Standard Campaign-related Fields  

Field Name Description Data Type 

Campaign Owner Specify the owner name of the campaign. Lookup 

Campaign Name* Specify the name of the campaign. 
Text box, alphanumeric 

(40) 

Type Select the type of the campaign. Check box 

Status Select the status of the campaign. Pick List 

Start Date 
Specify the date on which the campaign 

starts. 
Date 

End Date 
Specify the date on which the campaign 

ends. 
Date 

Expected Revenue 
Specify the revenue expected after 

launching the campaign. 
Currency 

Actual Cost 
Specify the actual amount spent on the 

campaign. 
Currency 

Budgeted Cost 
Specify the planned amount to be spent on 

the campaign. 
Currency 

Expected Response Specify the campaign turnout percentage. Percent 

Number sent 
Specify the number of leads/contacts to 

whom the campaign details has been sent. 
Integer 

Description 
Specify additional details about the 

campaign. 
Text area (32KB) 

To create campaigns individually  

1. Click the New Campaign link.  

2. In the Campaign: page, specify the campaign-related information. 

Note: The Campaign Name is a mandatory field. Refer to the 

List of Standard Campaign-related Fields section for more details. 

3. Click Save. Campaign details are displayed in Campaign: <Campaign Name> page 

where you can perform the additional operations. Refer to the Associating Campaigns 

with Other Records section for more details.  

 

http://zohocrm.wiki.zoho.com/#Standard_Campaign_fields
http://zohocrm.wiki.zoho.com/#Associating_Campaigns
http://zohocrm.wiki.zoho.com/#Associating_Campaigns
http://zohocrm.wiki.zoho.com/#Associating_Campaigns
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To create campaigns instantly  

1. Click the Campaigns tab.  

2. In the Quick Create (left hand-side bar) section, specify the campaign details, such as 

Campaign Name, Status, Start Date, End Date, and Expected Revenue.  

3. Click Save. Campaign details are displayed in Campaigns Home page, where you can 

update the additional details.  

To create campaigns from the existing campaign  

1. Click the Campaigns tab.  

2. In the Campaign List view page, select the Campaign to be duplicated.  

3. In the Campaign: <Campaign Name> page, click the Clone button.  

4. In the Edit: <Campaign Name> page, modify some of the Campaign details.  

5. Click Save. Campaign details are displayed in the Campaign: <Campaign Name> page 

where you can perform the additional operations.  

Associating Campaigns with Other Records  

(Access Privilege: Read/Write permission)  

After creating Campaigns, you may need to associate Campaigns with other records, such as 

tasks, events, e-mails, products, attachments, and notes until the Campaign is reached to a certain 

stage where it can be converted to potential as per your organization's sales process.  

To associate campaign with other records  

1. In the Campaign: <Campaign Name> page, you can update the following details:  

o Open Activities: To add tasks and events.  

o Closed Activities: To display the closed tasks and events.  

o Leads: To display the leads generated through campaign.  

o Potentials: To display the potentials converted through campaign.  

o Attachments & Notes: To attach documents and notes to the Campaign  

2. After updating the associated records, you can proceed to the next record.  
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Exporting Campaigns  

(Access Privilege: Export permission)  

Occasionally it is very useful to export the campaigns from the Zoho CRM system to 

Spreadsheet programs, such as Microsoft Excel, OpenOffice, and others for further data analysis.  

To export campaigns to external sources  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page under the Campaign Tools section, click the Export All 

Campaigns button.  

3. In the File Download pop-up dialog, Click Save to save the Campaigns details in 

CSV/XLS file format.  

Changing Campaign Owner  

(Access Privilege: Read/Write permission)  

When the campaign is in progress, occasionally it may be very useful to change the owner of 

some of the campaigns in a single step. You can change the owner of an individual campaign or 

a group of campaigns.  

To change owner of campaigns individually  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page, select the Campaign.  

3. In the Campaign: <Campaign Name> page, click the Edit button.  

4. In the Campaign: <Campaign Name> page, change the Campaign owner from the 

Campaign Owner lookup field.  

5. Click Save.  

To change campaigns owner in bulk  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page, go to the Campaign List section and select the check 

boxes corresponding to the Campaigns. You can also select all the Campaigns.  

3. Click the Change Owner button.  
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4. In the Campaigns: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the Campaigns 

permanently. 

Warning: Campaigns ownership will be changed to another 

user, irrespective of its existing owner. Use this operation carefully, 

otherwise campaigns belonging to different users will be changed 

to new user. To overcome this problem, first you may search the 

campaigns with a required owner name then change the owner in 

bulk. 

Printing Campaign Details  

(Access Privilege: Read permission)  

You can view the campaign details in printable form and print them using browser's Print 

function.  

To print campaign details  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page, go to the Campaign List section and select the required 

Campaign.  

3. In the Campaign: <Campaign Name> page click the Printable View button.  

4. In the Campaign: <Campaign Name>, page, click the Print Page button to print the 

document.  

Viewing Reports  

(Access Privilege: Read permission)  

You can directly access some of the standard reports pertaining to campaigns from the Campaign 

Reports section. By default, the following reports are displayed under Campaigns module:  

 Campaigns Revenue Report  

 Campaign Leads 

To view campaign report  
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1. Click the Campaigns tab.  

2. In the Campaigns: Home page, go to the Campaign Reports section.  

3. Click the required Report link. The Report is displayed in Reports page, which can be 

further customized as per your requirements.  

Refer to Working with Reports for more details about customizing the campaign reports.  

Deleting Campaigns  

(Access Privilege: Read/Write/Delete permission)  

Occasionally you may need to remove some of the unnecessary Campaigns from the Zoho CRM 

system for a better user experience. You may consider removing Campaigns that are not useful 

for future reference.  

Note: The deleted campaigns are temporarily stored in Recycle Bin. If required you can 

restore the deleted campaigns again. However, if you delete campaigns from Recycle Bin, you 

cannot restore again. 

To delete campaigns individually  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page, select the Campaign.  

3. In the Campaign: <Campaign Name> page, click the Delete button.  

4. In the Confirmation dialog, click OK to remove the Campaign permanently.  

To delete campaigns in bulk  

1. Click the Campaigns tab.  

2. In the Campaigns: Home page, go to the Campaign List section and select the check 

boxes corresponding to the Campaigns to be removed.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to remove the selected Campaigns permanently.  

Customizing Campaigns  

(Access Privilege: Customize ZohoCRM.com permission)  

http://zohocrm.wiki.zoho.com/Working-with-Reports.html
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Customization of the campaigns module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying campaign page layout, and 

show/hide the related list views according to your Campaign management process requirements.  
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Working with Leads 
 

 

Introduction 

Businesses consider Lead management as one of the important activities in their organization-

wide sales & marketing process. Leads are raw details about individuals or representatives of 

organizations collected from trade shows, seminars, advertisements, purchasing from external 

sources, and other marketing campaigns. These are used to qualify a particular individual or 

organization to next stage of your sales process so that you can sell your products/services to 

them in future. Sometimes leads may not be interested to purchase specific products/services, but 

may be useful as referral to sell other products in future. 

The terminology related to lead management may differ across the industries, but the basic 

process is approximately same. You can use Leads module, if you have a well-defined lead 

management process in your organization. In Zoho CRM, lead contains a combination of 

company, person, and business opportunely (potential) details. You can use Zoho CRM for 

managing both Business to Business (B2B) and Business to Consumer (B2C) scenarios. In 

B2B, scenario company name can be made mandatory where as in B2C company name can be 

optional. For more details on customizing Zoho CRM for B2C, refer to Zoho CRM for B2C 

tutorial.  

Typical Lead Management Process 

1. Customize lead related fields in lead page according to your organization Sales & 

Marketing process (You may use the existing fields, disable some of the standard fields, 

or add new custom fields).  

2. Setup lead generation process by filling the lead form, importing lead data from external 

sources, or capturing leads directly from your Web site  

3. Assign leads to the correct sales persons/partners using the Lead Assignment rules.  

4. Qualify the leads as potentials by following-up until the lead reached to a certain stage. 

Afterwards convert lead to potential. While converting leads to potentials, accounts and 

contacts are created automatically.  

5. After converting leads to potentials follow-up further in Potentials module until the deal 

is either won or lost. All the converted leads status is changed to "Converted", which can 

be used for future reference.  

http://zohocrm.wiki.zoho.com/B2C-Tutorial.html
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Sales Funnel Diagram 

Note: 

 Standard fields in the Leads module are applicable to most of the industries. If your 

organization requires additional fields, your System Administrator can add them using 

product customization module.  

 For creating leads, you must add the Company Name and Last Name of the lead. In 

Zoho CRM, lead information is a combination of company as well as the person's contact 

information.  

The Leads home page contains, 

 Leads list View  

 Page Navigation  

 Leads Reports  

 Dashboard  

 Lead Tools, such as Import, Export, Mass Delete, and Mass Transfer  

 Alphabetical Search  

 Custom Views  

You can perform the following operations in Leads module: 

 Navigate leads  

 Search leads (Alphabetical or Advanced search options)  

 Manage custom views  

http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Navigating_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Searching_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Creating_Custom_List_Views
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 Create leads (form filling, quick create, or duplicate options)  

 Import leads (from external sources)  

 Associate lead with other records  

 Send mass e-mail to the leads  

 Merge duplicate leads  

 Export leads (to spreadsheet programs)  

 Convert lead to other sales records (account, contact, and potential)  

 Map lead conversion fields  

 Change lead status (individually or in bulk)  

 Change lead owner (individually or in bulk)  

 View Reports & Dashboards  

 Print lead details  

 Delete leads (individually or in bulk)  

 Customize leads  

 Set up Lead Assignment Rules  

 Capture Leads from Web site  

 Approve Web-to-Leads  

Navigating Leads 

(Access Privilege: Read access) 

You can navigate the leads according to the status of the leads. 

To navigate leads 

1. Click the Leads tab.  

2. In the Leads Home page, under the Lead List section, select one of the views from Select 

View drop-down list to display the list of leads according to the status of the leads (For 

example, Contacted, Hot, Won, and others).  

3. In the Lead List section, click the Start, Previous, Next, or End links to access the 

respective list of leads.  

Searching Leads 

(Access Privilege: Read permission) 

You can search the leads alphabetically or filling the required information in Search box. 

 

http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Creating_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Importing_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Associating_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Sending_Email_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Merging_Duplicate_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Exporting_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Converting_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Mapping_custom_fields
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Changing_Lead_Status
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Changing_Lead_Owner
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Printing_Lead_Details
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Deleting_Leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Customizing_leads
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Lead_Assignment
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Capture_Lead_Website
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Approve_Web_Leads
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To search leads 

1. Click the Leads tab.  

2. In the Leads Home page, under Lead Search section, do one of the following:  

3.  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Lead List page, a list of leads is displayed as per search criteria.  

Creating Custom List Views 

(Access Privilege: Read/Write permission) 

In the Lead List view, you can create/modify/delete the custom views, sort columns in the list 

view (ascending/descending order), search the records available in the current list view. In 

addition, you can modify some of the columns in standard list views. By default, the following 

standard list views are available in the Leads module: 

 Standard Views  

o All Open Leads  

o My Leads  

o Today’s Leads  

o Converted Leads  

o My Converted Leads 

 Recent Views  

o Recently Created Leads  

o Recently Modified Leads  

o Recently Viewed Leads  

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Leads tab.  

2. In the Leads Home page, under Lead List section, click the Create View link. 

Note: Under the Lead List section, some of the standard list 
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views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box.  

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Leads 

(Access Privilege: Write permission) 

In Zoho CRM system, you can create leads by: 

 Entering data manually into lead details form  

 Importing leads from external sources  

 Capture leads from Web site through Web-to-Lead form  

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

List of Standard Lead-related Fields 

In the Lead: Edit form, you need to specify the lead-related information. The following table 

provides descriptions of the various standard fields in the form. 

Field Name Description Data Type 

Salutation Select the salutation from the drop-down list. Pick list 

First Name Specify the first name of the lead. 
Text box, 

Alphanumeric (40) 

http://zohocrm.wiki.zoho.com/Managing_List_Views.html#Specifying_Criteria&pid=2547000000004003
http://zohocrm.wiki.zoho.com/Managing_List_Views.html#Selecting_Columns&pid=2547000000004003
http://zohocrm.wiki.zoho.com/Managing_List_Views.html#Enabling_Access&pid=2547000000004003
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Last Name* 
Specify the last name of the lead. This field is a 

mandatory. 

Text box, 

Alphanumeric (80) 

Company* 
Specify the name of the company where the lead is 

working. This field is a mandatory. 

Text box, 

Alphanumeric (100) 

Designation Specify the designation of the lead. 
Text box, 

Alphanumeric (50) 

Lead Source 
Select the source of the lead, that is, from where the lead 

is generated. 
Pick list 

Industry Select the industry to which the lead belongs. Pick list 

Annual Revenue 
Specify the annual revenue of the company where the 

lead is working. 

Text box, decimal 

value (19). 

Lead Owner 
Display the Zoho CRM user ID to whom the lead is 

assigned. 
Pick list 

Phone Specify the phone number of the lead. 
Text box, 

Alphanumeric (50) 

Mobile Specify the mobile number of the lead. 
Text box, 

Alphanumeric (50) 

Fax Specify the fax number of the lead. 
Text box, 

Alphanumeric (50) 

E-mail Specify the E-mail address of the lead. E-mail (100) 

Skype ID 
Specify the Skype ID of the lead. Currently skype ID 

can be in the range of 6 to 32 characters.  
50 characters 

Web site Specify the Web site of the lead. URL (50) 

Lead Status Select the status of the lead from the drop-down list. Pick list 

Rating Select the rating of the lead from the drop-down list. Pick list 

No of Employees Specify the number of employees in lead's company. 
Text box, integer 

value (50) 

Street Specify the street address of the lead. 
Text box, 

Alphanumeric (250) 

City Specify the name of the city where the lead lives. 
Text box, 

Alphanumeric (30) 

State Specify the name of the state where the lead lives. 
Text box, 

Alphanumeric (30) 

ZIP Code Specify the postal code of the lead's address. 
Text box, integer 

value (30) 

Country Specify the name of the lead's country. 
Text box, 

Alphanumeric (30) 

Description Specify any other details about the lead. Text area (long text) 
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Creating Leads Individually 

You can create leads manually whenever there are very less number of leads. For example, you 

might have met a person in travel, and in normal chat, he/she has shown some interest in your 

product/service. After that, you have exchanged business cards and were asked to contact 

him/her later with more details about the product/service. The next day morning, you can create 

a lead manually with the available details. The best way to handle this type of scenarios is to 

create leads manually where you can fill the available details instantly. 

You can create leads by: 

 Filling details in the lead creation form.  

 Using the Quick Create, a quick create component present in left hand-side of the Leads 

Home page.  

 Duplicating the lead with few changes in the existing lead details  

Note: By default, the person who creates the lead owns the lead. If you want to assign the 

lead to a different user, select the user name from the Change Owner field in the lead details 

view. In addition, the lead status is marked with a default lead status as per your organization's 

sales process. 

To create leads individually 

1. Click the New Lead link.  

2. In the Lead: page, enter the lead-related information. 

 

Note: The Last Name and Company fields are mandatory. Refer to the List of Standard 

Lead-related Fields section for more details.  

3. Click Save. Lead details are displayed in Lead: <Lead Name> page where you can 

perform the additional operations. Refer to the Associating Leads with Other Records 

section for more details.  

To create leads instantly 

1. Click the Leads tab.  

2. In left hand-side under the Quick Create section, enter the mandatory details, such as 

Last Name and Company name.  

3. Click Save. Lead details are displayed in Leads Home page, where you can update the 

additional details.  

To create duplicate leads 

http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Standard_Lead_fields
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Standard_Lead_fields
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Standard_Lead_fields
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Associating_Leads
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1. Click the Leads tab.  

2. In the Lead List view page, select the lead to be duplicated.  

3. In the Lead: <Lead Name> page, click the Clone button.  

4. In the Edit: <Lead Name> page, modify some of the lead details.  

5. Click Save. Lead details are displayed in the Lead: <Lead Name> page where you can 

perform the additional operations.  

Importing Leads 

(Access Privilege: Data import permission) 

Importing leads from external to the CRM system is one of the most important activities in 

marketing and sales, when you are using different systems to gather leads data. For example, you 

may be purchasing leads from external sources, capturing product requests through Web site, 

getting leads from a different business unit within organization where there is a chance of cross-

selling of products, or migrating data from your old system to the Zoho CRM system. In all these 

cases, importing leads enhances your productivity. 

You can import leads, if you are authorized to perform this operation. Otherwise, Import Leads 

button in Leads Home page will be hidden in your user interface. By default, lead ownership is 

held up with the user, who imports the leads. You can change the lead ownership while 

importing by adding a lead owner column in import (CSV/XLS) file and map to the Assigned 

To field. This will automatically assign leads to particular users. Use the exact Zoho CRM users' 

names while creating the lead import file, otherwise leads are not created in Zoho CRM. 

Important Tips 

 Before importing leads, you must have the lead details in a CSV/XLS file.  

 You must have privilege to import the leads into the Zoho CRM system.  

 Before importing the leads, close the CSV/XLS file and the Spreadsheet program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 leads in one import cycle.  

To import leads 

1. Click the Leads tab.  

2. In the Leads: Home page under Lead Tools section, click the Import My Leads or 

Import My Organization Leads button. 
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Note: Import link is displayed only if you have privilege to use Import feature. Please 

contact your administrator in case these links are disabled. 

3. In the Specify Import File: page, browse the leads-related import file (CSV/XLS format) 

and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with lead fields in Zoho 

CRM.  

5. Click the Import button. It will take few minutes to complete the importation.  

6. In the Import Summary page, click the Go to Leads List button.  

7. In the Leads: Home page, imported leads are displayed under the Leads List section. You 

can continue the importation further or complete the operation.  

Merging Duplicate Leads 

Over a period, there may be a chance of accumulation of duplicate leads. You can merge these 

duplicate leads for a better organization of your leads. 

To merge duplicate leads 

1. Click the Leads tab.  

2. In the Leads Home page, under the Lead List section, click the required lead.  

3. In the Lead Details page, click the Find & Merge Duplicates button.  

4. In the Find Duplicate Leads page, do the following:  

1. Under the Search Criteria section, by default the some of the matching criteria 

and the corresponding values are displayed. Add additional criteria if required. 

Click the Search button.  

2. Under the Matching Leads section, select the leads to be merged.  

3. Click the View Duplicates button.  

5. In the Merge Leads page, select the fields to be updated to master record. All the 

duplicate fields are highlighted with a different color.  

6. Click the Merge button. The field’s details will be merged with the master lead record 

and lead details page is displayed for further operations.  

Associating Leads with Other Records 

(Access Privilege: Read/Write permission) 

After creating leads, you may need to associate leads with other records, such as tasks, events, E-

mails, products, attachments, and notes until the lead is reached to a certain stage where it can be 

converted to potential as per your organization's sales process. 
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To associate lead with other records 

1. In the Lead: <Lead Name> page, you can update the following details:  

2.  

o Open Activities: To add tasks and events (meetings, and calls).  

o Closed Activities: To archive the closed activities.  

o Products: To add products to the lead.  

o Attachments & Notes: To attach documents and notes to the lead.  

o Mails: To archive the sent email messages as part of the mass mailing.  

o Notes: To add notes to the lead.  

2. After updating the associated records, you can work with the next record.  

Sending Email to Leads 

(Access Privilege: Write permission) 

You can send bulk Emails to the selected leads from the Leads module. Before sending E-mail, 

ensure that the lead contains a valid Email address; otherwise, Email will not be sent to the 

corresponding lead. 

To send Emails to individual leads 

1. Click the Leads tab.  

2. In the Leads: Home page under the Lead List View section, select the lead.  

3. In the Lead Details page, go to Mails related list view and click the Send Mail button.  

4. In the Compose Mail page, enter the email message, attach files, add additional email IDs 

in CC & BCC fields, and finally click the Send button. An Email will be sent to the 

recipients and copy of the mail is stored under Mails related list view.  

To send E-mails to a group of leads 

1. Click the Leads tab  

2. In the Leads: Home page under the Lead Tool section, click the Mass E-mail Lead link.  

3. In the Mass E-mail page, do the following:  

o By default, the E-mail Template tab is enabled. Select the template to be used 

from the E-mail Template pick list. The template content is displayed under E-

mail Template Body section.  

o Click Matching Criteria tab. You can create a leads mailing list by specifying 

the matching criteria under Specify Criteria section.  
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4. Click the Send button to send the E-mail message to the selected leads.  

Exporting Leads 

(Access Privilege: Data export permission) 

Occasionally it is very useful to export the leads from Zoho CRM to Spreadsheet programs, such 

as Microsoft Excel, OpenOffice, and others for further data analysis. 

To export leads to external sources 

1. Click the Leads tab.  

2. In the Leads: Home page under the Lead Tools section, click the Export All Leads 

button.  

3. In the File Download pop-up dialog, Click Save to save the leads details in CSV/XLS file 

format.  

Converting Leads to Other Sales Records 

(Access Privilege: Lead Conversion permission) 

Once lead status has reached a certain stage, where it can be qualified as a potential, i.e., there is 

a chance of further negotiations with the lead, it can be converted to account, contact, and 

potential. It depends on your organization's sales process. During lead conversion, all the fields 

in Lead details are converted to the account, contact, and potential fields. Also the related lists, 

such as tasks, events, 

Note: Once a lead is converted into potential, lead status will be changed to Converted in 

Leads Home page. 

Lead Conversion Rule 

While converting a lead to a potential first a new account and contact are created with the 

relevant lead data, and then a new potential is created. The following table provides descriptions 

of the various fields converted to account, contact, and potential (optional) during lead 

conversion: 

Lead Field Converted To 

Salutation Contact: Salutation 

First Name Contact: First Name 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

38 ©2007, AdventNet Inc. All rights reserved.  

 

Lead Field Converted To 

Last Name Contact: Last Name 

Company Account: Name 

Designation Contact: Designation 

Lead Source Potential: Lead Source 

Industry Account: Industry 

Annual Revenue Account: Annual Revenue 

Assigned To Account, Contact, Potential: Assigned To 

Phone 
Account: Phone 

Contact: Phone 

Mobile Contact: Mobile 

Fax 
Account: Fax 

Contact: Fax 

E-mail Contact: Amyl 

Skype ID  Contact: Skype ID  

Web site Account: Web site 

Lead Status Potential: Status 

Rating Potential: Rating 

No of Employees Account: No. of Employees 

Street 
Account: Street 

Contact: Street 

City 
Account: City 

Contact: City 

State 
Account: State 

Contact: State 

Postal Code 
Account: Postal Code 

Contact: Postal Code 

Country 
Account: Country 

Contact: Country 

Custom Fields Users can add their own custom fields. 

To convert leads to other sales records 

1. Click the Leads tab.  

2. In the Leads: Home page, select the lead to be converted.  

3. In the Lead: <Lead Name> page, click the Convert Lead button.  

4. In the Convert Lead: <Lead Name> page, enter the following details:  

5.  

o Assigned To - Select the user name.  
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o Account Name - Display the company name. This field is non-editable.  

o Potential Name - Specify the potential name.  

o Potential Close Date - Specify the potential closing date or select the date from 

the pop-up Calendar.  

5. Click Save.  

Mapping Custom Fields 

(Access Privilege: System Administrator permission)  

By default, all the standard lead fields are mapped with the corresponding account, contact, and 

potential 

To map lead fields with other records 

1. Click the Setup link.  

2. In the Setup page, expand the Lead Settings section and click the Fields link.  

3. In the Lead Fields page, click the Map Custom Fields button.  

4. In the Map Lead Custom Fields page, custom fields are displayed under Lead Custom 

Fields column.  

Changing Lead Status 

(Access Privilege: Read/Write permission) 

When the prospecting is in progress, it may be very useful to change the status of some of the 

leads in a single step. Lead status is customizable and your administrator has already configured 

the Lead Status field as per your organization's sales process. You can change the status of 

individual lead or group of leads. 

To change the status of leads individually 

1. Click the Leads tab.  

2. In the Leads: Home page, select the lead.  

3. In the Lead: <Lead Name> page, click the Edit button.  

4. In the Lead: <Lead Name> page, change the lead status from Lead Status pick-list.  

5. Click Save to update the lead status.  

To change the status of leads in bulk 
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1. Click the Leads tab.  

2. In the Leads: Home page, go to the Lead List section and select the check boxes 

corresponding to the leads. You can also select all the leads.  

3. Click the Change Status button.  

4. In the Leads: Change Status page, select the status from the Select New Status pick list 

and click the Update Status button. 

Note: Leads status will be changed to a new status, irrespective 

of its existing status. Use this operation carefully, otherwise leads at 

different states will be changed to new status violating the 

organization's sales process. If you are not sure of using this 

operation, change the status of leads one-after-another. The other 

ways of overcoming this problem is first search the leads with a 

required status then change the status in bulk. 

Changing Lead Owner 

(Access Privilege: Read/Write permissions) 

When the prospecting is in progress, occasionally it may be very useful to change the owner of 

some of the leads in a single step. You can change the owner of an individual lead or a group of 

leads. 

To change owner of leads individually 

1. Click the Leads tab.  

2. In the Leads: Home page, select the lead.  

3. In the Lead: <Lead Name> page, click the Edit button.  

4. In the Lead: <Lead Name> page, change the lead owner from the Lead Owner lookup 

field.  

5. Click Save to update the lead owner.  

To change owner of leads in bulk 

1. Click the Leads tab.  

2. In the Leads: Home page, go to the Lead List section and select the check boxes 

corresponding to the leads. You can also select all the leads.  

3. Click the Change Owner button.  

4. In the Leads: Change Owner page, select the user from the Select New Owner pick list 

and click the Update Owner button to change the owner of the leads permanently. 
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Warning: Leads ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise leads belonging to different users 

will be changed to new user. To overcome this problem, first you may search the leads 

with a required owner name then change the owner in bulk. 

Viewing Reports 

(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to leads from the Lead Reports 

section. In addition to reports, you can access one of the dashboards in Leads module. 

By default, the following reports are displayed under Leads module: 

 Leads By Source  

 Leads By Status  

 Today's Leads  

 Leads by Ownership  

 Converted Leads  

 Leads by Industry  

To view Lead report  

1. Click the Leads tab.  

2. In the Leads: Home page, go to the Lead Reports section.  

3. Click the required Report link. The Report is displayed in Reports page, which can be 

further customized as per your requirements.  

Printing Lead Details 

(Access Privilege: Read permission) 

You can view the lead details in printable form and print them using browser’s Print function. 

To print lead details 

1. Click the Leads tab.  

2. In the Leads: Home page, go to the Lead List section and select the required lead.  

3. In the Lead: <Lead Name> page, click the Printable View link.  
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4. In the Lead: <Lead Name> page, click the Print Page button. You can print the 

document using the Web browser print function.  

Deleting Leads 

(Access Privilege: Read/Write/Delete permissions) 

Occasionally you may need to remove some of the unnecessary leads from the Zoho CRM 

system for a better user experience. You may consider removing leads that are not useful for 

future reference. 

Warning: The deleted leads are temporarily stored in Recycle Bin. If required you can 

restore the deleted leads again. However, if you delete leads from Recycle Bin, you cannot 

restore again. 

To delete leads individually 

1. Click the Leads tab.  

2. In the Leads: Home page, select the lead.  

3. In the Lead: <Lead Name> page, click the Delete button.  

4. In the Confirmation dialog, click OK to remove the lead permanently.  

To delete leads in bulk 

1. Click the Leads tab.  

2. In the Leads: Home page, go to the Lead List section and select the check boxes 

corresponding to the leads to be removed.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to remove the selected leads permanently.  

Customizing Leads 

(Access Privilege: System Administration) 

Customization of the Leads module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying lead page layout, and show/hide 

the related list views according to your Lead management process requirements. 
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Setting up Lead Assignment Rules 

(Access Privilege: Manage Lead Assignment Permission) 

You can setup lead assignment rules based on your organization-wide lead distribution (based on 

sales territories) process so that leads generated through import tool are automatically assigned to 

the respective sales team members. 

Lead Assignment Workflow 

 Create lead assignment rule.  

 Associate rule entries to the assignment rule, which contains matching criteria, selecting 

user, and adding default workflow task.  

 Select the required assignment rule in lead import tool  

 During lead importation, first assignment rule is evaluated and the leads are assigned to 

the Zoho CRM users according matching criteria.  

Limitations 

 You can create up to 20 different lead assignment rules.  

 In each assignment rule, you can associate up to 20 different criteria.  

 Even though you can setup multiple rules, users can select only one rule at a time.  

 Lead assignment rule can be used only for the leads generated through import tool.  

To set up lead assignment rules 

1. Click the Setup link.  

2. In the Settings Home page, under the Lead Settings section click the Assignment Rules 

link.  

3. In the Lead Assignment Rules page, under the Rules List section list of default rules are 

displayed. Click the Create New Rule button to add a new rule.  

4. In the New Rule page, specify the rule in the Rule Name field and click the Save. 

 

Specify Rule Name 
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5. In the Lead Assignment Rule Entry page, under the Rules Entries section list of default 

rule entries are displayed. Click the Create New Rule Entry button to add a new rule 

entry.  

6. In the Rule Entry page, do the following:  

1. Specify Criteria: Select the matching criteria to evaluate the rule (Refer 

to Managing Workflow)  

2. Select User: Select the user to whom the lead has to be assigned.  

3. Add Task: Select the workflow task to be assigned (Refer to Managing 

Workflow)  

7. Click Save. 

 

Specify Rule Details 

 

 

http://zohocrm.wiki.zoho.com/Managing-Workflow.html
http://zohocrm.wiki.zoho.com/Managing-Workflow.html
http://zohocrm.wiki.zoho.com/Managing-Workflow.html
http://zohocrm.wiki.zoho.com/Managing-Workflow.html
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Capturing Leads from Web site (Web-to-Lead Form) 

(Access Privilege: Web-to-Lead Permission) 

Using Web-to-Lead form your organization can allow Web site visitors submitting their 

information directly so that you can create leads directly. All the leads captured through Web site 

are first assigned to the Lead Administrator, which can be reassigned to the corresponding Sales 

persons. 

Important Points 

 Anyone visiting your Web site can submit leads and submit any type of information. 

Hence, you cannot control the Spam.  

 All the leads are first assigned to the User selected in Web-to-Lead settings page. The 

Lead Administrator can change the lead ownership to other users.  

 To send automate replies to visitors select the required e-mail template from the Web-to-

Lead settings.  

 The generated Web-to-Lead form contains only Web form related tags. You have to 

customize the generated Lead form further to suite your Website requirements.  

 Test the complete workflow of Web-to-Lead form, before publishing in the Website.  

Note: For creating a lead, Last Name and Company Name fields are mandatory. If your 

Website visitors do not enter these fields, lead with company name as "Not Available" is created. 

To create Web-to-Lead form 

1. Click the Setup link.  

2. In the Settings Home page, under the Lead Settings section click the Web-to-Lead link.  

3. In the Capturing Leads from Website page, do the following:  

4. Enable Web-to-Lead option for your organization: Refer To configure Web-to-Lead 

settings section.  

5. Set up Custom Lead Fields in Web-to-Lead form: Refer To add custom lead fields in 

Web-to-Lead form section.  

6. Generate HTML page as per your fields in the Web-to-Lead form: Refer To generate 

HTML page for Web-to-Lead form section.  

7. The generated HTML page contains only the web form objects and minimal HTML tags. 

Customize the web page according to your Website layout requirements.  

8. Publish the Web-to-Lead form in your Website. Your visitors can submit their contact 

information, which will be routed to Leads module. All the leads captured through Web 

Form are assigned to the Owner selected in Web-to-Lead settings page.  

http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Web_to_Lead_Settings
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Web_to_Lead_Settings
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Custom_Fields_in_Web_to_Lead
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Custom_Fields_in_Web_to_Lead
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Custom_Fields_in_Web_to_Lead
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Generate_Web_to_Lead_HTML_Page
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Generate_Web_to_Lead_HTML_Page
http://zohocrm.wiki.zoho.com/WorkingWithLeads.html#Generate_Web_to_Lead_HTML_Page
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To configure Web-to-Lead settings 

1. In the Capturing Leads from Website page, click the Web-to-Lead link.  

2. In the Web-to-Lead Settings page do the following:  

3. Enable Web-to-Lead: Select the check box the enable the Web-to-Lead form.  

4. Return URL: Specify the URL of the page to be displayed after visitor submits the case 

(For example, Thanks page for submitting the information)  

5. Web Leads Approval: Select the checkbox to enable approval system, so that leads will 

be assigned to respective sales person upon approving the lead. By default, the lead 

approval is disabled.  

6. Default Lead Owner/Creator: Specify the Zoho CRM user to whom the case has to be 

assigned.  

7. Default Response Template: Select the automate e-mail response template, which is 

used for sending an e-mail to the person submits the case.  

8. Click Save. Again, Capturing Leads from your Web Site page is displayed.  

To add custom lead fields in Web-to-Lead form 

1. In the Capturing Leads from Website page, click the Setup Custom Lead Fields link.  

2. In the Lead Fields section, add the custom fields to be added. For more details, refer to 

Customizing Zoho CRM  

3. Once you have completed the field customization, click the Web-to-Lead link under Lead 

Settings section.  

To generate HTML page for Web-to-Lead form 

1. In the Capturing Leads from Website page, click the Generate the HTML link.  

2. In the Generating HTML for Web-to-Lead page, do the following:  

1. Select Web Form Fields: Select the lead fields to be displayed in the Web Form.  

2. Confirm Password: Specify your password (User who creates the Web-to-Lead 

form) to authenticate your Account from the Zoho CRM on-demand service.  

3. Click the Generate HTML button.  

4. In the Copy Generated HTML page, copy the HTML content, paste to your favorite 

HTML editor, and click the Finish button.  

5. Customize the Web-to-Lead form (HTML page) to suite your Website requirements and 

publish in your Website.  

Warning: If you change your password after publishing the Web-to-Lead form, please 

ensure that updating the following information in Web-to-Lead form. 
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Example: 

<!-- Begin: Do not edit the section --> 

<form action="http://zohocrm.com/crm/WebtoLeadServlet?encoding=UTF-8" method="POST"> 

<input type='hidden' name='orgId' value='1'/> 

<input type='hidden' name='xnQsjsdp' value=Z29wYWxzQGFkdmVudG5ldC5jb20=/> 

<input type='hidden' name='xmPqMMnsd' value=dGVzdGl0/> 

<input type='hidden' name='actionType' value=Q2FzZXM=/> 

<input type='hidden' name='returnURL' value='http://www.zohocrm.com' /> 

<!-- End: Do not edit the section --> 

Otherwise, leads submitted through Website will not be captured in Leads module, due to 

authentication failure. 

Approving Leads Captured through Website 

(Access Privilege: Web-to-Lead Permission) 

By default, leads captured through Website are assigned to one of the Lead Administrator who 

can update the leads with additional information and assign to the corresponding Sales Person in 

your organization. It will allow your sales persons focus mainly on high priority leads (lead 

contain correct contact information, and interest on your offering). 

To approve leads from Website 

1. Click the Setup link.  

2. In the Settings Home page, under the Lead Settings section click the Approve Web Leads 

link.  

3. In the Web-to-Lead Approval page, under Web-to-Lead list, leads are displayed. View 

the lead details, assign to specific user, and click the Approve button. Afterwards lead 

owner can follow-up the lead.  
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Working with Accounts 
 

Introduction 

In a typical Business to Business (B2B) scenario, Account represents a Company or a 

Department within the company, with which your Company is doing or planning to do business 

in future. In an Account, you can store the company address, number of employees, annual 

revenue, and other details. 

You can associate an account with contacts (persons) within the company and the potentials 

(business opportunities) during pre-sales. After successful completion of the sales, you can also 

provide customer support & service through Zoho CRM - Case Management. 

The Accounts home page contains, 

 Accounts List  

 Account Reports  

 Tools, such as Import, Export, mass transfer, and delete accounts  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Change Owner  

 Delete  

 Page Navigation  

You can perform the following operations in the Accounts module: 

 Navigate accounts  

 Search accounts (Alphabetical or advanced options)  

 Create list views  

 Create accounts (Form filling, quick create, or duplicate options)  

 Import accounts (from external sources)  

 Associate account with other records  

 Export accounts to spreadsheets  

 Change account owner (individually or in bulk)  

 Print account details  

 View reports  

 Delete accounts (individually or in bulk)  

 Customize accounts  

http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Navigating_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Searching_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#List_Views
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Creating_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Importing_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Associating_Account
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Exporting_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Change_Account_Owner
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Printing_Account_Details
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Deleting_Accounts
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Customizing_accounts
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Navigating Accounts 

(Access Privilege: Read permissions) 

You can navigate accounts according to the type of account. 

To navigate accounts 

1. Click the Accounts tab.  

2. In the Accounts Home page, under the Account List section, select one of the views from 

Select View drop-down list to display the list of accounts according to the type of the 

account (For example, Prospect, Investor, Reseller, and others).  

3. In the Account List section, click the Start, Previous, Next, or End links to access the 

respective list of accounts.  

Searching Accounts 

(Access Privilege: Read permission) 

You can search the contacts alphabetically or filling the required information in Search box. 

To search accounts 

1. Click the Accounts tab.  

2. In the Accounts Home page, under the Account Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Contact List page, list of accounts are displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permissions) 

In the Account List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Accounts module: 

 Standard Views  

o All Accounts  
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o My Accounts  

o New This Week  

o New Last Week  

 Recent Views  

o Recently Created Accounts: Accounts created during 24 hours.  

o Recently Modified Accounts: Accounts modified during 24 hours.  

o Recently Viewed Accounts: Accounts viewed during 24 hours.  

Note: User created list views are displayed under User Created Views category in 

View drop-down list. 

To create custom views 

1. Click the Accounts tab.  

2. In the Accounts Home page, under Account List section, click the Create View link. 

Note: Under Account List section, some of the standard list views are displayed. You can 

only rearrange the order of columns and more columns.  

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box.  

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Accounts 

(Access Privilege: Read/Write permissions) 

In Zoho CRM, you can create accounts by: 

 Entering data in account details form  

 Duplicating the account with a few changes from the existing account details  

 Using the New Account, a quick create component present in left hand-side of the 

Accounts Home page  

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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 Importing accounts from other Contact Management and CRM applications  

 Synchronizing Microsoft Outlook contacts with Zoho CRM (Special case: An account 

will be created in Zoho CRM while Company Name field is specified in the Microsoft 

Outlook)  

 Converting leads to accounts  

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

List of Standard Account-related Fields 

In the Account: Edit form, you need to specify the account-related information. The following 

table provides descriptions of the various standard fields in the form. 

Field Name Description Data Type 

Account Name* Specify the company name. This field is mandatory. 
Text box, 

alphanumeric (100) 

Website Specify the URL of the company's Web site. 
URL, alphanumeric 

(30) 

Ticker Symbol Specify the ticker symbol of the Company. 
Text box, 

alphanumeric (30) 

Parent Account 
Select the parent company name from the Change 

pop-up dialog. 
Lookup 

Employees 
Specify the number of employees in account's 

company. 

Text box, integers 

(10) 

Ownership Specify the type of ownership of the company. 
Text box, 

alphanumeric (50) 

Industry Select the type of industry from the drop-down list. Pick list 

Type Select the type of account from the drop-down list. Pick list 

Account Owner 

Select the Zoho CRM user to whom the account to 

be assigned. By default, the record is assigned to 

the user who creates it. 

Pick list 

Phone Specify phone number of the account. 
Text box, 

alphanumeric (30) 

Fax Specify fax number of the account. 
Text box, 

alphanumeric (30) 
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E-mail Specify the official E-mail address of the account. 

E-mail, alphanumeric 

and special characters 

(100) 

Rating Specify the rating of the account. Pick list 

SIC Code 
Specify the Standard Industrial Classification code 

of the account. 

Text box, integers 

(10) 

Annual Revenue Specify the annual revenue of the account. 
Text box, integers 

(10) 

Billing Address  

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the billing address of the account to send 

the quotes, invoices, and other agreements. 

 Street, 

alphanumeric 

(250)  

 City, 

alphanumeric 

(30)  

 State, 

alphanumeric 

(30)  

 Postal Code, 

alphanumeric 

(30)  

 Country, 

alphanumeric 

(30)  

Shipping Address  

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the shipping address of the account to 

deliver the shipment. 

-Do- 

Description Specify any other details about the account. Text area (32 Kb) 

  

Notes: By default, the person who creates the account owns the account. 

If you want to assign the account to a different user, in account creation form, 

select the user name from Assigned To field. In addition, the account status 
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is marked with a default account status, as per your organization's sales 

process. 

To create accounts individually 

1. Click the New Account link.  

2. In the Account: page, specify the account details. 

Note: Account Name is a mandatory field. Refer to the List of 

Standard Account-related Fields section for more details. 

3. Click Save. Account details are displayed in Account: <Account Name> page where you 

can perform the additional operations. Refer to Associating Accounts with Other Records 

section for more details.  

To create accounts instantly 

1. Click the Accounts tab.  

2. In left hand-side under the New Account section, enter the mandatory details, such as 

Company name.  

3. Click Save. Account details are displayed in Account: <Account Name> page where you 

can update additional details or perform the additional operations.  

To create duplicate accounts 

1. Click the Accounts tab.  

2. In Account List view page, select the account to be duplicated.  

3. In Account: <Account Name> page, click the Duplicate button.  

4. In Edit: <Account Name> page, modify some of the account details.  

5. Click Save. Account details are displayed in Account: <Account Name> page where you 

can perform the additional operations.  

Importing Accounts 

(Access Privilege: Data Import permission) 

You can import your accounts from other legacy Business applications to Zoho CRM to have a 

better-centralized database. 

http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Standard_Account_fields
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Standard_Account_fields
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Standard_Account_fields
http://zohocrm.wiki.zoho.com/Working-with-Accounts.html#Associating_Account
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Tips:  

 Before importing accounts into Zoho CRM, you must have the accounts details in 

CSV/XLS file.  

 You must have privilege to import the accounts into Zoho CRM.  

 Before importing the accounts into Zoho CRM close the import file and the 

Spreadsheet program.  

 Remove apostrophe if present in any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 accounts in one import cycle.  

To import accounts 

1. Click the Accounts tab.  

2. In the Accounts: Home page under Account Tools section, click the Import My 

Accounts or Import My Organization Accounts button. 

Note: Import link is displayed only if you have privilege to use 

Import feature. Please contact your administrator in case these links 

are disabled. 

3. In the Specify Import File: page, browse the accounts-related import file (CSV/XLS 

format) and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with account fields in 

Zoho CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Accounts: Home page, imported accounts are displayed under the Accounts List 

section. You can continue the importation further or complete the operation.  

Associating Account with Other Records 

(Access Privilege: Read/Write permissions) 

You can create a 360 degrees view of the account to display all the associated details, such as 

contacts, potentials, trouble tickets, activities, attachments, and notes in a single view. 

To associate account with other records 

1. In the Account: <Account Name> page, update the following details:  



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

55 ©2007, AdventNet Inc. All rights reserved.  

 

o Potentials: To add potentials to the account  

o Contacts: To add contacts to the account  

o Open Activities: To add tasks and events (meetings, and calls) to the account.  

o Closed Activities: To display the closed activities  

o Products: To add products to the account.  

o Quotes: To add quotes to the account.  

o Sales Orders: To add sales orders to the account.  

o Invoices: To add invoices to the account.  

o Attachments & Notes: To attach documents and notes to the account.  

o Member Accounts: To add other divisons or subsidiaries to the parent account.  

2. After updating the associated records, you can move to the next record.  

Exporting Accounts 

(Access Privilege: Data Export permission) 

Occasionally it is very useful to export the accounts from Zoho CRM to Spreadsheet programs, 

such as Microsoft Excel, OpenOffice, and others for further data analysis. 

To export contacts to external sources 

1. Click the Accounts tab.  

2. In the Accounts: Home page under Account Tools section, click the Export All Accounts 

button.  

3. In the File Download pop-up dialog, Click Save to save the Accounts files in CSV/XLS 

file format.  

Merging Duplicate Accounts 

Over a period, there may be a chance of accumulation of duplicate accounts. You can merge 

these duplicate accounts for a better organization of your accounts. 

To merge duplicate accounts 

1. Click the Accounts tab.  

2. In the Accounts Home page, under the Account List section, click the required account.  

3. In the Account Details page, click the Find & Merge Duplicates button.  

4. In the Find Duplicate Accounts page, do the following:  
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1. Under the Search Criteria section, by default the some of the matching criteria 

and the corresponding values are displayed. Add additional criteria if required. 

Click the Search button.  

2. Under the Matching Accounts section, select the accounts to be merged.  

3. Click the View Duplicates button.  

5. In the Merge Accounts page, select the fields to be updated to master record. All the 

duplicate fields are highlighted with a different color.  

6. Click the Merge button. The field’s details will be merged with the master account 

record and account details page is displayed for further operations. 

Changing Account Owner 

(Access Privilege: Owner change permission) 

When the prospecting is in progress, occasionally it may be very useful to change the owner of 

some of the accounts in a single step. You can change the owner of an individual account or a 

group of accounts. 

To change owner of accounts individually 

1. Click the Accounts tab.  

2. In the Accounts: Home page, select the contact.  

3. In the Account: <Account Name> page, click the Edit button.  

4. In the Account: <Account Name> page, change the account owner from the Account 

Owner lookup field.  

5. Click Save to update the account owner.  

To change owner of accounts in bulk 

1. Click the Accounts tab.  

2. In the Account: Home page, go to the Account List section and select the check boxes 

corresponding to the accounts. You can also select all the accounts.  

3. Click the Change Owner button.  

4. In the Accounts: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the accounts 

permanently. 

Warning: Accounts ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise accounts belonging to different 

users will be changed to new user. To overcome this problem, first you may search the 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

57 ©2007, AdventNet Inc. All rights reserved.  

 

accounts with a required owner name then change the owner in bulk. 

Printing Account Details 

(Access Privilege: Read permission) 

You can view a printable form and print the account details using browser’s Print function. 

To print account details 

1. Click the Accounts tab.  

2. In the Accounts: Home page under the Account List section, select the required account.  

3. In the Account: <Account Name> page, click the Print Preview button.  

4. In the Account: <Account Name>, page, click the Print Page button to print the 

document.  

Viewing Reports 

(Access Privilege: Read/Write permissions) 

You can directly access some of the standard reports pertaining to accounts from the Account 

Reports section. By default, the following reports are displayed under accounts module: 

 Contact Mailing List  

 Key Accounts  

 Accounts by Industry  

To view account reports  

1. Click the Accounts tab.  

2. In the Accounts: Home page, go to the Account Reports section.  

3. Click the required Report link. The Report is displayed in Reports page, which can be 

further customized as per your requirements.  

For more details about reports customization refer to Chapter <>: Working with Reports 

Deleting Accounts 

(Access Privilege: Read/Write/Delete permissions) 

http://zohocrm.wiki.zoho.com/Working-with-Reports.html
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Rarely, you may need to remove some of the unnecessary accounts (customers) from the Zoho 

CRM database to have a better control over the existing accounts. 

You can delete accounts that are not useful, individually or in bulk. All the deleted accounts are 

stored in Recycle bin. If required you can restore the accounts. However, if you delete the 

records from Recycle Bin your records will be deleted permanently, hence use this option 

carefully. 

While deleting the accounts, the related activities, notes, and attachments are also deleted. 

Warning: The deleted accounts are temporarily stored in Recycle Bin. If required you can 

restore the deleted accounts again. However, if you delete accounts from Recycle Bin, you 

cannot restore again. 

To delete accounts individually 

1. Click the Accounts tab.  

2. In the Accounts: Home page, select the account.  

3. In the Account: <Account Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the account permanently.  

To delete accounts in bulk 

1. Click the Accounts tab.  

2. In the Accounts: Home page under the Account List section, select the check boxes 

corresponding to the accounts to be removed.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected accounts permanently.  

Customizing Accounts 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the accounts module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying accounts page layout, and 

show/hide the related list views according to your Account management process requirements. 
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Working with Contacts 
 

Introduction 

Contacts are people with whom you communicate, either in pursuit of a business opportunity or 

for personal reasons. In Business-to-Consumer (B2C) scenario, contact is the most important 

information for acquiring customers where as in Business-to-Business (B2B) it is a part of the 

organization details with which you are doing business. You can also create personal contacts 

that are not associated with any account. A personal contact does not display as part of the 

account or business opportunity information. Only you can see your personal contacts. 

Contacts can be added to the Zoho CRM system by filling the contact form, importing contacts 

from other Contact Management & CRM applications, synchronizing contacts from the 

Microsoft Outlook software, or converting leads to contacts. Contact information can include an 

address, title, phone numbers, e-mail address, Birth date, and other personal details of an 

individual. 

The most important function of contacts module in the Zoho CRM system is they can be used for 

both customers' acquisition as well as procurement of products from the vendors, i.e., contacts 

can be related to accounts as well as vendors according to your business process. 

Contacts Module contains the following: 

 Contact List View  

 Page Navigation  

 Quick Create Contacts  

 Contact Reports  

 Contact Tools such as Import, Export, Mass Delete, and Mass Transfer  

 Alphabetical Search  

 Custom Views  

You can perform the following operations in Contacts module: 

 Navigate contacts  

 Search contacts (Alphabetical or advanced search options)  

 Create list views  

 Create contacts (Form filling, quick create, or duplicate options)  

 Import contacts (from external sources)  

 Associate contacts with other records  

 Send E-mail to the contacts  

http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Navigating_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Searching_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Contact_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Creating_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Importing_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Associating_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Sending_Emails
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 Export contacts to other spreadsheets  

 Change contact owner (individually or in bulk)  

 View contact related reports  

 Print contact details  

 Delete contacts (individually or in bulk)  

 Customize contacts  

Navigating Contacts 

(Access Privilege: Read permission) 

You can navigate contacts available in the Contact List. 

To navigate contacts 

1. Click the Contacts tab.  

2. In the Contacts Home page, under the Contact List section, select one of the views from 

Select View drop-down list to display the list of accounts according to the type of the 

account (For example, Prospect, Investor, Reseller, and others).  

3. In the Contact List section, click the Start, Previous, Next, or End links to access the 

respective list of contacts.  

Searching Contacts 

(Access Privilege: Read permission) 

You can search the contacts alphabetically or filling the required information in Search box. 

To search contacts 

1. Click the Contacts tab.  

2. In the Contacts Home page, under the Contact Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Contact List page, list of contacts are displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permissions) 

http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Exporting_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Changing_Contact_Owner
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Printing_Contact_Details
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Deleting_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Customizing_contacts
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In the Contact List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Contacts module: 

 Standard Views  

o All Contacts  

o My Contacts  

o New This Week  

o New Last Week  

 Recent Views  

o Recently Created Contacts  

o Recently Modified Contacts  

o Recently Viewed Contacts  

Refer to Chapter <>: Managing List Views chapter to learn more about creating list views. 

To create list views 

1. Click the Contacts tab.  

2. In the Contacts Home page, under Contact List section, click the Create View link. 

Note: Under the Contact List section some of the standard list 

views are displayed. You can only rearrange the order of columns 

and add more columns to the standard list views. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box.  

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

 

http://zohocrm.wiki.zoho.com/Managing-List-Views.html
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

62 ©2007, AdventNet Inc. All rights reserved.  

 

Creating Contacts 

(Access Privilege: Read/Write permissions) 

In Zoho CRM, you can create contacts as given below: 

 Entering data in contact details form  

 Duplicating the contact with few changes from the existing contact details  

 Importing contacts from other Contact Management applications  

 Converting leads to contacts  

 Synchronizing Microsoft Outlook contacts with Zoho CRM  

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Contact: Edit form, you need to specify the contact-related information. The following 

table provides descriptions of the various fields in the form. 

List of Standard Contact-related Fields 

Field Name Description Data Type 

Salutation 
Select the Salutation of the contact, such as Mr., Ms, 

Mrs., or others.  
Pick list 

First Name Specify the first name of the contact. 
Text box, 

Alphanumeric (40) 

Last Name* 
Specify the last name of the contact. This field is 

mandatory. 

Text box, 

Alphanumeric (40) 

Account Name Select the account related the contact. Lookup 

Lead Source Select the source from which the contact is created. Pick list 

Title Specify the job position of the contact. 
Text box, 

Alphanumeric (50) 

Department Specify the department of the contact. 
Text box, 

Alphanumeric (30) 

Date of Birth 
Specify the birthday of the contact to send greetings 

for a better relationship. 
Date 

Reports To Select the person to whom the contact reports Lookup 

Do Not Call Select this option not to make a call to the contact (If Check box 
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Field Name Description Data Type 

the contact is not interested to be contacted by phone 

even though having a phone number). 

Assigned To 
Select the name of the user to whom the contact has 

to be assigned. 
Pick list 

Phone Specify the office phone number of the contact. 
Text box, 

Alphanumeric (50) 

Mobile Specify the mobile number of the contact. 
Text box, 

Alphanumeric (50)  

Home Phone Specify the home phone number of the contact. 
Text box, 

Alphanumeric (50) 

Other Phone 
Specify the other phone number of the contact (if 

any). 

Text box, 

Alphanumeric (50) 

Fax Specify the Fax number of the contact. 
Text box, 

Alphanumeric (50) 

E-mail Specify the primary E-mail address of the contact. 
Text box, 

Alphanumeric (100) 

Assistant Specify the name of the contact’s assistant. 
 

Assistant Phone Specify the phone number of the contact's assistant. 
Text box, 

Alphanumeric (100) 

Mailing Address 

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the primary address of the contact. 
 

Other Address 

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the other address of the contact (if any). 
 

Description Specify any other details about contact. Text area (long text) 
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To create contacts individually 

1. In the Contacts home page under Contacts list, click the New Contact button.  

2. In the Contact: < > page, enter the contact-related information. The Last Name is a 

mandatory field. Refer to the List of Standard Contact-related Fields section for more 

details.  

3. Click Save. Contact details are displayed in the Contact: <Contact Name> page where 

you can perform the additional operations. Refer to the Associating Contact with Other 

Records section for more details.  

Note: By default, the person who creates the contact owns the contact. If you want to assign 

the contact to a different user, in contact creation form, select the user name from the Assigned 

To field. 

To create contacts instantly 

1. Click the Contacts tab.  

2. In the left hand-side bar under the New Contact section, enter the contact's last name.  

3. Click Save. Contact details are displayed in the Contact: <Contact Name> page where 

you can update with additional details or perform the additional operations.  

To create duplicate contacts 

1. Click the Contacts tab.  

2. In the Contact List view page, select the contact to be duplicated.  

3. In the Contact: <Contact Name> page, click the Clone button.  

4. In the Edit: <Contact Name> page, modify some of the contact details.  

5. Click the Save. Contact details are displayed in the Contact: <Contact Name> page 

where you can perform the additional operations.  

Importing Contacts 

(Access Privilege: Data Import permission) 

You can import contacts from other Contact Management, CRM, and Address Book 

applications. Before migrating data, you must convert the data into CSV/XLS format. 

 

http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Standard_Contact_fields
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Associating_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Associating_Contacts
http://zohocrm.wiki.zoho.com/Working-with-Contacts.html#Associating_Contacts
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Tips 

 Before importing contacts into Zoho CRM, you must have the contacts details in a 

CSV/XLS file.  

 You must have privilege to import the contacts in Zoho CRM.  

 Before importing, the contacts into Zoho CRM close the CSV/XLS file and the 

Spreadsheet program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 contacts in one import cycle.  

To import contacts 

1. Click the Contacts tab.  

2. In the Contacts: Home page under Contact Tools section, click the Import My Contacts 

or Import My Organization Contacts button. 

Note: Import link is displayed only if you have privilege to use Import feature. Please 

contact your administrator in case these links are disabled.  

3. In the Specify Import File: page, browse the Contacts-related import file (CSV/XLS 

format) and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with contact fields in 

Zoho CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Contacts: Home page, imported contacts are displayed under the Contacts List 

section. You can continue the importation further or complete the operation.  

Associating Contact with other Records 

(Access Privilege: Read/Write permissions) 

You can create a 360-degrees view of the contact to display all the associated details, such as 

potentials, trouble tickets, open activities, history of the completed activities, attachments, and 

notes.  

To associate contact with other records 

1. In the Contact: <Contact Name> page, you can update the following details:  

o Open Activities: To add tasks and events  

o Closed Activities: To display all the closed tasks and events  

o Cases: To create cases for the contact  
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o Products: To add products for the contact  

o Attachments: To attach documents and notes  

o Notes: To attach notes to the contact.  

2. After updating the associated records, you can move to the next record.  

Sending Emails to Contacts 

(Access Privilege: Read/Write permissions) 

You can create mailing list for contacts and send mass E-mail to the contacts from contact list 

view. Please ensure the contacts contain an E-mail ID otherwise, E-mail will not be sent to the 

corresponding contact(s). 

Note: Standard Users can use the standard E-mail templates available in the system where as 

System Administrator can create E-mail templates from Setup section. If you are a System 

Administrator, refer to the Creating E-mail Templates section. 

To send Emails to individual contacts 

1. Click the Contacts tab.  

2. In the Contacts: Home page under the Contact List View section, select the contact.  

3. In the Contact Details page, go to Mails related list view and click the Send Mail button.  

4. In the Compose Mail page, enter the email message, attach files, add additional email IDs 

in CC & BCC fields, and finally click the Send button. An Email will be sent to the 

recipients and copy of the mail is stored under Mails related list view.  

To send Emails to a group of contacts 

1. Click the Contacts tab  

2. In the Contacts: Home page under the Contact Tool section, click the Mass E-mail 

Contacts link.  

3. In the Mass E-mail page, do the following:  

o By default, the E-mail Template tab is enabled. Select the template to be used 

from the E-mail Template pick list. The template content is displayed under E-

mail Template Body section.  

o Click Matching Criteria tab. You can create a contacts mailing list by specifying 

the matching criteria under Specify Criteria section.  

4. Click the Send button to send the E-mail message to the selected contacts.  

 

http://www.zoho.com/crm/help/workflow/managing_workflow.html#Email_Templates
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Exporting Contacts 

(Access Privilege: Data Export permission) 

Occasionally it is very useful to export the contacts from Zoho CRM to Spreadsheet programs 

for further data analysis. 

To export contacts to spreadsheets 

1. Click the Contacts tab.  

2. In the Contacts: Home page under the Contact Tools section, click the Export All 

Contacts button.  

3. In the File Download pop-up dialog, click Save to save the contacts files in CSV/XLS 

file format.  

Changing Contact Owner 

(Access Privilege: Owner change permission) 

When the prospecting is in progress, occasionally it may be very useful to change the owner of 

some of the contacts in a single step. You can change the owner of an individual contact or a 

group of contacts. 

To change owner of contacts individually 

1. Click the Contacts tab.  

2. In the Contacts: Home page, select the contact.  

3. In the Contact: <Contact Name> page, click the Edit button.  

4. In the Contact: <Contact Name> page, change the contact owner from the Contact 

Owner lookup field.  

5. Click Save to update the contact owner.  

To change owner of contacts in bulk 

1. Click the Contacts tab.  

2. In the Contacts: Home page, go to the Contact List section and select the check boxes 

corresponding to the contacts. You can also select all the contacts.  

3. Click the Change Owner button.  

4. In the Contacts: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the contacts permanently. 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

68 ©2007, AdventNet Inc. All rights reserved.  

 

Warning: Contacts ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise contacts belonging to different 

users will be changed to new user. To overcome this problem, first you may search the 

contacts with a required owner name then change the owner in bulk. 

Printing Contact Details 

(Access Privilege: Read permission) 

You can view a printable form and print the contact details using browser's Print function. 

To print contact details 

1. Click the Contacts tab.  

2. In the Contacts: Home page, go to the Contact List section and select the required 

contact.  

3. In the Contact: <Contact Name> page, click the Print Preview button.  

4. In the Contact: <Contact Name>, page, click the Print Page button to print the 

document.  

Viewing Reports 

(Access Privilege: Read/Write permissions) 

You can directly access some of the standard reports pertaining to contacts from the Contacts 

Reports section. By default, the following reports are displayed under Contacts module: 

 Contact Mailing List  

 Key Accounts  

 Accounts by Industry  

To view contact report  

1. Click the Contacts tab.  

2. In the Contacts: Home page, go to the Contacts Reports section.  

3. Click the required report link. The report is displayed in Reports page, which can be 

further customized as per your requirements.  

For more details about reports customization refer to Chapter <>: Working with Reports. 
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Deleting Contacts 

(Access Privilege: Read/Write/Delete permissions) 

Rarely, you may need to remove some of the unnecessary contacts, which are moved from the 

existing account or not doing business with you for a long time. This will help you manage your 

contacts in a better way. You can delete contacts either individually or in bulk. 

Note: The deleted contacts are temporarily stored in Recycle Bin. If required you can restore 

the deleted contacts again. However, if you delete contacts from Recycle Bin, you cannot restore 

again. 

To delete contacts individually 

1. Click the Contacts tab.  

2. In the Contacts: Home page, select the contact to be removed.  

3. In the Contact: <Contact Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the contact permanently.  

To delete contacts in bulk 

1. Click the Contacts tab.  

2. In the Contacts: Home page, under the Contact List section, select the contacts to be 

removed using the Select Contacts check box (first column).  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to remove the selected contacts permanently.  

Customizing Contacts 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the contacts module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying contacts page layout, and 

show/hide the related list views according to your Contact management process requirements. 
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Working with Opportunities 
 

In any sales organization, potentials are the most important records to generate the real revenue 

for the organization. In a typical B2B organization, all the potentials have to undergo a complete 

sales cycle, which start with identifying the hot prospect and end with sales won or lost. The in 

between sales activities that has to be completed are sending product information to potentials, 

product demonstrations, sending sales quotations and business negotiations. Precisely, potential 

provides the following information for the sales management: 

 Sales cycle (Duration of the prospecting the potential)  

 The potential sales volume (Product units and price)  

 Up-to-minute sales stage and the estimated sales probability in each stage  

 Reasons for the sales status (Won/Lost)  

 Competitors of the potential  

 Forecast for the next quarter/year sales  

The Potentials home page contains, 

 Potentials List  

 Potential Reports  

 Tools such as Import, Export, change owner, and delete  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Page Navigation  

You can perform the following operations in Potentials module: 

 Navigate potentials  

 Search potentials (Alphabetical or advanced search options)  

 Creating Custom List Views  

 Create potentials (Form filling, quick create, or duplicate options)  

 Import potentials (from external sources)  

 Associate potentials with other records  

 Associate competitors with potential  

 Add contact roles  

 Customize contact roles  

 Change potential owner (individually or in bulk)  

 Export potentials to spreadsheets  

http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Navigate_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Searching_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Creating_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Importing_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Associating_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Competitors_with_Potential
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Add_Contact_Roles
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Customizing_Contact_Roles
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Changing_Potential_Owner
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Exporting_Potentials
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 Print potentials details  

 View reports  

 Delete potentials(individually or in bulk)  

 Customize potentials  

 Set up Big-Deal Alert  

 Configure Sales Stage pick lists  

 Map Sales Stage-Probability values  

Navigating Potentials 

(Access Privilege: Read permission) 

You can navigate potentials available in the potentials list according to the status of the 

potentials. 

To navigate potentials 

1. Click the Potentials tab.  

2. In the Potentials Home page, under the Potential List section, select one of the views 

from the Select View drop-down list to display the list of accounts according to the type 

of the account (For example, Prospect, Investor, Reseller, and others).  

3. In the Potential List section, click the Start, Previous, Next, or End link to access the 

respective list of potentials.  

Searching Potentials 

(Access Privilege: Read permission) 

You can search the potentials alphabetically or filling the required information in Search box. 

To search potentials 

1. Click the Potentials tab.  

2. In the Potentials Home page, under the Potential Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Potential List page, a list of potentials is displayed as per search criteria.  

Creating Custom List Views 

http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Printing_Potential_Details
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Deleting_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Customizing_Potentials
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Big_Deal_Alert
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Sales_Stage_picklists
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Stage_Probabiity
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(Access Privilege: Read/Write permissions) 

In the Potential List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Potentials module: 

 Standard Views  

o All Potentials  

o My Potentials  

o New This Week  

o New Last Week  

o Closing This Month  

o Closing Next Month  

 Recent Views  

o Recently Created Potentials  

o Recently Modified Potentials  

o Recently Viewed Potentials  

To create custom views 

1. Click the Potentials tab.  

2. In the Potentials Home page, under Potential List section, click the Create View link. 

Note: Under the Potential List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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Creating Potentials 

(Access Privilege: Read/Write permissions) 

In Zoho CRM, you can create potentials as given below: 

 By entering data in potential details form  

 Importing potentials from other sales force automation applications  

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Potential: Edit form, you need to specify the potential-related information. The following 

table provides descriptions of the various fields in the form. 

List of standard potential-related fields 

Field Name Description Data Type 

Potential Name* 
Specify name of the potential. This field is 

mandatory. 

Text box, Alphanumeric 

(120) 

Account Name* 
Select name of the account to which potential has 

to be created. This field is mandatory. 
Lookup 

Type 
Select the type of potential (New Business or 

Existing Business) from the drop-down list. 
Pick list 

Lead Source Select the lead source from the drop-down list Pick list 

Product Name Select the product name from the pick list. 
Text box, Alphanumeric 

(50) 

Amount 
Specify the amount that can be expected after 

closing the potential.  
Text box, Decimal (10) 

Expected Close 

Date* 

Specify or select the expected close date. This 

field is mandatory. 

Date format 

(yyyy/mm/dd) 

Next Step Specify the next step of the sales process. 
Text box, Alphanumeric 

(100) 

Sales Stage* 
Select the sales stage from the drop-down list. 

This filed is mandatory. 
Pick list 

Probability Specify the probability of closing a potential. Text box, Decimal (2, 2) 
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Field Name Description Data Type 

Assigned To 
Select the user to whom the potential has to be 

assigned. 
Pick list 

Description Specify any other details about potential. Text area (long text) 

You can create potentials by: 

 Filling details in the potential creation form.  

 Using the New Potential, a quick create component present in left hand-side of the 

Potentials Home page  

 Duplicating the contact with a few changes from the existing contact details  

To create potentials individually 

1. Click the New Potential link.  

2. In the Potential: page, enter the potential information. 

 

Note: Company name is a mandatory field. Refer to the “List of Standard Potential-

related Fields” section for more details.  

3. Click Save to save the potential information. Potential details are displayed in Potential: 

<Potential Name> page where you can perform the additional operations. Refer to the 

Associating Potentials with Other Records section for more details.  

To create potentials instantly 

1. Click the Potentials tab.  

2. In left hand-side under New Potential section, enter the mandatory details, such as 

Potential Name, Account Name, Expected Close Date, and Sales Stage.  

3. Click Save. Potential details are displayed in Potential: <Potential Name> page where 

you can update the additional details or perform the additional operations.  

To create duplicate potentials 

1. Click the Potentials tab.  

2. In the Potential List view page, select the potential to be duplicated.  

3. In the Potential: < Potential Name> page, click the Duplicate button.  

4. In the Edit: < Potential Name> page, modify some of the potential-related details.  

5. Click Save. Potential details are displayed in the Potential: < Potential Name> page 

where you can perform the additional operations.  

http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Standard_Potential_fields
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Standard_Potential_fields
http://zohocrm.wiki.zoho.com/Working-with-Opportunities.html#Associating_Potentials
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Importing Potentials 

(Access Privilege: Data Import permission) 

You can migrate your potentials from other CRM and Account Management applications. Before 

migrating data, you must convert the data into CSV/XLS format. Import link is displayed only if 

you have privilege to use Import feature. Please contact your administrator in case import link is 

disabled. 

Tips 

 Before importing potentials into Zoho CRM, you must have the potentials details in a 

CSV/XLS file.  

 You must have privilege to import the potentials in Zoho CRM.  

 Before importing the potentials into Zoho CRM close the CSV/XLS file and the 

Spreadsheet program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 potentials in one import cycle.  

To import potentials 

1. Click the Potentials tab.  

2. In the Potentials: Home page under Potential Tools section, click the Import My 

Potentials or Import My Organization Potentials button.  

3. In the Specify Import File: page, browse the Potentials-related import file (CSV/XLS 

format) and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with potential fields in 

Zoho CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Potentials: Home page, imported potentials are displayed under the Potentials List 

section. You can continue the importation further or complete the operation.  
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Associating Potential with Other Records 

(Access Privilege: Read/Write permissions) 

You can create a 360-degrees view of the potential to display all the associated details, such as 

open activities, history of the completed activities, contacts, products, sales stage history, 

attachments, and notes. 

To associate potential with other records 

1. In the Potential page, you can update the following details:  

o Sales Stage History: To display the history of the sales stage.  

o Competitors: To associate competitors to the potential.  

o Contact Roles: To select contacts associated to the potential.  

o Open Activities: To create tasks and events.  

o Closed Activities: To display the completed tasks and events.  

o Products: To add products to the potential.  

o Quotes: To create quote for the potentials.  

o Sales Orders: To create sales order for the potential.  

o Invoices: To create invoices for the potential.  

o Attachments: To attach documents to the potential.  

o Notes: To add notes to potential.  

2. After updating the associated records, you can move to the next record.  

Associating Competitors with Potential 

(Access Privilege: Manage Competitor permission) 

Most of the companies prefer to purchase products after analyzing the track of the different 

vendors. If you are working with a highly competitive market, where your competitors are 

directly competing with you in winning the deals, it is always better to know their strengths and 

weaknesses well in advance so that you can propose your offering in a better way. 

In the competitor page, you can add the competitor's strengths and weaknesses. 

To associate competitors with potential  

1. Click the Potentials tab.  

2. In the Potentials: Home page under Potential List section, select the required potential.  

3. In the Potential Details page under Competitors section, click the New button.  
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4. In the Competitor page, under Competitor Information section do the following:  

o Competitor Name: Specify the company name of the competitor. This is a 

mandatory field  

o Website: Specify the URL of the competitor website.  

o Strengths: Specify the strengths of the competitor's offering.  

o Weaknesses: Specify the weaknesses of the competitor's offering.  

5. Click Save.  

Adding Contact Roles to Contacts 

(Access Privilege: Read/Write permissions) 

While prospecting, you may need to contact different persons (contacts) to finalize the sales deal. 

It is always better to know the contact's role in your prospecting organization, so that always you 

have a right discussion with the right persons. For example, explaining about product price and 

discounts is always better with Financial Manager where as product features with the Product 

Manager. This kind of approach helps you to negotiate with the prospecting organization in a 

better way and cut short the sales lead-time. 

To add contact roles to contacts 

1. Click the Potentials tab.  

2. In the Potentials: Home page under Potential List section, select the required potential.  

3. In the Potential Details page under Contact Roles section, list of contacts associated with 

potential are displayed. Click the Add Role button.  

4. In the Contact Roles Mapping page, for each contact select the role from the Contact 

Role drop-down list.  

5. Once you have completed associating roles to all the contacts, click Save.  

Customizing Contact Roles 

(Access Privilege: Contact Role permission) 

By default, some of the contact roles, such as Decision Maker, Product Management, Purchasing 

and other roles are available. You can customize the contact roles according to your business 

process. 

Note: Users with "Administrator" privilege can customize the contact roles. Please contact 

your System Administrator in case you need some additional roles. 
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To add/modify contact roles 

1. Click the Setup link.  

2. In the Setup page under the Potential Settings section, click the Contact Roles link.  

3. In the Edit Contact Roles page, do the following:  

o Click the Add Role link to add a new role.  

o Click the Delete Role link after selecting the role(s) to delete roles.  

o Modify the existing roles from the Contact Role text box.  

4. Once you have completed updating the contact roles click Save.  

Changing Potential Owner 

(Access Privilege: Read/Write permissions) 

When the prospecting is in progress, occasionally it may be very useful to change the owner of 

some of the potentials in a single step. You can change the owner of an individual potential or a 

group of potentials. 

To change owner of potentials individually 

1. Click the Potentials tab.  

2. In the Potentials: Home page, select the potential.  

3. In the Potential: <Potential Name> page, click the Edit button.  

4. In the Potential: <Potential Name> page, change the potential owner from the Potential 

Owner lookup field.  

5. Click Save to update the potential owner.  

To change owner of potentials in bulk 

1. Click the Potentials tab.  

2. In the Potentials: Home page, go to the Potential List section and select the check boxes 

corresponding to the potentials. You can also select all the potentials.  

3. Click the Change Owner button.  

4. In the Potentials: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the potentials 

permanently. 

Warning: Potentials ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise potentials belonging to different 

users will be changed to new user. To overcome this problem, first you may search the 
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potentials with a required owner name then change the owner in bulk. 

Exporting Potentials 

(Access Privilege: Data Export permissions) 

Occasionally, it is very useful to export the potentials from the Zoho CRM system to a 

spreadsheet programs for further data analysis. 

To export potentials to external sources 

1. Click the Potentials tab.  

2. In the Potentials: Home page under the Potential Tools section, click the Export All 

Potentials button.  

3. In the File Download pop-up dialog, click Save to save the Potentials files in *.CSV file 

format  

Printing Potential Details 

You can view a printable form and print the potential details using browser’s Print function. 

To print potential details 

1. Click the Potentials tab.  

2. In the Potentials: Home page, under the Potential List section, select the required 

potential.  

3. In the Potential: <Potential Name> page click the Printable View button.  

4. In the Potential: <Potential Name> page, click the Print Page button to print the 

document.  

Viewing Reports 

(Access Privilege: Read permission) 

You can directly access some of the standard reports pertaining to potentials from the Potentials 

Reports section. By default, the following reports are displayed under Potentials module: 

 Pipeline by Stage  

 Potentials Closing by this Month  
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 Sales Person's Performance Report  

 Lost Potentials  

 Potentials by Type  

 Open Potentials  

 Pipeline by Probability  

 Sales By Lead Source  

 This month sales  

 Today's Sales  

To view potentials report  

1. Click the Potentials tab.  

2. In the Potentials: Home page under the Potentials Reports section, click the required 

report link.  

3. The report is displayed in Reports page, which can be further customized as per your 

requirements.  

Deleting Potentials 

(Access Privilege: Read/Write/Delete permissions) 

Rarely, you may need to remove the unnecessary potentials, which are lost. This helps you 

manage your potentials in a better way. You can delete potentials either individually or in bulk. 

Warning: The deleted potentials are temporarily stored in Recycle Bin. If required you can 

restore the deleted potentials again. However, if you delete potentials from Recycle Bin, you 

cannot restore again. 

To delete potentials individually 

1. Click the Potentials tab.  

2. In the Potentials: Home page, select the potential to be deleted.  

3. In the Potential: <Potential Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the potential permanently.  

To delete potentials in bulk 

1. Click the Potentials tab.  

2. In the Potentials: Home page, under the Potential List section, select the potentials to be 

deleted using Select Potentials check box (first column).  
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3. Click the Mass Delete button.  

4. In the Confirmation dialog, click OK to delete the selected potentials permanently.  

Customizing Potentials Module 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the Potentials module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying Potential page layout, and 

show/hide the related list views according to your Sales management process requirements. 

For more details, refer to Customizing Zoho CRM 

Setting up Big Deal Alert 

You can use the Big-deal Alert function to notify your management/Colleagues if there is a 

chance of winning a big deal, which you wish to share the good news with them. Sometimes 

executive board members may be interested to know all the Big-deal information well in 

advance. You can send the Big-deal alert as an e-mail notification to all the Zoho CRM 

users/selected users and colleagues not registered as Zoho CRM users. 

To configure big deal alert  

1. Click the Setup link.  

2. In the Setup: Home page, under Potentials Settings section, click the Big Deal Alert link.  

3. In the Workflow Rule page, do the following:  

4.  

o In the Rule Edit section, the Big Alert rule details are displayed. The default 

criteria is "Amount >= 1000 and the probability = 100". You can change the 

Amount and Probability by editing the existing criteria.  

o In the Related Alerts section, the Alert details are displayed. The default alert is 

"Select the Big Deal E-mail template and send to all the users in Zoho CRM". 

You can change the Alert details by editing the existing alert.  

o In the Related Tasks section, you can add tasks for the Big deal Alert rule.  

For more details, refer to Chapter 25: Managing Workflow 

Configuring Sales Stage Pick list 

You can modify the default stage for new and converted leads. 

http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html
http://www.zoho.com/crm/help/workflow/managing_workflow.html
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To configure Sales Stage Pick list 

1. Click the Setup link.  

2. In the Setup: Home page, under Potentials Settings section, click the Field List link.  

3. In the Potentials List page, edit the Sales Stage field.  

4. In the Edit Pick List page, add/modify values in the Values list box. Once you have 

updated the pick list values you can sort the values alphabetically and use the first values 

as the default pick list value.  

5. Click Save.  

Mapping Stage and Probability Values 

Sales Stage is very important criteria to identify the performance of organization-wide Sales 

pipeline. In the Stage-Probability mapping page, you can perform the following operations: 

 Create different types of Sales stages according to your organization-wide Sales process  

 Associate Probability values to the Sales stages  

 Associate Forecast types (Open, Closed-won, or Closed-lost) to Sales stages  

 Associate Forecast categories (Pipeline, Closed, Omitted, Best Case, Committed) - For 

more details refer to Chapter 7: Managing Sales Forecasts  

Tips: 

 For a better sales pipeline analysis assign different probabilities to sales stage values.  

 For each stage, assign probability in the range of 0 to 100.  

 You may consider using probability value as 100 when the deal is closed-won and 0 for 

deal closed-lost.  

To map stage and probability values 

1. Click the Setup link.  

2. In the Setup: Home page, under Potentials Settings section, click the Stage-Probability 

Mapping link.  

3. In the Stage-Probability Mapping page, do the following:  

o Add the Sales Stage and the corresponding Probability of closing the sales deal  

o Delete Sales Stage and assign the existing Probability to another Sales Stage 

value  

o To modify the existing Sales Stages, use the Replace option.  
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4. Click Save.  

To map sales stage and forecast type  

1. Click the Setup link.  

2. In the Setup: Home page, under Potentials Settings section, click the Stage-Probability 

Mapping link.  

3. In the Stage-Probability Mapping page, do the following:  

o Add the Sales Stage and the corresponding Forecast Type  

o Delete Sales Stage and assign the existing Forecast Type to another Sales Stage 

value.  

4. Click Save.  

To map sales stage and forecast category  

1. Click the Setup link.  

2. In the Setup: Home page, under Potentials Settings section, click the Stage-Probability 

Mapping link.  

3. In the Stage-Probability Mapping page, do the following:  

o Add the Sales Stage and the corresponding Forecast Category  

o Delete Stage Stage and assign the existing Forecast Category to another Sales 

Stage value.  

4. Click Save.  
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Working with Forecasts 
 

Forecasting provides real-time insight for tracking the sales numbers against quotas, 

probabilities, plans, etc., which helps organization to fine-tune the organization-level sales 

process. For sales mangers, forecast feature provides an overall picture of company sales 

pipeline, as well as those of each individual sales staff performance. Sales Representatives can 

use forecasting to meet/exceed quotas assigned to them and in turn increase company profits. 

Note: In Zoho CRM, you cannot consolidate the individual sales persons' forecasts and 

provide the organization-wide forecast. 

You can perform the following operations in Forecasts module: 

 Navigate forecasts  

 Search forecasts (Alphabetical or Advanced search options)  

 Create list views  

 Create new forecasts (Form filling, quick create, or duplicate options)  

 Associate forecast with other records  

 View forecast reports  

 Delete forecasts (individually or in bulk)  

Navigating Forecasts 

(Access Privilege: Read permission) 

You can navigate the forecasts according to the status of the forecasts. 

To navigate forecasts 

1. Click the Forecasts tab.  

2. In the Forecasts Home page, under the Forecast List section, select one of the views 

from Select View drop-down list to display the list of forecasts according to the status of 

the forecasts (For example, Contacted, Hot, Won, and others).  

3. In the Forecast List section, click the Start, Previous, Next, or End links to access the 

respective list of forecasts.  

Searching Forecasts 

http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Navigating_Forecasts
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Searching_Forecasts
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Creating_Forecasts
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Associating_Forecasts
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Deleting_Forecasts
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(Access Privilege: Read permission) 

You can search forecasts alphabetically are filling the required information in Search box. 

To search forecasts 

1. Click the Forecasts tab.  

2. In the Forecasts Home page, under Search section, do one of the following:  

3.  

o Specify the search criteria in the Search field and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Forecast List page, a list of forecasts is displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Forecast List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Forecasts module: 

 All Forecasts  

 My Forecasts  

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Forecasts tab.  

2. In the Forecasts Home page, under Forecast List section, click the Create View link. 

Note: Under the Forecast List section, some of the standard list 

views are displayed. You can only rearrange the order of the 

columns and add more columns. 

3. In the Create New View page, do the following:  



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

86 ©2007, AdventNet Inc. All rights reserved.  

 

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Forecasts 

(Access Privilege: Read/Write permission) 

In Zoho CRM, you can create forecasts for a financial year and for each quarter by entering data 

manually in forecast details. 

If you have already created forecast for a specific quarter, you cannot create forecast for the 

same quarter. For example, first, you have created a forecast for the Quarter 1 in Year 2006, and 

then you cannot create a new forecast in the same quarter. You can only modify the existing 

quarter details. 

Note: You cannot customize the fields in forecast module. 

List of Standard Forecast-related Fields 

In the Forecast: Edit form, you need to specify the forecast-related information. The following 

table provides descriptions of the various standard fields in the form. 

Field Name Description Data Type 

Year* Select the fiscal year from the drop-down list. Pick list 

Quarter* Select the quarter of the fiscal year. Pick list 

Month Display the month of the selected quarter. Month 

Quota Specify the quota for the month. Currency 

Closed Display the amount from the closed won potentials. Currency 

Commit Amount 
Specify the total amount a sales person confident of 

closing during forecast period. 
Currency 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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Field Name Description Data Type 

Best Case 

Amount 

Specify the amount a sales person might be closing. This 

amount can be either more or less than Commit Amount. 
Currency 

Pipeline Displays the amount in the sales pipeline. Currency 

Owned By Displays the owner of the forecast. Lookup 

Created By Displays the person created the forecast first time. Date/Time 

Last Modified By Displays the person modified the forecast. Date/Time 

By default, the person who creates the forecast owns the forecast. If you want to assign the 

forecast to a different user, select the user name from the Change Owner field in the forecast 

details view. 

To create forecasts 

1. Click the New Forecast link.  

2. In the New Forecast: page, select the mandatory forecast-related fields, such as Year and 

Quarter. 

Note: The Year and Quarter fields are mandatory. Refer to 

the List of Standard Forecast-related Fields section for more 

details. 

3. Click Save. Forecast details for the three months and forecast history are displayed in the 

forecast details page.  

Associating Forecasts with Other Records 

(Access Privilege: Read/Write permissions) 

After creating forecasts, you can add potentials in each month. Once the potential is closed, it is 

automatically displayed under forecast history. All the potentials created/followed-up are 

displayed under sales person's monthly forecast list. 

To associate forecast with other records 

1. In the Forecast: <Forecast Name> page, you can update the following details:  

2.  

o Months list Potentials: To display the potentials in each month. You can also 

add new potential to the month.  

http://zohocrm.wiki.zoho.com/Working-with-Forecasts.html#Standard_Forecast_fields
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o Forecast History: To display the historical data of the forecasts.  

2. After updating the associated records, you can move to the next record.  

Viewing Reports 

(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to forecasts from the Forecasts 

Reports section. By default, the following reports are displayed under Forecasts module: 

 Quarterly Sales Forecast  

 Forecast History 

To view forecast report  

1. Click the Forecasts tab.  

2. In the Forecasts: Home page under the Forecasts Reports section click the required 

report link. The report is displayed in Reports page, which can be further customized as 

per your requirements.  

For more details about reports customization, refer to Chapter 19: Working with Reports. 

Deleting Forecasts 

(Access Privilege: Read/Write/Delete permission) 

Occasionally you may need to remove some of the unnecessary forecasts from the Zoho CRM 

system for a better user experience. You may consider removing forecasts that are not useful for 

future reference. 

Warning: The forecast details are deleted permanently, hence use the delete operation 

carefully. 

To delete forecasts individually 

1. Click the Forecasts tab.  

2. In the Forecasts: Home page under the Forecast List section, select the forecast.  

3. In the Forecast: <Forecast Name> page, click the Delete button.  

http://www.zoho.com/crm/help/reports/working_with_reports.html
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4. In the Confirmation dialog, click OK to remove the forecast permanently.  

To delete forecasts in bulk 

1. Click the Forecasts tab.  

2. In the Forecasts: Home page under the Forecast List section, select the check boxes 

corresponding to the forecasts to be removed.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to remove the selected forecasts permanently.  
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Working with Cases 
 

In the Internet world, online Customer Support became an integral part of the organizations' 

business process. Customer Support is becoming an important activity in retaining all types of 

products and service industries. In general cases (trouble tickets) are used to capture the 

customer feedback on various types of problems arises after purchasing product/service from 

your company. Sometimes customers may provide some good feature requests, which can be 

useful during future product/service enhancements. 

Typical Case Management Process 

1. Customize the fields in Case page according to your organization Customer Support 

process (You may use the existing fields, disable some of the fields, or add new custom 

fields).  

2. Setup case generation process by filling the Case form, importing cases data from 

external sources, or capturing cases directly from Website using Web-to-Case form.  

3. Assign cases to the correct users using the workflow rules.  

4. Follow-up cases until resolutions are sent to the customers.  

5. Once the resolution is working fine, add the solution to the publicly accessible Solutions 

module for future reference.  

In Zoho CRM, cases can be generated through telephone, E-mail, or Website. In addition, you 

can also generate cases from customer specific E-mails in Microsoft Outlook using the Zoho 

CRM Outlook Edition. Refer to Chapter 28: Working with Outlook Edition. 

The Cases home page contains, 

 Cases List  

 Case Reports  

 Tools, such as Import, Export, mass transfer, and delete cases  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Change Owner  

 Delete  

 Page Navigation  

You can perform the following operations in Cases module: 

http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Outlook-Plugin.html
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 Navigate cases  

 Search cases (Alphabetical or advanced options)  

 Create List views  

 Create cases (Form filling, quick create, or duplicate options)  

 Associate cases with other records  

 Import cases (individual/Organizational)  

 Change case owners (individually or in bulk)  

 Export cases  

 Print cases details  

 View case reports  

 Delete cases (individually or in bulk)  

 Customize cases  

 Capture cases from Website (using Web-to-Case form)  

 Track cases through Email  

Navigating Cases 

(Access Privilege: Read permission) 

You can navigate cases available in the Cases List. 

To navigate cases 

1. Click the Cases tab.  

2. In the Cases Home page, go to the Cases List section and select one of the views from 

Select View drop-down list to display the list of Cases according to the priority of the 

Case (For example, Low, Medium, High, and others).  

3. In the Cases List section, click the Start, Previous, Next, or End link to access the 

respective list of cases.  

Searching Cases 

(Access Privilege: Read permission) 

You can search the cases alphabetically or filling the required information in Search box. 

To search cases 

1. Click the Cases tab.  

2. In the Cases Home page, under Case Search section, do one of the following:  

http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Navigating_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Searching_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Creating_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Associating_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Importing_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Changing_Case_Owner
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Exporting_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Printing_Case_Details
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Viewing_Case_Reports
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Deleting_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Customizing_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Web_to_case
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3.  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Case List page, a list of cases is displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Case List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Cases module: 

 All Cases  

 My Cases  

 Today Cases  

 Open Cases  

 Closed Cases  

 Escalated Cases  

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Cases tab.  

2. In the Cases Home page, under Case List section, click the Create View link. 

Note: Under the Case List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box.  
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o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Cases 

(Access Privilege: Read/Write permissions) 

In Zoho CRM, you can create cases by: 

 Entering data manually into case details form  

 Importing cases from external sources  

 Capture cases from Website through Web-to-Case form  

 Adding customer-specific e-mail message as case from Microsoft Outlook to Cases 

module  

In the Case: Edit form, you need to specify the case-related information. The following table 

provides descriptions of the various fields in the form. 

List of Standard Case-related Fields 

Field Name  Description  Data Type  

Case Number Display the case ID after creating a case. Number 

Case Owner 
Select the name of the Zoho CRM user to whom 

the Case is assigned. 
Lookup 

Subject* 
Specify the title of the Case. This field is 

mandatory. 

Text box, Alphanumeric 

(255) 

Priority 
Select the priority of the Case from the drop-down 

list. 
Pick list 

Status 
Select the status of the Case from the drop-down 

list. 
Pick list  

Category 
Select the category of the Case from the drop-down 

list.  
Pick list 

Reported By Displays the name of the contact. - 

Related To Select the name of the contact who submitted the Lookup 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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Field Name  Description  Data Type  

Case. 

Type 

Select the type of problem. It can be a general 

question, feature request, or real issue in your 

product/service. 

Pick list 

Case Origin 

Select the source from which the case has been 

generated. You can select Email, Phone, or 

Website. If you select Email, you must specify the 

Email ID of the customer. 

Pick list 

Email Specify the Email ID of the contact. Email 

Phone Specify the phone number of the customer Textbox 

Case Reason Specify the reason for the case Pick list 

No of 

comments 

Display the number of comments submitted during 

case resolution. 
- 

Description Specify complete details about the case.  Text Area (32 KB) 

Comments Specify follow-up notes about case. Text Area (32 KB) 

To create cases 

1. Click the New Case link.  

2. In the Case: page, enter the details. 

 

Note: Case Title is a mandatory field. Refer to the List of Standard Case-related Fields 

section for more details.  

3. Click Save to save the Case details. Case details are displayed in Case: <Case Name> 

page where you can perform the additional operations. Refer to the Associating cases 

with Other Records section for more details.  

To create cases instantly 

1. Click the Cases tab.  

2. In left hand-side under the New Case section, specify the mandatory details, such as 

Status, Case Origin, and Subject.  

3. Click Save. Case details are displayed in the Case: < Case Name> page where you can 

update the additional details or perform the additional operations.  

To create duplicate cases 

1. Click the Cases tab.  

http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Standard_Ticket_fields
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Associating_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Associating_Cases
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Associating_Cases
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2. In the Case List view page, select the Case to be duplicated.  

3. In the Case: < Case Name> page, click the Clone button.  

4. In the Edit: < Case Name> page, modify some of the Case-related details.  

5. Click Save. Case details are displayed in the Case: <Case Name> page where you can 

perform the additional operations.  

Importing Cases 

(Access Privilege: Data Import permission) 

You can import cases from other Help Desk and CRM applications to the Zoho CRM system for 

a better integration of your organization-wide sales and customer support processes. 

Tips 

 Before importing cases into Zoho CRM, you must have the cases details in a CSV/XLS 

file.  

 You must have privilege to import the cases in Zoho CRM.  

 Before importing the cases into Zoho CRM close the CSV/XLS file and the Spreadsheet 

program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 cases in one import cycle.  

To import cases from external sources 

1. Click the Cases tab.  

2. In the Cases: Home page under Case Tools section, click the Import My Cases button.  

3. In the Import My Cases Wizard page, browse the Cases-related data (CSV/XLS format) 

and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with case fields in Zoho 

CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Cases: Home page, imported cases are displayed under the Cases List section. You 

can continue the importation further or complete the operation.  

Associating Cases with Other Records 

(Access Privilege: Read/Write permissions) 
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You can create a 360-degrees view of the Case to display all the associated details, such as 

potentials, cases, open activities, history of the completed activities, attachments, and notes. 

To associate cases with other records 

1. Click the Cases tab.  

2. In the Cases Home page, under the Case List section, select the required Case.  

3. In the Case: <Case Name> page, you can perform the following operations:  

o Edit the Case details.  

o Create activities, such as events and tasks related to case  

o Attach documents and notes  

4. Close the case page once all the required information is updated for the case.  

Exporting Cases 

(Access Privilege: Data Export permission) 

Occasionally it is very useful to export the cases from Zoho CRM to Spreadsheet programs, such 

as Microsoft Excel, OpenOffice, and others for further data analysis. 

To export cases to external sources 

1. Click the Cases tab.  

2. In the Cases: Home page under the Case Tools section, click the Export All Cases 

button.  

3. In the File Download pop-up dialog, Click Save to save the cases details in CSV/XLS 

file format.  

Changing Case Owner 

(Access Privilege: Read/Write permission) 

You can change the owner of an individual case or a group of cases to other users. 

To change owner of cases individually 

1. Click the Cases tab.  

2. In the Cases: Home page, select the case.  

3. In the Case: <Case Name> page, click the Edit button.  
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4. In the Case: <Case Name> page, change the case owner from the Case Owner lookup 

field.  

5. Click Save to update the case owner.  

To change owner of cases in bulk 

1. Click the Cases tab.  

2. In the Cases: Home page, go to the Case List section and select the check boxes corresponding 
to the cases. You can also select all the cases. 

3. Click the Change Owner button.  

4. In the Cases: Change Owner page, select the user from the Select New Owner pick list and click 
the Update Owner button to change the owner of the cases permanently. 

Note: Cases ownership will be changed to another user, irrespective of its existing owner. Use this 
operation carefully, otherwise cases belonging to different users will be changed to new user. To 
overcome this problem, first you may search the cases with a required owner name then change the 
owner in bulk.  

Printing Case Details 

(Access Privilege: Read permission) 

You can view a printable form and print the Case details using browser's Print function. 

To print case details 

1. Click the Cases tab.  

2. In the Cases: Home page, under the cases List section, select the required Case.  

3. In the Case: <Case Name> page click the Printable View button.  

4. In the Case: <Case Name> page, click the Print Page button to print the document.  

Viewing Case Reports 

(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to cases from the Case Reports 

section. By default, the following reports are displayed under Cases module: 

 Cases By Origin  

 Cases By Status  
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 Cases By Priority  

 Cases By Comments  

To view case report 

1. Click the Cases tab.  

2. In the Cases: Home page, go to the Case Reports section.  

3. Click the required report link. The report is displayed in Reports page, which can be 

further customized as per your requirements.  

Deleting Cases 

(Access Privilege: Read/Write/Delete permissions) 

Rarely, you may need to remove the unnecessary cases, which are not tracked further. This will 

help you manage your cases in a better way. You can delete cases either individually or in bulk. 

Note: The deleted cases are temporarily stored in Recycle Bin. If required you can 

restore the deleted cases again. However, if you delete cases from Recycle Bin, you 

cannot restore again. 

To delete cases individually 

1. Click the Cases tab.  

2. In the Cases: Home page, select the Case to be deleted.  

3. In the Case: < Case Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the case permanently.  

To delete cases in bulk 

1. Click the Cases tab.  

2. In the Cases: Home page, under the cases List section, select the cases to be deleted using 

the Select check box (first column).  

3. Click the Mass Delete button.  

4. In the Confirmation dialog, click OK to delete the selected cases permanently.  

Customizing Cases 

(Access Privilege: Customize ZohoCRM.com permission) 
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Customization of the cases module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying case page layout, and show/hide 

the related list views according to your Case management process requirements. 

Capturing Cases from Website (Web-to-Case form) 

(Access Privilege: Customize ZohoCRM.com permission) 

Using Web-to-Case form your organization can allow Website visitors submitting cases directly 

to the Cases module. All the cases captured through Website are first assigned to the Customer 

Support Administrator, which can be reassigned to the corresponding Support persons. 

Important Points 

 Anyone visiting your Web site can submit cases and submit any type of information. 

Hence, you cannot control the Spam.  

 All the cases are first assigned to the User selected in Web-to-Case settings page. The 

Customer Support Administrator can change the case ownership to other users.  

 Contacts are automatically created if you have enabled Web to Contacts option in the 

Web-to-Case settings.  

 To send automate replies to visitors select the required e-mail template from the Web-to-

Case settings.  

 The generated Web-to-Case form contains only Web form related tags. You have to 

customize the generated case form further to suite your Website requirements.  

 Test the complete workflow of Web-to-Case form, before publishing in the Website.  

To create Web-to-Case form 

1. Click the Setup link.  

2. In the Settings Home page, under the Case Settings section click the Web-to-Case link.  

3. In the Capturing Cases from Website page, do the following:  

4. Enable Web-to-Case option for your organization: Refer To configure web-to-case 

settings section.  

5. Set up Custom Case Fields in Web-to-Case form: Refer To add custom case fields in 

Web-to-Case form section.  

6. Generate HTML page as per your fields in the Web-to-Case form: Refer To generate 

HTML page for Web-to-Case form section.  

7. The generated HTML page contains only the web form objects and minimal HTML tags. 

Customize the web page according to your Website layout requirements.  

http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Customer-Support.html
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Web_to_Case_Settings
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Web_to_Case_Settings
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Custom_Fields_in_Web_to_Case
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Custom_Fields_in_Web_to_Case
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Custom_Fields_in_Web_to_Case
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Generate_Web_to_Case_HTML_Page
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Generate_Web_to_Case_HTML_Page
http://zohocrm.wiki.zoho.com/Working-with-Cases.html#Generate_Web_to_Case_HTML_Page
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8. Publish the Web-to-Case form in your Website. Your Web site visitors can submit 

cases/feedback, which will be routed to Cases module. All the cases captured through 

web form are assigned to the Owner selected in Web-to-Case settings page.  

To configure Web-to-Case settings 

1. In the Capturing Cases from Website page, click the Web-to-Case link.  

2. In the Web-to-Case Settings page do the following:  

3. Enable Web-to-Case: Select the check box the enable the Web-to-Case form.  

4. Return URL: Specify the URL of the page to be displayed after visitor submits the case 

(For example, Thanks page for submitting the information)  

5. Default Case Owner/Creator: Specify the Zoho CRM user to whom the case has to be 

assigned.  

6. Web to Contacts: Enable this option to create contact upon submitting the case. Contact 

Name and Email are mandatory fields, which are added to Web-to-Case form.  

7. Default Response Template: Select the automate e-mail response template, which is 

used for sending an e-mail to the person submits the case.  

8. Click Save. Again, Capturing Cases from your Web Site page is displayed. Next go to 

Next Step.  

To add custom case fields in Web-to-Case form 

1. In the Capturing Cases from Website page, click the Setup Custom Case Fields link.  

2. In the Case Fields section, add the custom fields to be added. For more details, refer to 

Chapter 24: Customizing Zoho CRM  

3. Once you have completed the field customization, click the Web-to-Case link under Case 

Settings section.  

To generate HTML page for Web-to-Case form 

1. In the Capturing Cases from Website page, click the Generate the HTML link.  

2. In the Generating HTML for Web-to-Case page, do the following:  

3. Select Web Form Fields: Select the case fields to be displayed in the Web Form.  

4. Confirm Password: Specify your password (User who creates the Web-to-Case form) to 

authenticate your Account from the Zoho CRM on-demand service.  

5. Click the Generate HTML button.  

6. In the Copy Generated HTML page, copy the HTML content and paste to your favorite 

HTML editor and click Finish button.  

7. Customize the Web-to-Case form (HTML page) to suite your Website requirements and 

publish in your Website.  

http://www.zoho.com/crm/help/customization/customization.html
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Warning: If you change your password after publishing the Web-to-Case form, 

please ensure that updating the following information in Web-to-Case form. 

Example: 

<!-- Begin: Do not edit the section --> 

<form action="http://zohocrm.com/crm/WebtoCaseServlet?encoding=UTF-8" 

method="POST"> 

<input type='hidden' name='orgId' value='1'/> 

<input type='hidden' name='xnQsjsdp' 

value=Z29wYWxzQGFkdmVudG5ldC5jb20=/> 

<input type='hidden' name='xmPqMMnsd' value=dGVzdGl0/> 

<input type='hidden' name='actionType' value=Q2FzZXM=/> 

<input type='hidden' name='returnURL' value='http://www.zohocrm.com' /> 

<!-- End: Do not edit the section --> 

Otherwise, cases submitted through Website will not be captured in Cases module, 

due to authentication failure. 

Managing Email-bases Cases 

With the rapid growth of Internet and related technologies, Email has emerged as one of the most 

important media for the customer support. Email-based case management helps Zoho CRM 

customers is easy to use and track all the customer-specific cases in a consolidated  

Frequently Asked Questions 

1. What are all the various sources of cases? 

Ans: In Zoho CRM, cases can be generated from different customer touch-points, such as phone, 

e-mail, and website. You can create a case based on telephonic conversation with your customer, 

add the customer-specific e-mail message as case from Microsoft Outlook Mail client using 

Outlook Edition, or capture from the Website using Web-to-Case form. 

2. Is it possible to send replies to the customer queries from the Cases module? 

Ans: You cannot send replies to the customers from Cases module. 

3. I have published Web-to-Case form for my organization. However, my cases submitted by my 

Website visitors are not captured in Cases module. Why it is happening? 
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Ans: You may not be able to capture cases properly if: 

 Password is changes after publishing the Web-to-Case form.  

 Removed some of the necessary Web form action entries in your HTML page while 

customizing the Web-to-Case form.  
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Working with Solutions 
 

Over a period, direct customer support helps your organization to build a rich knowledge Base 

for future reference. Knowledge Base in the form of solutions (also called as articles or 

frequently asked questions) enables your organization in solving the repetitive problems 

encountered by customers with limited resources. Solutions module integrated with Cases is very 

useful for organizations that are mainly focusing on post-sales support, particularly technology 

and knowledge-based industries. 

The Solutions home page contains, 

 Solutions List  

 Solution Reports  

 Tools, such as Import, Export, mass transfer, and delete solutions  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Change Owner  

 Delete  

 Page Navigation  

You can perform the following operations in Solutions module: 

 Navigate Solutions  

 Search Solutions  

 Create List views  

 Create solutions  

 View solutions list  

 Attach documents to the solution  

 Import solutions  

 Export solutions  

 Print solution details  

 Change solutions Owners (individually or in bulk)  

 Delete solutions (individually or in bulk)  

 Customize Solutions  

Navigating Solution 

(Access Privilege: Read permission) 

http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Navigating_Solutions
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Searching_Solution
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Create_Solution
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#View_Solution
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Attach_Document
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Importing_Solutions
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Exporting_Solutions
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Print_solution_details
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Changing_Solution_Owner
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Deleting_Solutions
http://zohocrm.wiki.zoho.com/Working-with-Solutions.html#Customizing_solutions
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You can navigate cases available in the Solution List. 

To navigate solutions 

1. Click the Solution tab.  

2. In the Solution Home page, go to the Solution List section and select one of the views 

from Select View drop-down list to display the list of Solution according to the priority 

of the Case (For example, Low, Medium, High, and others).  

3. In the Solution List section, click the Start, Previous, Next, or End link to access the 

respective list of solutions.  

Searching Solution 

(Access Privilege: Read permission) 

You can search the solutions alphabetically or filling the required information in Search box. 

To search solutions 

1. Click the Solution tab.  

2. In the Solution Home page, under Solution Search section, do one of the following:  

3.  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Solution List page, a list of solutions is displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Solution List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Solutions module: 

 All Solutions  

 My Solutions  

 Published Solutions  
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Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Solutions tab.  

2. In the Solutions Home page, under Solution List section, click the Create View link. 

Note: Under the Solution List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Solutions 

(Access Privilege: Read/Write/Delete permission) 

In the Solutions: Edit form, you need to specify the Solutions-related information. The following 

table provides descriptions of the various fields in the form. 

List of Standard Solutions Fields 

Field Name Description Data Type 

Solution Title* Specify the subject of the solution. 
Text box, Alphanumeric 

(255) 

Solution Owner 
Select the Zoho CRM user's name to which the 

solution is assigned. 
Pick list 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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Field Name Description Data Type 

Product Name 
Select the name of the product to which the 

solution has to be associated. 
Lookup 

Category Select the category of the solution. 
Text box, Alphanumeric 

(255) 

Question* 
Select the priority of the solution from the drop-

down list. 

Text box, Alphanumeric 

(255) 

Answer* Specify solution details. Text Area 

Status Specify the status of the solution. Pick list 

Description Specify any other details about solution. Text Area (32 KB) 

Comments Specify additional comments about the solution. Text Area (32 KB) 

To create Solutions 

1. Click the Solutions tab.  

2. In the Solutions: page, specify the solution details. 

Note: Solution Title, Question, and Answer are mandatory fields.  

3. Click Save.  

To create solutions instantly 

1. Click the Solutions tab.  

2. In left hand-side under the New Solution section, specify the mandatory details, such as 

Solution Title, Question and Answer.  

3. Click Save. Solution details are displayed in the Solution: < Solution Name> page where 

you can update the additional details or perform the additional operations.  

To create duplicate solutions 

1. Click the Solutions tab.  

2. In the Solution List view page, select the Solution to be duplicated.  

3. In the Solution: < Solution Name> page, click the Clone button.  

4. In the Edit: < Solution Name> page, modify some of the Solution-related details.  

5. Click Save. Solution details are displayed in the Solution: <Solution Name> page where 

you can perform the additional operations.  

Importing Solutions 

(Access Privilege: Data import permission) 
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Administrator can import the solutions from other Help Desk and Knowledge Base applications. 

Tips 

 Use the CSV/XLS file format.  

 The import file should contain the header column to map the data with Zoho CRM.  

 Disable the Sort filter in import file (In import file, disable the filter option by Data  

Filter  AutoFilter).  

 Before importing the solutions into Zoho CRM close the import file and the 

corresponding Spreadsheet program.  

 Remove apostrophe if present anywhere in the import file.  

 You can import a maximum of 1000 potentials in one import cycle.  

To import solution from external sources 

1. Click the Solutions tab.  

2. In the Solutions: Home page under Solution Tools section, click the Import My 

Solutions button.  

3. In the Import My Solutions Wizard page, browse the solutions-related data (CSV/XLS 

format and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with solution fields in 

Zoho CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Solutions: Home page, imported solutions are displayed under the Solutions List 

section. You can continue the importation further or complete the operation.  

Viewing Solutions 

(Access Privilege: Read permission) 

Before replying to the cases, you may refer to the existing solutions. If the required solution is 

already available, you can save a lot of time and enhance the productivity. If the solution is not 

available, you can add a new solution item so that all the customer support persons can use it in 

future while encountering a similar problem. 

To view solutions 

1. Click the Solutions tab.  
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2. In the Solutions Home page, under the Solutions List section list of Solutions select the 

required Solutions.  

3. In the Solutions: <Solutions> page the answer for the question is displayed.  

Attaching Documents to the Solution 

(Access Privilege: Read/Write/Delete permission) 

You can attach additional documents to the solution. 

To attach documents with solution 

1. Click the Solutions tab.  

2. In the Solutions Home page, under the Solution List section, select the required Solution.  

3. In the Solution: <Solution Name> page, attach the documents.  

4. Close the Solution page once all the required information is updated.  

Exporting Solutions 

(Access Privilege: Export permission) 

Occasionally it is very useful to export the solutions from Zoho CRM to Spreadsheet programs, 

such as Microsoft Excel, OpenOffice, and others for further data analysis. 

To export solutions to spreadsheets 

1. Click the Solutions tab.  

2. In the Solutions: Home page under the Solution Tools section, click the Export All 

Solutions button.  

3. In the File Download pop-up dialog, Click Save to save the solutions details in *.CSV 

file format.  

Changing Solution Owner 

(Access Privilege: Read/Write permission) 

It may be very useful to change the owner of some of the solutions when there are changes in 

support organization. You can change the owner of a single solution or multiple solutions. 

To change owner of solutions individually 
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1. Click the Solutions tab.  

2. In the Solutions: Home page, select the solution.  

3. In the Solution: <solution Name> page, click the Edit button.  

4. In the solution: <solution Name> page, change the solution owner from the Solution 

Owner lookup field.  

5. Click Save to update the solution owner.  

To change owner of solutions in bulk 

1. Click the solutions tab.  

2. In the Solutions: Home page, go to the Solution List section and select the check boxes 

corresponding to the solutions. You can also select all the solutions.  

3. Click the Change Owner button.  

4. In the solutions: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the solutions 

permanently. 

Warning: Solutions ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise solutions belonging to different users 

will be changed to new user. To overcome this problem, first you may search the solutions 

with a required owner name then change the owner in bulk. 

Printing Solution Details 

(Access Privilege: Read permission) 

You can view a printable form and print the Solution details using Web browser's Print function. 

To print solution details 

1. Click the Solutions tab.  

2. In the Solutions: Home page, under the Solution List section, select the required 

Solution.  

3. In the Solution: <Name> page, click the Printable View link.  

4. In the Solution: <Solution Name> page, click the Print Page button to print the 

document.  

Deleting Solutions 

(Access Privilege: Read/Write/Delete permission) 
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Occasionally you may need to remove some of the unnecessary solutions from the Zoho CRM 

system for a better user experience. You may consider removing solutions that are not useful for 

future reference. 

Note: The deleted solutions are temporarily stored in Recycle Bin. If required you can 

restore the deleted again. However, if you delete solutions from Recycle Bin, you cannot restore 

again. 

To delete solutions individually 

1. Click the Solutions tab.  

2. In the Solutions: Home page, select the Solution.  

3. In the Solution: <Solution Name> page, click the Delete button.  

4. In the Confirmation dialog, click OK to remove the Solution permanently.  

To delete solutions in bulk 

1. Click the Solutions tab.  

2. In the Solutions: Home page, go to the Solution List section and select the check boxes 

corresponding to the solutions to be removed.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to remove the selected solutions permanently.  

Customizing Solutions 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the solutions module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying solutions page layout, and 

show/hide the related list views according to your Customer Support management process 

requirements. 

 

 

 

 

http://zohocrm.wiki.zoho.com/Customer-Support.html
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Working with Products 
 

Products can be either goods or services, which are sold or procured by your organization. In 

Zoho CRM, you can manage your company- wide products that are sold to the customers as well 

as procured from the vendors. Hence, both sales and purchasing departments can use the 

Products module effectively according to their department process. In case your organization 

procures products from vendors and sell to customers with a markup, both sales and purchase 

departments can coordinate in a better way. 

Sales department can use the products module along with other modules, such as leads, accounts, 

potentials, quotes, Sales Orders, and Invoices where as purchasing department can use along 

with Vendors and Purchase Orders. In general, Product details page contains the product name, 

manufacturer/reseller name, part numbers, sales start/end dates, support start/end dates, price, 

stock position and others. 

The Products home page contains, 

 Products List  

 Product Reports  

 Tools such as Import, Export, change owner, and delete  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Page Navigation  

You can perform the following operations in Products module: 

 Navigate products  

 Search products (Alphabetical or advanced search options)  

 Create List views  

 Create new products (Form filling, quick create, or duplicate options)  

 Associate products with other records  

 Changing Product Owner (individually or in bulk)  

 Export Products  

 Print products details  

 View Reports  

 Delete products (individually or in bulk)  

 Customize products  

http://zohocrm.wiki.zoho.com/Working-with-Products.html#Navigating_Products
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Searching_Products
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Creating_Products
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Associating_Products
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Changing_Product_Owner
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Exporting_Products
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Printing_Product_Details
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Deleting_Products
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html
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Navigating Products 

(Access Privilege: Read permission) 

You can navigate products available in the Products List. 

To navigate products 

1. Click the Products tab.  

2. In the Products Home page, under the Products List section, click the Start, Previous, 

Next, or End link to access the list of products.  

Searching Products 

(Access Privilege: Read permission) 

You can search the sales orders alphabetically or filling the required information in Search box. 

To search products 

1. Click the Products tab.  

2. In the Products Search section, do one of the following:  

3.  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Products List page, list of products are displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Product List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Products module: 

 All Products  

 My Products  

 Active Products  
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Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Products tab.  

2. In the Products Home page, under Product List section, click the Create View link. 

Note: Under the Product List section, some of the standard list views are 

displayed. You can only rearrange the order of columns and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Products 

(Access Privilege: Read/Write permission) 

In Zoho CRM, you can store product details by entering data in product detail form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Product: Edit form, you need to specify the product-related information. The following 

table provides descriptions of the various fields in the form. 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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List of Standard Product-related Fields 

Field Name Description Data Type 

Product Name* 
Specify the name of the product. This field 

is mandatory. 

Text box, alphanumeric 

(50) 

Product Code Specify the product identification. 
Text box, alphanumeric 

(40) 

Product Active Specify the status of the product. Check box 

Commission Rate 
Specify the commission rate for selling the 

product. 
Text box, decimal () 

Qty/Unit 
Specify the quantity rate for selling the 

product. 
Decimal 

Unit Price Specify the unit price of the product. Decimal 

Manufacturer Select the name of the product manufacturer. Pick list 

Product Category Select the category of the product. Pick list 

Purchase Date 
Select the date of purchase from the 

calendar. 
Date 

Support Start Date 
Select the date on which the product support 

starts. 
Date 

Support Expiry Date 
Select the date on which the product support 

ends. 
Date 

Description Specify any other details about product. Text area (long text) 

To create products individually 

1. Click the New Product link.  

2. In the Product: page, specify the product details. 

Note: Product Name is a mandatory field. Refer to the List of 

Standard Product-related Fields section for more details. 

3. Click Save.  

Importing Products 

(Access Privilege: Data Import permission) 

http://zohocrm.wiki.zoho.com/Working-with-Products.html#Standard_Product_fields
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Standard_Product_fields
http://zohocrm.wiki.zoho.com/Working-with-Products.html#Standard_Product_fields
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Importing product details from external source to the CRM system is one of the most important 

activities while migrating data from legacy systems to Zoho CRM. 

You can import products, if you are authorized to perform this operation. Otherwise, Import 

Products button in Products Home page will be hidden in your user interface. By default, 

product ownership is held up with the users, who import the products. You can change the 

product ownership while importing by adding a product owner column in import (CSV/XLS) 

file and map to the Assigned To field. This will automatically assign products to particular users. 

Use the exact Zoho CRM users' names while creating the product import file, otherwise product 

details are not created in Zoho CRM. 

Tips: 

 Before importing products into Zoho CRM, you must have the products details in a 

CSV/XLS file.  

 You must have privilege to import the products in Zoho CRM.  

 Before importing the products into Zoho CRM close the CSV/XLS file and the 

Spreadsheet program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 products in one import cycle.  

To import product details from external sources  

1. Click the Products tab.  

2. In the Products: Home page under Product Tools section, click the Import Products 

button.  

3. In the Import Products page, browse the Products-related data in CSV/XLS format and 

then click the Submit button.  

4. In the Fields Mapping page, map the CSV/XLS column header with product related 

fields in Zoho CRM.  

5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Products: Home page, imported products are displayed under the Products List 

section. You can continue the importation further or complete the operation.  

Associating Products with Other Records 

(Access Privilege: Read permission) 
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You can create a 360-degrees view of the product to display all the associated details, such as 

products, trouble tickets, open activities, history of the completed activities, attachments, and 

notes: 

 Price Books: To add different list prices to the product.  

 Open Activities: To add tasks and events to product.  

 Closed Activities: To display the closed tasks and events to product.  

 Cases: To add cases to the product.  

 Solutions: To add solutions to the product.  

 Attachments: To attach documents to the product.  

 Notes: To add notes to the product.  

To associate Products with other Records 

1. Click the Products tab.  

2. In the Products Home page, under the Product List section, select the required product.  

3. In the Product: <Product Name> page, do the following:  

o Edit the Product details.  

o Create activities, such as tasks and events.  

o Attach documents and notes.  

4. You can close the Product page once all the required information is updated for the 

product.  

Changing Product Owner 

(Access Privilege: Read/Write permissions) 

It may be very useful to change the owner of some of the products when there are changes in 

your organization structure. You can change the owner of a single product or multiple products. 

To change owner of products individually 

1. Click the Products tab.  

2. In the Products: Home page, select the product.  

3. In the Product: <Product Name> page, click the Edit button.  

4. In the Product: <Product Name> page, change the product owner from the Product 

Owner lookup field.  

5. Click Save to update the product owner.  

To change owner of products in bulk 
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1. Click the Products tab.  

2. In the Products: Home page, go to the Product List section and select the check boxes 

corresponding to the products. You can also select all the products.  

3. Click the Change Owner button.  

4. In the Products: Change Owner page, select the user from the Select New Owner pick 

list and click the Update Owner button to change the owner of the products 

permanently. 

Note: Products ownership will be changed to another user, irrespective of its 

existing owner. Use this operation carefully, otherwise products belonging to different 

users will be changed to new user. To overcome this problem, first you may search 

the products with a required owner name then change the owner in bulk. 

Exporting Products 

(Access Privilege: Data Export permissions) 

Occasionally, it is very useful to export the products from Zoho CRM to a spreadsheet programs 

for further data analysis. 

To export products to external sources 

1. Click the Products tab.  

2. In the Products: Home page under the Product Tools section, click the Export All 

Products button.  

3. In the File Download pop-up dialog, click Save to save the Products files in *.CSV file 

format  

Printing Product Details 

(Access Privilege: Read permission) 

You can view a printable form and print the product details using browser’s Print function. 

To print product details 

1. Click the Products tab.  

2. In the Products: Home page, go to the Products List section and select the required 

product.  

3. In the Product: < Product Name> page click the Printable View link.  
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4. In the Product: < Product Name> page, click the Print Page button to print the 

document.  

Viewing Reports 

(Access Privilege: Read permission) 

You can directly access some of the standard reports pertaining to products from the Products 

Reports section. By default, the following reports are displayed under Products module: 

 Products by Category  

 Products by Support Termination date  

 Products by Cases  

To view products report 

1. Click the Products tab.  

2. In the Products: Home page, go to the Products Reports section.  

3. Click the required report link. The report is displayed in Reports page, which can be 

further customized as per your requirements.  

For more details about reports customization, refer to Chapter 19: Working with Reports. 

Deleting Products 

(Access Privilege: Read/Write/Delete permission) 

Rarely, you may need to remove the unnecessary products, which are not tracked further. This 

will help you manage your products in a better way. You can delete products either individually 

or in bulk. 

Warning: The deleted potentials are temporarily stored in Recycle Bin. If required you can 

restore the deleted potentials again. However, if you delete potentials from Recycle Bin, you 

cannot restore again. 

To delete products individually 

1. Click the Products tab.  

2. In the Products: Home page, select the product to be deleted.  

http://www.zoho.com/crm/help/reports/working_with_reports.html
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3. In the Product: <Product Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the product permanently.  

To delete products in bulk 

1. Click the Products tab.  

2. In the Products: Home page under the Products List section, select the products to be 

deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected products permanently.  

Customizing Products 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the Products module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying Product page layout, and 

show/hide the related list views according to your Product catalog management process 

requirements. 
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Working with Price Books 
 

Price Books are used for selling products at different prices, based on the agreement terms with a 

particular type of customer. For each customer you can sell the same product at different prices. 

There are two key prices in Price Book one is Unit Price and other List Price. Unit Price is a 

fixed price of the product decided by manufacturer, which cannot be changed. List Price is the 

sellers' price. The manufacturer/resellers may sell the product with different prices to their 

resellers/customers. These variable prices for the same product are called as List Prices. The List 

Prices may vary according to the manufacturer's understanding with the reseller/customer. 

The Price Book home page contains, 

 Price Book List  

 Tools, such as Import, Export, mass transfer, and delete vendors  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Change Owner  

 Delete  

 Page Navigation  

Note: While creating a potential you can select products only from a single Price Book. 

You can perform the following operations in Price Books module: 

 Navigate Price Books  

 Search Price Books (Basic and alphabetical)  

 Create new Price Books (Form filling, duplicate, or import options)  

 Associate products with Price Books  

 Print Price Books  

 Delete Price Books (individually or in bulk)  

 Customize Price Books  

Navigating Price Books 

You can navigate Price Books available in the Price books list view. 

http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Navigating_Price_Books
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Searching_Price_Books
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Creating_Price_Books
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Associating_Price_Books
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Printing_Price_Book
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Deleting_Price_Books
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Customizing_pricebooks
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To navigate Price Books 

1. Click the Price Books tab.  

2. In the Price books Home page under the Price Books List section, click the Start, 

Previous, Next, or End link to access the list of Price Books.  

Searching Price Books 

You can search the Price Books with basic details or alphabetically. 

To search Price Books 

1. Click the Price Books tab.  

2. In the Price books Home page, under Search (Top LHS corner) section, do one of the 

following:  

o Enter the search criteria click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Price books, List page, list of Price Books are displayed as per search criteria.  

Creating Price Books 

In Zoho CRM, you can store Price Book details by entering data in Price Book form or importing 

the data from external source. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Price book: Edit form, you need to specify the Price Book-related information. The 

following table provides descriptions of the various fields in the form. 

List of Standard Price Book-related Fields 

Field Name Description Data Type 

Price book Owner 
Select the Price Book owner from the 

available users list 
Lookup 

Price book Name* 
Specify the name of the Price Book. This 

field is mandatory. 

Text box, alphanumeric 

(50) 
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Field Name Description Data Type 

Price book Owner 
Select the Price Book owner from the 

available users list 
Lookup 

Active 
Select the Active check box to set the status 

of the Price Book as active. 
Check box 

Description Specify any other details about Price Book. Text area (long text) 

To create Price Books 

1. Click the New Price Book link.  

2. In the Price book: < > page, enter the Price Book details. 

Note: Price book Name is a mandatory field. Refer to the List of Standard Price book-

related Fields section for more details.  

3. Click Save to save the Price Book details.  

To import Price Book data 

1. Click the Price Books tab.  

2. In the Price books Home page, under Price book Tools section, click the Import My Price 

Books or Import My Organization Price Books link according to your privilege.  

3. In the Specify Import File section, browse the Price Book file (XLS or CSV format) and 

click the Next.  

4. In the Map Fields section, map the XLS/CSV file headers with the Price Book related 

fields.  

5. In the Confirm Mapping section, check the mapped fields. If you are OK with the 

mapping, click the Import button.  

6. In the Import Summary page, click the Go to Price book list button. The imported data is 

displayed in the Price Books Home page.  

Associating Products with Price Books 

You can associate products with Price Books to create different list prices for the same product. 

To associate Product with Price Book 

1. Click the Price Books sub-tab.  

2. In the Price books Home page, under the Price book List section, select the required Price 

Book.  

3. In the Price book: <Price book Name> page, do the following:  

o In Product List section, click the Add Product button.  

http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Standard_Pricebook_fields
http://zohocrm.wiki.zoho.com/Working-with-Price-Books.html#Standard_Pricebook_fields
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o In Add Products to Price Book page, specify the List Price and select the products 

to be added to the Price Book.  

o Click the Add to Price Book button to add the products to the Price Book.  

Changing Price Books Owner 

You can transfer the Price Books record in between users whenever there are some organization 

changes. 

To transfer Price Books individually 

1. Click the Price Books tab.  

2. In the Price books: Home page, select the Price Book to be transferred.  

3. In the Price book: <Price book Name> page, click Change Owner.  

4. In the Confirmation dialog, click OK to change the owner of the Price Book.  

To transfer Price Books in bulk 

1. Click the Price Books tab.  

2. In the Price books: Home page, go to the Price books List section and select the Price 

Books to be transferred using the Select check box.  

3. Click the Change Owner button.  

4. In the Confirmation dialog, click OK to change the owner of the selected Price Books.  

Printing Price Book Details 

You can view a printable form and print the Price Book details using browser's Print function. 

To print Price Book details 

1. Click the Price Books tab.  

2. In the Price books: Home page, go to the Price books List section and select the required 

Price Book.  

3. In the Price book: < Price book Name> page click the Printable View link.  

4. In the Price book: < Price book Name> page, click the Print Page button to print the 

document.  

Deleting Price Books 
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Rarely, you may need to remove the unnecessary Price Books, which are not tracked further. 

This will help you manage your Price Books in a better way. You can delete Price Books either 

individually or in bulk. 

Warning: The deleted Price Books are temporarily stored in Recycle Bin. If required you 

can restore the deleted Price Books again. However, if you delete Price Books from Recycle Bin, 

you cannot restore again. 

To delete Price Books individually 

1. Click the Price Books tab.  

2. In the Price books: Home page, select the Price Book to be deleted.  

3. In the Price book: <Price book Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the Price Book.  

To delete Price Books in bulk 

1. Click the Price Books tab.  

2. In the Price books: Home page under the Price books List section, select the Price Books 

to be deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected Price Books.  

Customizing Price Books 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the Price Books module includes, renaming the tab name, modifying the pick 

list values in standard fields, adding new custom fields, modifying Price Book page layout, and 

show/hide the related list views according to your Sales management requirements. 
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Working with Quotes 
 

Sales Quotes are legally binding agreement between customer and vendor to deliver customer 

requested products in a specified timeframe at a predefined price. Your customers can place 

orders within the stipulated period (validity date) that has been specified in the quote otherwise 

you may cancel the quote or send a new quote extending the timeframe. In general Sales Quote 

contains the Quote number, date, line items (products) including the quantities and prices based 

on your Price Books, Terms & Conditions and others. In Zoho CRM, you can create a quote 

directly from the potential or from the account page. 

The Quotes home page contains, 

 Quotes List  

 Quote Reports  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Page Navigation  

You can perform the following operations in Quotes module: 

 Navigate quotes  

 Search quotes (Basic or alphabetical options)  

 Create List views  

 Create new quotes (Form filling or duplicate options)  

 Associate quotes with other records  

 Print quotes details  

 View reports  

 Delete quotes (individually or in bulk)  

 Customize Quotes  

Navigating Quotes 

You can navigate quotes available in the Quotes List. 

To navigate quotes 

1. Click the Quotes tab.  

http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Navigating_Quotes
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Searching_Quotes
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Creating_Quotes
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Associating_Quotes
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Printing_Quote_Details
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Deleting_Quotes
http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Customizing_quotes
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2. In the Quotes Home page, under the Quotes List section, click the Start, Previous, Next, 

or End link to access the list of quotes.  

Searching Quotes 

You can search the quotes with basic details, such as Subject, Quote Name, Account Name, and 

Quote Stage. You can also search quotes alphabetically. 

To search quotes 

1. Click the Quotes tab.  

2. In the Quotes Home page, under the Quote Search section, do one of the following:  

o Enter the search criteria in Quote Name, Quote Code, and Qty/Unit and Unit Price 

and click the Search button. Or  

o Select one of the alphabetical search links.  

3. In the Quotes List page, list of quotes are displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Quote List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Quotes module: 

 All Quotes  

 My Quotes  

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Quotes tab.  

2. In the Quotes Home page, under Quote List section, click the Create View link. 

Note: Under the Quote List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 
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and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Quotes 

In Zoho CRM, you can store quote details by entering data in quote detail form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Quote: Edit form, you need to specify the quote-related information. The following table 

provides descriptions of the various fields in the form. 

List of Standard Quote-related Fields 

Field Name Description Data Type 

Quote Owner 
Select the name of the user to whom the quote 

is assigned. 
Lookup 

Subject*  
Specify the name of the quote. This field is 

mandatory.  

Text box, alphanumeric 

(50)  

Quote Name  
Specify the quote name for which the quote has 

to be created.  

Text box, alphanumeric 

(40)  

Quote Stage  Specify the status of the quote.  Check box  

Valid Till  
Specify the date until the quote is valid after 

sending to the prospective customer.  
Date  

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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Field Name Description Data Type 

Quote Owner 
Select the name of the user to whom the quote 

is assigned. 
Lookup 

Team  Specify the quantity rate for selling the quote.  
Text box, alphanumeric 

(50)  

Contact Name  
Specify the contact to which the quote has to be 

created.  
Lookup  

Carrier  Select the name of the carrier manufacturer.  Pick list  

Shipping  Select the category of the quote.  
Text box, alphanumeric 

(50)  

Inventory Manager  
Specify the person responsible for shipping the 

shipment to the account or contact.  

Text box, alphanumeric 

(50)  

Account Name*  
Specify the account name to which the quote 

has to be created.  
Lookup  

Billing Address*  

Specify the billing address of the account or 

contact to which the quote has to be sent. If you 

have selected the account or contact, the 

corresponding billing address is automatically 

filled up.  

Text box, alphanumeric 

(256)  

Shipping Address*  

Specify the shipping address of the account or 

contact to which the shipment has to be sent. If 

you have already selected the account or 

contact, the corresponding shipping address is 

automatically filled up.  

Text box, alphanumeric 

(256)  

Product Details  Specify the line items of the quote.  
 

Product  Select the product name.  Lookup  

Quantity  Specify the number of units.  Numeric (Integer)  

Unit Price  Displays the unit price of the product.  Alphanumeric  

List Price  
Select the product list price from Price Book or 

specify the product price.  
Numeric  

Total  Displays the amount of the selected products.  Alphanumeric  

Terms & 

Conditions  

Specify the terms and conditions that are 

associated with quote.  
Text area (32 KB)  

Description  Specify any other details about quote.  Text area (32 KB)  

To create quotes 

1. Click the New Quote link.  
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2. In the Quote: page, specify the quote details. 

Note: Quote Name, Account Name, Billing Address, Shipping Address, and Product 

Details are mandatory field. Refer to the List of Standard Quote-related Fields section for 

more details.  

3. Click Save to save the quote details.  

Associating Quotes with Other Records 

You can create a 360-degrees view of the quote to display all the associated details, such as sales 

orders, open activities, and history of the completed activities. 

 Sales Orders: To display sales orders associated with quotes.  

 Open Activities: To add tasks and events related to quotes.  

 Closed Activities: To display the completed activities.  

To associate quotes with other records 

1. Click the Quotes tab.  

2. In the Quotes Home page, under the Quote List section, select the required quote.  

3. In the Quote: <Quote Name> page, do the following:  

o Edit the Quote details.  

o Display the sales orders associated with quote.  

o Create activities, such as tasks and events (See chapter <No>: Managing 

Activities section for more details)  

o Display the completed activities.  

4. You can close the Quote page once all the required information is updated for the quote.  

Printing Quote Details 

You can view a printable form and print the quote details using browser’s Print function. 

To print quote details 

1. Click the Quotes tab.  

2. In the Quotes: Home page under the Quotes List section, select the required quote.  

3. In the Quote: < Quote Name> page click the Printable View button.  

4. In the printable document page, click the Print Page button to print the document.  

Viewing Reports 

http://zohocrm.wiki.zoho.com/Working-with-Quotes.html#Standard_Quote_fields
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(Access Privilege: Read permission) 

You can directly access some of the standard reports pertaining to quotes from the Quotes 

Reports section. By default, the following reports are displayed under Quotes module: 

 Quotes by Accounts  

 Converted Quotes  

 Lost Quotes  

 Quotes by Stage  

 Open Quotes 

To view quotes report 

1. Click the Quotes tab.  

2. In the Quotes: Home page under the Quotes Reports section, click the required report 

link.  

3. The report is displayed in Reports page, which can be further customized as per your 

requirements.  

For more details about reports customization, refer to Chapter <>: Working with Reports. 

Deleting Quotes 

Rarely, you may need to remove the unnecessary quotes, which are not tracked further. This will 

help you manage your quotes in a better way. You can delete quotes either individually or in 

bulk. 

Warning: The deleted quotes are temporarily stored in Recycle Bin. If required you can 

restore the deleted quotes again. However, if you delete quotes from Recycle Bin, you cannot 

restore again. 

To delete quotes individually 

1. Click the Quotes tab.  

2. In the Quotes: Home page, select the quote to be deleted.  

3. In the Quote: <Quote Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the quote permanently.  

To delete quotes in bulk 

http://www.zoho.com/crm/help/reports/working_with_reports.html
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1. Click the Quotes tab.  

2. In the Quotes: Home page, go to the Quotes List section and select the quotes to be 

deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected quotes permanently.  

Customizing Quotes 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the Quotes module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying Quotes page layout, and 

show/hide the related list views according to your Sales process requirements. 
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Working with Purchase Orders 
 

Purchase Order is an order placed for procuring products or services from your short listed 

vendors. In general PO contains the PO number, date, line items (products) including the 

quantities and prices based on Sales Quote, Billing address, Shipping address, Terms & 

Conditions and others. You can use the PO for communicating your product and pricing 

requirements to vendors so that there will not be any obligations in future. In addition, you can 

use the PO to crosscheck the products shipped to your shipping address and invoices sent to your 

billing address. In addition, your vendor can use PO as legal document in the event of 

nonpayment in a court of law for claiming damages from your side. To summarize, PO is a legal 

binding document that protects interests of both vendor and buyers, which can be used as legal 

binding document for both parties. 

In PO module, you can create PO for the products to be procured, associate POs to the vendors, 

track the status of the POs, create printer friendly format. 

The Purchase Order home page contains, 

 POs List  

 PO Reports  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Page Navigation  

You can perform the following operations in Purchase Orders module: 

 Navigate purchase orders  

 Search purchase orders (Alphabetical or advanced search options)  

 Create new purchase orders (Form filling or duplicate options)  

 Associate purchase orders with other records  

 Print purchase orders details  

 View reports  

 Delete purchase orders (individually or in bulk)  

 Customize Purchase Orders  

Navigating Purchase Orders 

(Access Privilege: Read permission) 

http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Navigating_Purchase_Orders
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Searching_Purchase_Orders
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Creating_Purchase_Orders
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Associating_Purchase_Orders
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Printing_Purchase_Order
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Viewing_PO_Reports
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Deleting_Purchase_Orders
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Customizing_POs


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

133 ©2007, AdventNet Inc. All rights reserved.  

 

You can navigate purchase orders available in the Purchase Orders List. 

To navigate purchase orders 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders Home page under the Purchase Orders List section, click the 

Start, Previous, Next, or End link to access the list of purchase orders.  

Searching Purchase Orders 

(Access Privilege: Read permission) 

You can search the purchase orders alphabetically or filling the required information in Search 

box. 

To search purchase orders 

1. Click the Purchase Orders tab.  

2. In the Purchase Order Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Purchase Orders List page, list of purchase orders are displayed as per search 

criteria.  

Creating Purchase Orders 

(Access Privilege: Read/Write permission) 

In Zoho CRM, you can store purchase order details by entering data into the purchase order 

form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Purchase Order: Edit form, you need to specify the purchase order-related information. 

The following table provides descriptions of the various fields in the form. 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

134 ©2007, AdventNet Inc. All rights reserved.  

 

List of Standard Purchase Order-related Fields 

Field Name Description Data Type 

Subject* 
Specify the name of the purchase order. This 

field is mandatory. 

Text box, alphanumeric 

(50) 

Sales Order Select the reference Sales order. Select option 

Customer No 
Specify the customer identification number 

(if any) 

Text box, alphanumeric 

(50) 

Purchase Order Date 
Specify the date on which purchase order is 

created. 
Date 

Due Date Select the due date. Date 

Sales Commission 
Specify the commission to the sales person 

upon closing the deal. 
Numeric (float) 

Account Name * 
Specify the account name to which the 

purchase order has to be created. 
Select option 

Status Specify the status of the purchase order. Check box 

Account Name * 
Specify the account name to which the 

purchase order has to be created. 
Select option 

Assigned To* 
Select the Zoho CRM user name to whom 

the purchase order handling duty is assigned. 
Select option 

Billing Address * 

Specify the billing address of the account or 

contact to which the purchase order has to 

be sent. If you have selected the account or 

contact the billing address is automatically 

filled up. 

Text box, alphanumeric 

(256) 

Shipping Address * 

Specify the shipping address of the account 

or contact to which the shipment has to be 

sent. If you have already selected the 

account or contact, the shipping address is 

automatically filled up. 

Text box, alphanumeric 

(256) 

Product Details Specify the line items of the purchase order. 
 

Product Select the product name. Select option 

Quantity Specify the number of units. Numeric (Integer) 

Unit Price Displays the unit price of the product. 
 

List Price 
Select the product list price from Price Book 

or specify the product price 

Lookup and Numeric 

(Integer) 

Total 
Displays the amount of the selected 

products.  

Terms & Conditions Specify the terms and conditions that are Text area (long text) 
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Field Name Description Data Type 

associated with purchase order. 

Description 
Specify any other details about purchase 

order. 
Text area (long text) 

To create purchase orders 

1. Click the New Purchase Order link.  

2. In the Purchase Order: page, specify the purchase order details. 

Note: Subject, Account Name, Billing Address, Shipping 

Address, and Product Details are mandatory field. Refer to the List 

of Standard Purchase Order-related Fields section for more details. 

3. Click Save.  

Associating Purchase Orders with Other Records 

(Access Privilege: Read/Write permission) 

You can associate the purchase order with other records such as, activities, attachments, and 

notes. 

 Activities: To add tasks related to purchase orders.  

 Attachments: To attach files to purchase orders.  

 Notes: To add notes to purchase orders.  

To associate Purchase Orders with other Records 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders Home page, under the Purchase Order List section, select the 

required purchase order.  

3. In the Purchase Order: <Purchase Order Name> page, do the following:  

o Edit the Purchase Order details.  

o Create tasks.  

o Add files and notes.  

4. You can close the purchase order page once all the required information is updated for 

the purchase order.  

http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Standard_PO_fields
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Standard_PO_fields
http://zohocrm.wiki.zoho.com/Working-with-Purchase-Orders.html#Standard_PO_fields


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

136 ©2007, AdventNet Inc. All rights reserved.  

 

Printing Purchase Order Details 

(Access Privilege: Read permission) 

You can view a printable form and print the purchase order details using browser’s Print 

function. 

To print purchase order details 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders: Home page under the Purchase Orders List section, select the 

required purchase order.  

3. In the Purchase Order: <Purchase Order Name> page click the Printable View button.  

4. In the Purchase Order: <Purchase Order Name> page, click the Print Page button to 

print the document.  

Viewing Reports 

(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to purchase orders from the 

Purchase Orders Reports section. By default, the following reports are displayed under Purchase 

Orders module: 

 Vendors Vs Purchases  

 Contacts Vs Purchases  

 Purchase Orders by Status 

To view purchase order report 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders: Home page under the Purchase Orders Reports section, click 

the required report link.  

3. The report is displayed in Reports page, which can be further customized as per your 

requirements.  

For more details about reports customization, refer to Chapter 19: Working with Reports. 

 

http://www.zoho.com/crm/help/reports/working_with_reports.html


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

137 ©2007, AdventNet Inc. All rights reserved.  

 

Deleting Purchase Orders 

(Access Privilege: Read/Write/Delete permission) 

Rarely, you may need to remove the unnecessary purchase orders, which are not tracked further. 

This will help you manage your purchase orders in a better way. You can delete purchase orders 

either individually or in bulk. 

Warning: The deleted purchase orders are temporarily stored in Recycle Bin. If required 

you can restore the deleted purchase orders again. However, if you delete purchase orders from 

Recycle Bin, you cannot restore again. 

To delete purchase orders individually 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders: Home page, select the purchase order to be deleted.  

3. In the Purchase Order: <Purchase Order Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the purchase order permanently.  

To delete purchase orders in bulk 

1. Click the Purchase Orders tab.  

2. In the Purchase Orders: Home page under the Purchase Orders List section, select the 

purchase orders to be deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected purchase orders permanently.  

Customizing Purchase Orders 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the Purchase Orders module includes, renaming the tab name, modifying the 

pick list values in standard fields, adding new custom fields, modifying PO page layout, and 

show/hide the related list views according to your Purchase management process requirements. 

 

 

 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

138 ©2007, AdventNet Inc. All rights reserved.  

 

Working with Sales Orders 
 

Sales Order (SO) can be created once the quote is accepted by your prospective customer 

(potential) and sends the Purchase Order (PO) for further processing. After receiving the PO, 

some of the customers may request SOs to know the exact date of delivery of the goods/services. 

In addition, the inventory/production department looks at the list of SOS to see what needs to be 

shipped out (and when). After the order is shipped and delivered to the customer an invoice is 

generated from the sales order for billing purposes. Precisely Sales Order is a confirmation 

document sent to the customers before delivering the goods/services. In general SO contains the 

SO number, date, line items (products) including the quantities and prices based on PO, Billing 

address, Shipping address, Terms & Conditions and others. 

The Sales Order home page contains, 

 SOS List  

 SO Reports  

 Tools, such as mass transfer and delete vendors  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Page Navigation  

You can perform the following operations in Sales Orders module: 

 Navigate Sales Orders  

 Search Sales Orders (Alphabetical or advanced search options)  

 Create new Sales Orders (Form filling or duplicate options)  

 Associate Sales Orders with other records  

 Print Sales Orders details  

 View reports  

 Delete Sales Orders (individually or in bulk)  

 Customize Sales Orders  

Navigating Sales Orders 

(Access Privilege: Read/Write permission) 

You can navigate sales orders available in the Sales Orders List. 

http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Navigating_Sales_Orders
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Searching_Sales_Orders
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Creating_Sales_Orders
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Associating_Sales_Orders
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Printing_Sales_Order
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Deleting_Sales_Orders
http://zohocrm.wiki.zoho.com/Working-with-Sales-Orders.html#Customizing_SOs
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To navigate sales orders 

1. Click the Sales Orders tab.  

2. In the Sales Orders Home page under the Sales Orders List section, click the Start, 

Previous, Next, or End link to access the list of sales orders.  

Searching Sales Orders 

(Access Privilege: Read permission) 

You can search the sales orders alphabetically or filling the required information in Search box. 

To search sales orders 

1. Click the Sales Orders tab.  

2. In the Sales Order Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Sales Orders List page, list of sales orders are displayed as per search criteria.  

Creating Sales Orders 

(Access Privilege: Read/Write permission) 

In Zoho CRM, you can store sales order details by entering data in sales order detail form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Sales Order: Edit form, you need to specify the sales order-related information. The 

following table provides description of the various fields in the form. 

List of Standard Sales Order-related Fields 

Field Name Description Data Type 

Subject* 
Specify the name of the sales order. This 

field is mandatory. 

Text box, alphanumeric 

(50) 
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Field Name Description Data Type 

Potential Name 
Select the potential for which the sales order 

has to be generated. 
Select option 

Customer No 
Specify the customer identification number 

(if any) 

Text box, alphanumeric 

(50) 

Purchase Order Select the reference purchase order. Select option 

Quote Name Select the reference quote. Select option 

Contact Name 
Select the contact for which the sales order 

has to be generated. 
Select option 

Due Date Select the date Date 

Carrier 

Select the carrier’s name that ships the 

products from your warehouse to customer 

site. 

Pick list 

Pending 
 

Text box, alphanumeric 

(50) 

Status Specify the status of the sales order. Check box 

Sales Commission 
Specify the commission to the sales person 

upon closing the deal. 
Numeric (float) 

Excise Duty Specify the excise duty for the shipment Text box, numeric 

Account Name* 
Specify the account name to which the sales 

order has to be created. 
Select option 

Assigned To 
Select the Zoho CRM user name to whom 

the sales order handling duty is assigned. 
Select option 

Billing Address * 

Specify the billing address of the account or 

contact to which the sales order has to be 

sent. If you have selected the account or 

contact the billing address is automatically 

filled up. 

Text box, alphanumeric 

(256) 

Shipping Address * 

Specify the shipping address of the account 

or contact to which the shipment has to be 

sent. If you have already selected the 

account or contact, the shipping address is 

automatically filled up. 

Text box, alphanumeric 

(256) 

Product Details Specify the line items of the sales order. 
 

Product * Select the product name. Select option 

Quantity in Stock Displays the stock quantity.. Numeric (Integer) 

Quantity* 
Specify the quantity for which the sales 

order has to be generated 
Numeric (Integer) 

Unit Price Displays the unit price of the product. Currency 
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Field Name Description Data Type 

List Price* 
Select the product list price from Price Book 

or specify the product price. 

Lookup and Numeric 

(Integer) 

Tax Specify the tax component of the products Currency 

Adjustments 
Specify if there are any adjustments, such as 

discounts, or extra charges etc. 
Currency 

Total 
Displays the amount of the selected line 

item. 
Currency 

Terms & Conditions 
Specify the terms and conditions that are 

associated with sales order. 
Text area (long text) 

Description Specify any other details about sales order. Text area (long text) 

To create sales orders 

1. Click the New Sales Order link.  

2. In the Sales Order: page, specify the sales order details. 

Note: Subject, Account Name, Billing Address, Shipping 

Address, and Product Details are mandatory fields. Refer to the List 

of Standard Sales Order-related Fields section for more details. 

3. Click Save.  

Associating Sales Orders with Other Records 

(Access Privilege: Read/Write permission) 

You can associate the sales order with other records such as, activities, attachments and notes. 

 Invoices: To create invoices from the sales order.  

 Open Activities: To add tasks related to sales order.  

 Closed Activities: To display the closed activities.  

 Attachments: To add files and notes to sales order.  

To associate Sales Orders with other Records 

1. Click the Sales Orders tab.  

2. In the Sales Orders Home page, under the Sales Order List section, select the required 

sales order.  

http://www.zoho.com/crm/help/products/working_with_products.html#Standard_Product_fields
http://www.zoho.com/crm/help/products/working_with_products.html#Standard_Product_fields
http://www.zoho.com/crm/help/products/working_with_products.html#Standard_Product_fields
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3. In the Sales Order: <Sales Order Name> page, do the following:  

o Edit the Sales Order details.  

o Create invoices.  

o Create tasks.  

o Attach files.  

4. You can close the sales order page once all the required information is updated for the 

sales order.  

Printing Sales Order Details 

(Access Privilege: Read permission) 

You can view a printable form and print the sales order details using browser’s Print function. 

To print sales order details 

1. Click the Sales Orders tab.  

2. In the Sales Orders: Home page under the Sales Orders List section, select the required 

sales order.  

3. In the Sales Order: < Sales Order Name> page click the Printable View button.  

4. In the Sales Order: < Sales Order Name> page, click the Print Page button to print the 

document.  

Viewing Reports 

(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to sales orders from the Sales 

Orders Reports section. By default, the following reports are displayed under Sales Orders 

module: 

 Sales Orders by Accounts  

 Sales Orders by Status 

To view sales order report 

1. Click the Sales Orders tab.  

2. In the Sales Orders: Home page under the Sales Orders Reports section, click the 

required report link.  
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3. The report is displayed in Reports page, which can be further customized as per your 

requirements.  

For more details about reports customization refer to Chapter 19: Working with Reports. 

Deleting Sales Orders 

(Access Privilege: Read/Write/Delete permission) 

Rarely, you may need to remove the unnecessary sales orders, which are not tracked further. This 

will help you manage your sales orders in a better way. You can delete sales orders either 

individually or in bulk. 

Warning: The deleted sales orders are temporarily stored in Recycle Bin. If required you 

can restore the deleted sales orders again. However, if you delete sales orders from Recycle Bin, 

you cannot restore again. 

To delete sales orders individually 

1. Click the Sales Orders tab.  

2. In the Sales Orders: Home page, select the sales order to be deleted.  

3. In the Sales Order: <Sales Order Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the sales order permanently.  

To delete sales orders in bulk 

1. Click the Sales Orders tab.  

2. In the Sales Orders: Home page under the Sales Orders List section, select the sales 

orders to be deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected sales orders permanently.  

Customizing Sales Orders 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the SO module includes, renaming the tab name, modifying the pick list values 

in standard fields, adding new custom fields, modifying SO page layout, and show/hide the 

related list views according to your Sales management process requirements. 

http://www.zoho.com/crm/help/reports/working_with_reports.html
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Working with Invoices 
 

Once the sales stage reaches to final stage, you may start working on payment procedure. In this 

regard, Invoice plays a vital role, which is very important for both Sales and Accounting 
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purposes. Invoice is a bill issued by the vendor to the customers along with the goods/services 

shipment. It usually contains reference number of Purchase Order, Date, Billing Address, 

Shipping Address, Terms of Payment, Line Items (products/services) with quantities and prices, 

and others. In a typical organization, invoicing completes the sales process and begins the 

accounting process where account receivable is managed by Accounts/Finance teams. 

In Zoho CRM, you can create invoices directly from the Potentials, Accounts, Quotes, or Sales 

Orders. 

Invoices module contains the following components: 

 Invoices List View  

 Page Navigation  

 Quick Create Invoices  

 Invoice Reports  

 Alphabetical Search  

 Custom Views  

You can perform the following operations in Invoices module: 

 Navigate invoices  

 Search invoices (Alphabetical or Advanced search options)  

 Create invoices (Form filling or duplicate options)  

 Associate invoices with other records  

 Print invoice details  

 View reports  

 Delete invoices (individually or in bulk)  

 Customize invoices  

Navigating Invoices 

(Access Privilege: Read permission) 

You can navigate invoices available in the Invoices List. 

To navigate invoices 

1. Click the Invoices tab.  

2. In the Invoices Home page, under the Invoices List section, click the Start, Previous, 

Next, or End link to access the list of invoices.  

http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Navigating_Invoices
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Searching_Invoices
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Creating_Invoices
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Associating_Invoices
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Printing_Invoice
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Deleting_Invoices
http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Customizing_Invoices
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Searching Invoices 

(Access Privilege: Read permission) 

You can search the Invoices alphabetically or filling the required information in Search box. 

To search invoices 

1. Click the Invoices tab.  

2. In the Invoices Home page, under the Invoice Search section, do one of the following:  

o Specify the search criteria in Search box and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Invoices List page, list of invoices are displayed as per search criteria.  

Creating Invoices 

(Access Privilege: Read/Write permission) 

In Zoho CRM, you can create invoices by entering data into invoice detail form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Invoice: Edit form, you need to specify the invoice-related information. The following 

table provides descriptions of the various fields in the form. 

List of Standard Invoice-related Fields 

Field Name Description Data Type 

Subject* 
Specify the name of the invoice. This field is 

mandatory. 

Text box, alphanumeric 

(50) 

Sales Order Select the reference Sales order (if any). Lookup 

Customer No 
Specify the customer identification number (if 

any). 

Text box, alphanumeric 

(50) 

Invoice Date Specify the date on which the invoice is created. Date 

Due Date Specify the potential name for which the invoice Text box, alphanumeric 
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Field Name Description Data Type 

has to be created. (40) 

Sales 

Commission 

Specify the commission to the sales person upon 

closing the deal. 
Numeric (float) 

Account Name * 
Specify the account name to which the invoice 

has to be created. 
Lookup 

Status Specify the status of the invoice. Check box 

Account Name * 
Specify the account name to which the invoice 

has to be created. 
Lookup 

Assigned To* 
Select the Zoho CRM user name to whom the 

invoice handling duty is assigned. 
Lookup 

Billing Address * 

Specify the billing address of the account or 

contact to which the invoice has to be sent. If you 

have selected the account or contact the billing 

address is automatically filled up. 

Text box, alphanumeric 

(256) 

Shipping Address 

* 

Specify the shipping address of the account or 

contact to which the shipment has to be sent. If 

you have already selected the account or contact, 

the shipping address is automatically filled up. 

Text box, alphanumeric 

(256) 

Product Details Specify the line items of the invoice. 
 

Product* Select the product name. Lookup 

Quantity Specify the number of units. Numeric (Integer) 

Unit Price Displays the unit price of the product. Currency 

List Price* 
Select the product list price from Price Book or 

specify the product price 

Lookup and Numeric 

(Integer) 

Total Displays the amount of the selected products. Currency 

Terms & 

Conditions 

Specify the terms and conditions that are 

associated with invoice. 
Text area (32 KB) 

Description Specify any other details about invoice. Text area (32 KB) 

To create invoices 

1. Click the New Invoice link. Note: The New Invoice link is present under  

2. In the Invoice: page, specify the invoice details. 

Note: Subject, Account Name, Billing Address, Shipping Address, and Line 

Items are mandatory fields. Refer to the List of Standard Invoice-related Fields 

section for more details. 

http://zohocrm.wiki.zoho.com/Working-with-Invoices.html#Standard_Invoice_fields
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3. Click Save. An invoice will be created with a permanent Invoice ID, which can be used 

future reference.  

Associating Invoices with Other Records 

(Access Privilege: Read/Write permission) 

You can associate invoice with the other records such as, activities, attachments and notes. 

 Activities: To add tasks related to invoices.  

 Attachments & Notes: To add the files and notes to invoices.  

To associate Invoices with other Records 

1. Click the Invoices tab.  

2. In the Invoices Home page, under the Invoice List section, select the required invoice.  

3. In the Invoice: <Invoice Name> page, do the following:  

o Edit the Invoice details.  

o Create tasks.  

o Add files and notes.  

4. You can close the invoice page once all the required information is updated for the 

invoice.  

Printing Invoice Details 

(Access Privilege: Read permission) 

You can view a printable form and print the invoice details using browser's Print function. 

To print invoice details 

1. Click the Invoices tab.  

2. In the Invoices: Home page under the Invoices List section, select the required invoice.  

3. In the Invoice: <Invoice Name> page click the Print Preview button.  

4. In the Invoice: <Invoice Name> page, click the Print Page button. You can print the 

document using the Web browser print function.  

5. Save the invoice file (PDF) locally and send to your customer separately.  

Viewing Reports 
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(Access Privilege: Read/Write permission) 

You can directly access some of the standard reports pertaining to Invoices from the Invoice 

Reports section. In addition to reports, you can access one of the dashboards in Invoices module. 

By default, the following reports are displayed under Invoices module: 

 Invoices by Accounts  

 Invoices by Status  

To view Invoice report  

1. Click the Invoices tab.  

2. In the Invoices: Home page under the Invoices Reports section, click the required Report 

link.  

3. The Report is displayed in Reports page, which can be further customized as per your 

requirements.  

For more details about reports customization, refer to Chapter 19: Working with Reports. 

Deleting Invoices 

(Access Privilege: Read/Write/Delete permission) 

Rarely, you may need to remove the unnecessary invoices, which are not tracked further. This 

will help you manage your invoices in a better way. You can delete invoices either individually 

or in bulk. 

Warning: The deleted invoices are temporarily stored in Recycle Bin. If required you can 

restore the deleted invoices again. However, if you delete invoices from Recycle Bin, you cannot 

restore again. 

To delete invoices individually 

1. Click the Invoices tab.  

2. In the Invoices: Home page, select the invoice to be deleted.  

3. In the Invoice: <Invoice Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the invoice permanently.  

To delete invoices in bulk 

http://www.zoho.com/crm/help/reports/working_with_reports.html
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1. Click the Invoices tab.  

2. In the Invoices: Home page, go to the Invoices List section and select the invoices to be 

deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected invoices permanently.  

Customizing Invoices 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the invoices module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying invoices page layout, and 

show/hide the related list views according to your Accounting management process 

requirements. 

 

 

 

 

 

 

 

 

 

 

Working with Vendors 
 

Vendors include companies, people, and contractors from which your company procures 

products and services. They can be either direct manufacturers or resellers. In Zoho CRM typical 

vendor selection process involves the following steps: 
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 Evaluate your business needs and create requirements document (RFI/RFP).  

 Collect information about vendors from Trade Magazines, Yellow Pages, 

Advertisements, referrals, and other channels.  

 Send RFI (request for information) to vendors and scrutinize the primary list of vendors 

based on their response to your RFI.  

 Send RFP (request for proposals) to selected list of vendors.  

 Evaluate vendors based on the response to your RFP and conduct vendor interviews and 

short-list the vendors.  

 Gather required information, such as product details, communication channel, product 

delivery process and others from the short listed vendors.  

 In Zoho CRM - Vendors module, create vendor information, such as business address of 

the vendor, contact information of the persons you are dealing with, products supplied /to 

be supplied, purchase orders for the shipments, activities related to vendors and others. In 

addition, you can also attach the important documents related to each vendor.  

 Periodically update the vendors' details and products purchased so that you can have a 

better visibility on your vendors/suppliers for the future procurement.  

The Vendor home page contains, 

 Vendors List  

 Vendor Reports  

 Tools, such as Import, Export, mass transfer, and delete vendors  

 Quick Create pane  

 Search  

 Alphabetical Search  

 Custom Views  

 Change Owner  

 Delete  

 Page Navigation  

You can perform the following operations in the Vendors module: 

 Navigate vendors  

 Search vendors (Alphabetical search options)  

 Create List views  

 Create vendors (Form filling, quick create, or duplicate options)  

 Import vendors  

 Associate vendors with other records  

 Change vendor ownership (individually or in bulk)  

 Export vendors  

 View reports  

 Print vendors details  

http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Navigate_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Search_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Creating_Custom_List_Views
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Create_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Importing_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Associate_Vendor_with_Other_Records
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Change_Vendor_Owner
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Exporting_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Viewing_Reports
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Print_Vendor_Details
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 Delete vendors (individually or in bulk)  

 Customize Vendors 

Navigating Vendors 

(Access Privilege: Read permissions) 

You can navigate vendors available in the Vendors List. 

To navigate vendors 

1. Click Vendors tab.  

2. In the Vendors Home page, under the Vendors List section, click the Start, Previous, 

Next, or End link to access the list of vendors.  

Searching Vendors 

(Access Privilege: Read permissions) 

You can search the vendors alphabetically or filling the required information in Search box. 

To search vendors 

1. Click the Vendors tab.  

2. In the Vendors Home page, under the Vendor Search section, do one of the following:  

o Specify the search criteria in the Search field and click the Go button. Or  

o Select one of the alphabetical search links.  

3. In the Vendors List page, list of vendors are displayed as per search criteria.  

Creating List Views 

(Access Privilege: Read/Write permission) 

In the Vendor List you can create/modify/delete the custom views, sort columns in the list view 

(ascending/descending order), search the records available in the current list view. In addition, 

you can modify some of the columns in standard list views. By default, the following standard 

list views are available in the Vendors module: 

 All Vendors  

 My Vendors  

http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Delete_Vendors
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Customizing_vendors


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

153 ©2007, AdventNet Inc. All rights reserved.  

 

Note: User created list views are displayed under User Created Views category in View 

drop-down list. 

To create custom views 

1. Click the Vendors tab.  

2. In the Vendors Home page, under Vendor List section, click the Create View link. 

Note: Under the Vendor List section, some of the standard list 

views are displayed. You can only rearrange the order of columns 

and more columns. 

3. In the Create New View page, do the following:  

o In the View Information section, specify name of the custom view in the View 

Name (mandatory) field. The custom view name appears in the View drop-down 

list. You can also set the custom view as a default list view by selecting the Set as 

Default View check box. 

o In the Specify Criteria section, specify the filter criteria. For more details, refer to 

the Specifying List View Criteria section.  

o In the Choose Columns section, select the columns to be displayed in the List 

View. For more details, refer to the Selecting List View Columns section.  

o In the Accessibility Details section, select the users to whom custom list view has 

to be enabled. For more details, refer to the Enabling View Access section.  

4. Click Save. The custom list view is displayed in the View drop-down list.  

Creating Vendors 

(Access Privilege: Read/Write permissions) 

In Zoho CRM, you can store vendor details by entering data in vendor detail form. 

Note: Some of the standard fields listed below may not be visible/editable depending on 

your organization business process and field-level security settings. In case your organization 

added/modified fields, please contact your System Administrator for more details about usage of 

the other fields. 

In the Vendor: Edit form, you need to specify the vendor-related information. The following 

table provides descriptions of the various fields in the form. 

http://www.zoho.com/crm/help/list_views/managing_list_views.html#Specifying_Criteria
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Selecting_Columns
http://www.zoho.com/crm/help/list_views/managing_list_views.html#Enabling_Access
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List of Standard Vendor-related Fields 

Field Name Description Data Type 

Vendor Name* 
Specify the name of the vendor. This field is 

mandatory 

Text box, alphanumeric 

(50) 

Phone Specify the phone number of the vendor 
Text box, alphanumeric 

(40) 

E-mail Specify the E-mail ID of the vendor Check box 

Website Specify the Web site URL of the vendor Text box, decimal () 

GL Account Select the general ledger account Pick List 

Category Specify the category of the vendor 
Text box, alphanumeric 

(40) 

Vendor Address  

 Street  

 City  

 State  

 Postal Code  

 Country  

Specify the address of the vendor 
 

Description Specify any other details about vendor Text area (long text) 

To create vendors 

1. Click the New Vendor link.  

2. In the Vendor: page, specify the vendor details. 

Note: Vendor Name is a mandatory field. Refer to the List of Standard Vendor-related 

Fields section for more details.  

3. Click Save to save the vendor details.  

To create vendors instantly 

1. Click the Vendors tab.  

2. In left hand-side under the Quick Create section, enter the mandatory details (Vendor 

Name).  

3. Click Save. Vendor details are displayed in Vendors Home page, where you can update 

the additional details.  

To create duplicate records of vendors 

http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Standard_Vendor_fields
http://zohocrm.wiki.zoho.com/Working-with-Vendors.html#Standard_Vendor_fields
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1. Click the Vendors tab.  

2. In the Vendor List view page, select the vendor to be duplicated.  

3. In the Vendor: <Vendor Name> page, click the Clone button.  

4. In the Edit: <Vendor Name> page, modify some of the vendor details.  

5. Click Save. Vendor details are displayed in the Vendor: <Vendor Name> page where 

you can perform the additional operations.  

Importing Vendors 

(Access Privilege: Data Import permissions) 

You can import vendor information from other legacy applications, such as spreadsheets, 

documents, and others to the Zoho CRM system. You can import the vendor information if you 

are authorized to perform this operation. Otherwise, Import Vendors button in Vendors Home 

page will be hidden in your user interface. By default, vendor ownership is held up with the user, 

who imports the vendors. You can change the vendor ownership while importing by adding a 

vendor owner column in import (CSV/XLS) file and map to the Assigned To field. This will 

automatically assign vendors to selected users. Use the exact Zoho CRM users' names while 

creating the vendor import file, otherwise vendors are not created in Zoho CRM. 

Tips: 

 Before importing vendors into Zoho CRM, you must have the vendor’s details in a 

CSV/XLS file.  

 You must have privilege to import the vendors in Zoho CRM.  

 Before importing, the vendors into Zoho CRM close the CSV/XLS file and the 

Spreadsheet program.  

 Remove apostrophe any place in the CSV file (For example, ABC's).  

 You can import a maximum of 1000 vendors in one import cycle.  

To import vendors from external sources  

1. Click the Vendors tab.  

2. In the Vendors: Home page under Vendor Tools section, click the Import My Vendors 

button.  

3. In the Import My Vendors Wizard page, browse the Vendors-related data (CSV/XLS 

format) and then click the Next button.  

4. In the Fields Mapping page, map the CSV/XLS column header with vendor fields in 

Zoho CRM.  
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5. Click the Import button. It will take a few seconds to complete the importation.  

6. In the Vendors: Home page, imported vendors are displayed under the Vendors List 

section. You can continue the importation further or complete the operation.  

Associating Vendors with Other Records 

(Access Privilege: Read/Write permissions) 

You can create a 360-degrees view of the vendor to display all the associated details, such as 

products, activities, contacts, and purchase orders. 

 Products: To add products that are purchased from vendor  

 Purchase Orders: To create purchase orders for procuring products from the vendors  

 Open Activities: To add new tasks and events.  

 Closed Activities: To track closed tasks and events.  

 Attachments: To add files to the vendor record.  

 Contacts: To add contacts related to vendors.  

To associate Vendors with other Records 

1. Click the Vendors tab.  

2. In the Vendors Home page, under the Vendor List section, select the required vendor.  

3. In the Vendor: <Vendor Name> page, do the following:  

o Edit the Vendor details.  

o Create Products (See chapter <No>: Managing Activities section for more details)  

o Create Purchase Orders (See chapter <No>: Creating Emails and Creating Notes 

sections for more details)  

o Create Contacts: (See chapter <No>: Attaching Documents section for more 

details)  

4. You can close the Vendor page once all the required information is updated for the 

vendor.  

 

Changing Vendor Owner 

You can change the owner of an individual vendor or a group of vendors. 

To change owner of vendors individually 
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1. Click the Vendors tab.  

2. In the Vendors: Home page, select the vendor.  

3. In the Vendor: <Vendor Name> page, change the vendor owner from the Vendor 

Owner lookup field.  

4. Click Save to update the vendor owner.  

To change owner of vendors in bulk 

1. Click the Vendors tab.  

2. In the Vendors: Home page, go to the Vendor List section and select the check boxes 

corresponding to the vendors. You can also select all the vendors.  

3. Click the Change Owner button.  

4. In the Vendors: Change Owner page, select the user from the Assigned To pick list and 

click the Save button to change the owner of the vendors permanently. 

 

Note: Vendors ownership will be changed to another user, irrespective of its existing 

owner. Use this operation carefully, otherwise vendors belonging to different users will 

be changed to new user. To overcome this problem, first you may search the vendors 

with a required owner name then change the owner in bulk.  

Exporting Vendors 

Occasionally it is very useful to export the vendor details from Zoho CRM to Spreadsheet 

programs, such as Microsoft Excel, OpenOffice, and others for further data analysis. 

To export vendors to external sources 

1. Click the Vendors tab.  

2. In the Vendors: Home page under the Vendor Tools section, click the Export All 

Vendors button.  

3. In the File Download pop-up dialog, Click Save to save the vendor details in *.CSV file 

format.  

 

Viewing Reports 

(Access Privilege: Read/Write permission) 
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You can directly access some of the standard reports pertaining to Vendors from the Vendor 

Reports section. In addition to reports, you can access one of the dashboards in Vendors module. 

By default, the following reports are displayed under Vendors module: 

 Vendors Vs Purchases  

 Vendors Vs Products  

To view vendor reports  

1. Click the Vendors tab.  

2. In the Vendors: Home page under the Vendors Reports section, click the required Report 

link.  

3. The Report is displayed in Reports page, which can be further customized as per your 

requirements.  

For more details about reports customization, refer to Chapter 19: Working with Reports. 

Printing Vendor Details 

(Access Privilege: Read permission) 

You can view a printable form and print the vendor details using browser's Print function. 

To print vendor details 

1. Click the Vendors tab.  

2. In the Vendors: Home page under the Vendors List section, select the required vendor.  

3. In the Vendor: < Vendor Name> page click the Printable View link.  

4. In the Vendor: < Vendor Name> page, click the Print button to print the document.  

Deleting Vendors 

(Access Privilege: Read/Write/Delete permissions) 

Rarely, you may need to remove the unnecessary vendors, which are not tracked further. This 

will help you manage your vendors in a better way. You can delete vendors either individually or 

in bulk. 

http://www.zoho.com/crm/help/reports/working_with_reports.html
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Warning: The deleted vendors are temporarily stored in Recycle Bin. If required you can 

restore the deleted vendors again. However, if you delete vendor from Recycle Bin, you cannot 

restore again. 

To delete vendors individually 

1. Click the Vendors tab.  

2. In the Vendors: Home page, select the vendor to be deleted.  

3. In the Vendor: <Vendor Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the vendor permanently.  

To delete vendors in bulk 

1. Click the Vendors tab.  

2. In the Vendors: Home page, go to the Vendors List section and select the vendors to be 

deleted using the Select check box.  

3. Click the Delete button.  

4. In the Confirmation dialog, click OK to delete the selected vendors permanently.  

Customizing Vendors 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the vendors module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, modifying vendors page layout, and 

show/hide the related list views according to your Purchase management process requirements. 

 

 

 

 

 

Activities 
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Activities play an important role in daily business operations. Activities can be either time bound 

calendar events, such as meetings, seminars, appointments, etc or status bound tasks, such as 

send status report to manager, send e-mail to customer, etc. In Zoho CRM, most of the records 

have activities as a related list for a better 360 degrees view. You can associate activities with 

modules, such as leads, accounts, contacts, potentials, campaigns, etc. 

You can perform the following operations in Activities module: 

 Navigate activities  

 Search activities  

 Manage tasks  

 Manage events  

 Delete activities  

 Customize activities  

Navigating Activities 

You can navigate activities from the Activity List. 

To navigate activities 

1. Click the Activities tab.  

2. In the Activities Home page, under the Activity List section, select Tasks or Events from 

the View drop-down list to display the list of tasks or events respectively.  

3. In the Activity List section, click the Start, Previous, Next, or End link to access the 

respective list of activities.  

Searching Activities 

You can search the activities alphabetically or filling the required information in the Search box. 

To search activities 

1. Click the Activities tab.  

2. In the Activities Home page, under Find Activities section, specify the search criteria in 

Search box and click the Go button. You can also use the alphabetical search links.  

3. In the Activity List page, a list of activities is displayed as per your search criteria.  

Creating Tasks 

http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Navigating_Activities
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Searching_Activities
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Creating_Tasks
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Creating_Events
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Deleting_Activities
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Customizing_Activities
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Tasks are displayed under the Zoho CRM user's Home page, Activities page, and some of the 

related modules, such as Leads, Accounts, Contacts, etc. 

List of Standard Task-related Fields 

In the Task: Edit form, you need to specify the task-related information. The following table 

provides descriptions of the various fields in the form. 

Field Name Description Data Type 

Subject* 
Specify the subject of the task. This is a mandatory 

field. 

Text box, alphanumeric 

(50) 

Due Date Specify the due date of the task. Date (yyyy/mm/dd) 

Priority Select the priority of the task. Pick list 

Assigned To* 
Select the user to whom the task is assigned. This is 

a mandatory field. 
Picklist 

Status Select the status of the task. Pick list 

Select Module 
Select the modules other than contact and lead name 

with which the task is associated. 
Pick list 

Select 

Contact/Lead 

Select the contact or lead name with which the task 

is associated. 
Pick list 

Send Notification 

Email 

Select the check box to send a notification about the 

task to the Zoho CRM user to whom the event is 

assigned. 

Check box 

Description Specify any additional details about the task. Text Area (long text) 

 

To create tasks 

1. Click the New Task link. Alternatively, click the Task button from records, such as leads, 

accounts, contacts, potentials, cases, and others.  

2. In the Task: page, specify the task-related information. Refer to List of Standard Task-

related Fields section for more details about mandatory fields.  

3. Click Save. Task details are displayed in Activities page under Activity List.  

 

Creating Events 

http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Task_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Task_fields
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Events are displayed under Zoho CRM user's Home page, Activities home page, Calendar, and 

other related modules. 

You can perform the following operations in Events module: 

 Create events (Form filling and quick create options)  

 Search events (Alphabetical/Advanced search)  

 Navigate events through Events List  

 Associate events with other records  

List of Standard Event-related Fields 

In the Event: Edit form, you need to specify the event-related information. The following table 

provides descriptions of the various fields in the form. 

Field Name Description Data Type 

Subject* 
Specify the subject of the event. This is a mandatory 

field. 

Text box, 

alphanumeric (50) 

Event Owner* 
Displays the user to whom the event is assigned. This 

is a mandatory field. This is a mandatory field. 
User Name 

Start Date & 

Time* 

Specify the starting date and time of the event. This is 

a mandatory field. 
Mini Calendar 

End Date & 

Time* 

Specify the completion date and time of the event. 

This is a mandatory field. 
Mini Calendar 

Select Module 
Select the modules other than contact and lead name 

with which the event is associated. 
Pick List 

Venue Specify the location of the event. 
 

Select 

Contact/Lead 

Select the contact or lead name with which the event 

need to be associated. 
Lookup 

Select 

Contact/Lead 

Select the contact or lead name with which the event 

need to be associated. 
Lookup 

Send Notification 

E-mail 

Select the check box to send a notification about the 

event to the Zoho CRM user to whom the event is 

assigned. 

Check box 

Invitees Specify email ID of the event participants Lookup, Email ID 

Repeat Event 
Select this option to repeat the same event in future. 

Options: Daily, Weekly, Monthly, and Yearly  

Send Reminder Select this option to send reminder before start of the 

event.  

Pick List 
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Field Name Description Data Type 

Description Specify additional details about the event. Text Area (32 Kb) 

To create events from Activities 

1. In Zoho CRM Home page, click the New Task link. Alternatively, click the Task button 

from records such as leads, accounts, contacts, potentials, and trouble tickets.  

2. In the Task: page, specify the task-related information. Refer to the List of Standard 

event-related Fields section for more details about mandatory fields.  

3. Click Save. Task details are displayed in Activities page under Activity List section.  

To create events from Calendar 

1. Click the Calendar.  

2. In the Calendar page, by default, Day View is displayed. Click the time (for example 

08:00 hrs), at which you have to set up a event.  

3. In the pop-up dialog, select the event option, type the subject in Subject field, and click 

the Save button.  

4. In the Activity <event Name> page, click the Edit button to update the event details.  

5. In the Activity <event Name> page, enter the other event related details. Refer to List of 

Standard event-related Fields section for more details.  

6. Click Save.  

Deleting Activities 

Occasionally, you may need to remove some of the unnecessary activities from the Zoho CRM 

system for a better user experience. You may consider removing activities that are not useful for 

future reference. 

Warning: Deleting activities is a destructive operation, hence use this option judiciously. 

To delete activities 

1. Click the Activities tab.  

2. In the Activities: Home page, select the activity.  

3. In the Activity: <Activity Name> page, click Delete.  

4. In the Confirmation dialog, click OK to delete the activity permanently.  

Printing Activity Details 

http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
http://zohocrm.wiki.zoho.com/Activities-Calendar.html#Standard_Event_fields
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You can view a printable form and print the activity details using browser’s Print function. 

To print activity details 

1. Click the Activities tab.  

2. In the Activities: Home page, under the Activity List section, select the required activity.  

3. In the Activity: <Activity Name> page, click the Print Preview button.  

4. In the Activity: < Activity Name> page, click the File -> Print Page button to print the 

document.  

Customizing Activities 

(Access Privilege: Customize ZohoCRM.com permission) 

Customization of the activities module includes, renaming the tab name, modifying the pick list 

values in standard fields, adding new custom fields, and modifying activities (tasks and events 

separately) page layout as per activity management requirements. For more details refer, 

Customizing Zoho CRM 

 

 

 

 

 

 

 

 

 

 

 

http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html
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Working with Reports 
 

In Zoho CRM, standard reports are provided in various modules, which can be either used 

directly or customized further according to your organization requirements. 

You can perform the following operations in Reports module: 

 View reports  

 Create reports  

 Create report folders  

 Schedule reports  

 Delete Reports  

Viewing Reports 

Zoho CRM provides 30 different standard reports for the benefit of the users, which are present 

under different module specific folders. You can use the standard reports or can customize as per 

your business requirements. 

List of standard Reports 

Report Name Description 

Account and Contact 

Reports  

Contact Mailing List Display the list of contact address details. 

Key Accounts Displays the accounts that give you more sales revenue. 

Accounts by Industry Displays the accounts from various industries. 

Potential Reports 
 

Pipeline by Stage Displays the potentials by their stage. 

Potentials Closing by 

this Month 
Displays the potentials that are closing during the current month. 

Sales Person's 

Performance Report 
Displays the potentials gained by each sales person. 

Lost Potentials Displays the potentials that are lost. 

Potentials by Type Displays the potentials by their type. 

Open Potentials Displays the potentials that are pending. 

Pipeline by Probability Displays the pipeline of the potentials by their probability. 

http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Viewing_reports
http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Creating_Reports
http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Creating_Reports_Folders
http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Scheduling_Reports
http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Delete_Reports
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Report Name Description 

Sales By Lead Source Displays the sales from various lead sources. 

This Month Sales Displays the sales that has happen during current month. 

Today's Sales Displays the sales that has happen today. 

Lead Reports 
 

Leads By Source Displays the leads from various sources. 

Leads By Status Displays the leads and their status. 

Today's Leads Displays the leads that are created today. 

Leads by Ownership Displays the leads and the corresponding owners. 

Converted Leads Displays the leads that are converted into Account / Potential / Contact. 

Leads by Industry Displays the leads from various vertical industries. 

Activity Reports 
 

Tasks and Events 

Report 
Displays the leads from various vertical industries. 

Campaign Reports 
 

Campaigns Revenue 

Report 
Display the revenue generated from the campaign. 

Campaign Leads Displays the leads that are generated through the campaign. 

Case & Solution 

Reports  

Popular Solutions Displays the number of comments for solutions. 

Cases By Origin Displays the cases based upon their origin. 

Cases By Status Displays the cases based upon their status. 

Cases By Priority Displays the cases based upon their priorities. 

Cases By Comments Displays the cases with the number of comments count. 

Sales Forecast 

Reports  

Quarterly Forecast 

Summary 

Displays the quarterly forecasts that include committed amounts, best-

case amounts, and pipeline by quarter. 

Forecast History 

Report 
Displays the life cycle of the forecast. 

Product Reports 
 

Products by Category Displays the products based upon their category. 

Products by Support 

Termination date 

Displays the products list whose support discontinued during the current 

month. 

Products by Cases 
Display the products and with the list of cases associated with the 

products. 
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Report Name Description 

Inventory Reports 
 

Vendors Vs Purchases Displays the vendors based on the purchases made from the vendors. 

Contacts Vs Purchases Displays the contacts based on purchases. 

Purchase Orders by 

Status 
Displays the purchase orders based on their status. 

Quotes by Accounts Displays the quotes based on accounts. 

Quotes by Stage Displays the quotes based on their stages. 

Sales Orders by 

Accounts 
Displays the sales orders based on accounts. 

Sales Orders by Status Displays the sales orders based on their status. 

Invoices by Accounts Displays the invoices based on their accounts. 

Invoices by Status Displays the invoices based on their status. 

To access standard reports In Reports tab click the specific report (For example, Contact Mailing 

List from the Accounts & Contacts Reports) from the Reports folder (for example, Accounts & 

Contacts Reports, Potentials reports, and others). 

To view the report 

1. Click the Reports tab.  

2. In the Reports Home page, select the report from the required module. (For example, 

Lead by Source from Leads module). The generated report is displayed with some of 

the fields.  

3. In the generated report view click the Export to PDF button to print the report in PDF 

and Export to Excel button to save the report in *.XLS format. 

Creating Reports 

You can create new module-specific reports linking some of the other cross-functional modules. 

For example, you can create a report in accounts module linking other modules such as Contacts, 

Potentials, Quotes, and others. 

List of Primary and related Secondary Modules 

In the Create Report form, you need to specify the primary module and the related secondary 

modules (optional). The following table provides various primary and related secondary 

modules. 
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Primary Module Secondary Modules 

Leads None 

Contacts Accounts, Potentials, Quotes, and Orders 

Accounts Potentials, Contacts, Products, Quotes, and Invoices 

Potentials Accounts, Contacts, and Quotes 

Activities Contacts 

Products Accounts and Contacts 

Cases Products 

Solutions - 

Quotes Accounts, Contacts, and Potentials 

Orders Contacts 

Invoice Accounts 

Types of Report 

 Tabular Report: Displays the data without any subtotals in the report. Use this type of 

report to create contact mailing lists, consolidated view of sales pipeline, and others.  

 Summary Report: Displays the data along with subtotals and other summary 

information.  

 Matrix Report: Displays the data summarized in a grid against both horizontal and 

vertical columns.  

Customizing Reports 

You can create new reports according to your organization requirements. The customization of 

reports involves the following steps: 

 Select the module and the corresponding cross-functional modules  

 Select the report type (Tabular, Summary, or Matrix report)  

 Select the report columns  

 Group the columns  

 Select the arithmetic functions  

 Specify the advanced sorting filters  

 Save the report in folder  

Step 1: To select module and the cross-functional modules 

1. Click the Reports tab.  

2. In the Reports home page, click the Create New Report button.  
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3. In the Create Report page, do the following:  

1. Select the primary module from the Modules drop-down list  

2. Select the cross-functional modules from the Related Modules list box  

4. Click the Continue button.  

 

Select Modules 

Step 2: To select the report type 

1. In the Create Report page, under the Report Type tab, select one of the following report 

options:  

o Tabular Report  

o Summary Report  

o Matrix Report  

2. Once you have selected the type of report, click the Columns tab  
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Select Report Type (Tabular, Summary, or Matrix type) 

Step 3: To select the report columns 

1. In the Create Report page, select the report columns to be displayed from the Available 

Columns list box to Selected Columns list box.  

2. In the Selected Columns list box, change the fields order (if required).  

3. Once you have selected the report columns, click the Grouping tab if you are using 

Summary Report otherwise click the Columns to Total tab.  
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Select Report Columns 

Step 4: To group report columns 

1. In the Create Report page, select click the Grouping tab (This is visible only if you have 

selected Summary reports under the Report Type tab).  

2. In the Grouping page, you can group the columns up to three levels in 

ascending/descending order.  

3. Once you have selected the report columns, click the Grouping tab if you are using 

Summary Report otherwise click the Columns to Total tab.  
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Group Report Columns 

Step 5: To select the arithmetic functions 

1. In the Create Report page, click the Columns to Total tab.  

2. In the Columns to Total section, select the required arithmetic functions, such as Sum, 

Average, Lowest value, and Largest value for the available columns.  

3. Once you have selected the arithmetic functions, click the Criteria tab to add additional 

report filters.  
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Arithmetic Functions in Report 

Step 6: To specify advanced sorting filters 

1. In the Create Report page, click the Criteria tab.  

2. In the Criteria section, select the additional criteria for the report.  

3. Once you have completed the report customization, do the following:  

o Click the Run: To run the customized report. Refer to Step 7 for saving the report 

in folder.  

o Click the Save: To save the custom report criteria.  

o Click the Cancel: To cancel the report customization.  

4. Once you have completed the report customization, you can store the report in a folder.  

http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Step7
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Add More Criteria 

Step 7: To save report in folder 

1. In the Create Report page, click the Run or Save button.  

2. In the Save Report dialog, do the following:  

o Report Name: Specify the report name.  

o Description: Specify any additional details about report.  

o Report Folder: Select the report folder in which the report has to be stored.  

3. Click the Save. Refer to the Creating Report Folders section for folder creation.  

 

Save Report in Folder 

http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Creating_Reports_Folders
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Creating Folders 

By default, reports are stored in different categories. You can create personal/public folders so 

that you can store the frequently used reports in a common folder and access the reports easily 

 

Create Report Folder 

To create report folders 

1. Click the Reports tab.  

2. In the Reports home page, click the Create New Report Folder button.  

3. In the Folder Details do the following:  

o Folder Name: Specify name of the folder.  

o Description: Specify additional information about folder.  

o Accessibility Details: Select one of the following options:  
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 All Users are allowed to view this Template Folder: Select if you would 

like to enable the folder access for all the users.  

 Show this Template Folder only to me: Select if you would like to 

enable the folder access only to you.  

 Allow the following users to view this Template Folder: Select the 

users or user roles that can access the folder.  

4. Click the Save. The new folder is created where you can add reports.  

Note: All the report folders are publicly visible, but the reports within the folder can be made 

private. 

Scheduling Reports 

You can send reports to your colleagues and management (non-Zoho CRM users also) 

periodically within your organization at a scheduled time. 
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Schedule Reports 

In the Scheduler Configuration page, you have to configure the schedule reports. The following 

table provides various field names in scheduling reports. 

Field Name Description Remarks 

Schedule 

Name 
Specify the scheduler name Mandatory field 

Select Report Select the report from the drop-down list Mandatory field 

Active Specify the scheduler status Checkbox 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

178 ©2007, AdventNet Inc. All rights reserved.  

 

Field Name Description Remarks 

Start Date Specify the start date of the scheduling the report 
Mandatory field. The standard 

date format is mm/dd/yy 

Start Time 
Specify the time at which the report has to 

generated and sent to the recipients 

Mandatory field. The standard 

time format is hh:mm 

Repeat 

Specify the frequency of the reports scheduler 

from the drop-down list. You can select one of 

the options. Daily, weekly, monthly, yearly, or 

specified time. 

Drop-down list 

Recipient 

Email 

By default, the logged in user's name is selected. 

You can also send the report to the other users by 

specifying the e-mail IDs. 

Specify the e-mail IDs separated 

by comma 

To setup report scheduler 

1. Click the Reports tab.  

2. In the Reports home page, click the Reports Scheduler button.  

3. In the Scheduled Reports page, existing schedulers are displayed under the Scheduled 

Reports List section. Click the New Report Scheduler button.  

4. In the New Report Schedule page specify the values (Refer to the Report Scheduler fields 

table) and click the Save button.  

Deleting Reports 

Periodically you may delete some of the unnecessary custom reports. 

To delete reports 

1. Click the Reports tab.  

2. In the Reports home page, select the report to be deleted and click the Del link. The 

selected report is deleted.  
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Frequently Asked Questions 

Q1. What types of reports are available? 

Ans: You can create three types of reports namely, Tabular, Summary, and Matrix types of 

reports. 

Q2. How to view reports? 

Ans: All the standard and custom reports are available in Reports Home page. You can select the 

specific reports by clicking the Report link under Report folders. 

Q3. Can I store all my personal reports in a folder? 

Ans: Yes, you can store all your personal reports in a folder, which can be viewed only by you 

and users with System Administrator privilege. If required you can also make report folders 

publicly visible to other users in your organization. 

Q4. Can I schedule my reports and send to my colleagues periodically? 

Ans: Yes, you can schedule reports delivery. After scheduling, reports are sent to the recipients' 

e-mail ID with a link to access the specific report from the Zoho CRM - Reports module. You 

can also send the PDF document to the recipients. For more details on scheduling reports, refer 

to the Scheduling Reports section. 

Q5. Why I am unable to see some of the fields in Reports? 

Ans: You may not be able to see some of the fields in reports if your administrator has disabled 

those fields. You can views fields that are displayed in your page layout. You can see the 

following set of data: Data to which you have the access (Read/Write) that includes records 

owned by you and shared by other users to you. 

 

 

 

 

 

http://zohocrm.wiki.zoho.com/Working-with-Reports.html#Scheduling_Reports
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Working with Dashboards 
 

Dashboards are a pictorial representation of your custom report data, which gives a real-time 

snapshot of your organization's key metrics. Using dashboards, you can easily visualize 

comparisons, patterns, and trends in sales, marketing, support, and inventory related data. For 

example, you can visualize at a glance the products that are selling fast over a period, compare 

the current quarter sales with previous quarter sales, or compare the actual sales to the projected 

sales. 

In Zoho CRM dashboard comprises of different types of two-dimensional and three-dimensional 

charts (components). These charts are built over the Macromedia Flash technology, which 

displays the data dynamically. The charts are bar, pie, line, or funnel. The unique feature in the 

Zoho CRM system is Funnel chart, which can be used to visualize the sales pipeline at various 

stages intuitively. 

Note: Please ensure that your Web browser supports Macromedia Flash. In case the 

Macromedia Flash is not enabled, Macromedia Flash plug-in icon is displayed on the chart area. 

By clicking the Flash plug-in icon you can install the Macromedia Flash plug-in. 

Limitations: 

 Some of the international currency symbols will not display properly.  

 Dashboard properties (color, gradient, borders, background etc.) cannot be modified 

through user interface.  

 Dashboards need to be refreshed manually to display the up-to-minute changes.  

You can perform the following operations in the Dashboards module: 

 Create dashboards  

 Create dashboard charts  

 Modify the existing dashboards  

 Drill-down charts  

 Zoom out charts  

 Manage dashboard folders  

 Delete dashboard  

Creating Dashboards 

(Access Privilege: Read access) 

http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Creating_Dashboards
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Creating_Dashboard_Components
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Drilling_down_dashboards
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Zoom_Dashboard
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Managing_Dashboard_Folders


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

181 ©2007, AdventNet Inc. All rights reserved.  

 

Dashboard is a summary view of the custom report data in your CRM system. It may contain 

more than one chart. However, ensure that at least one chart is added to the dashboard. 

List of Standard Dashboard Components 

In the Dashboard home page, the following types of dashboards are available. 

Module Standard Dashboard Components 

Leads 

 Leads by Source: Displays the leads from various 

sources.  

 Leads by Status: Displays the leads at different status.  

 Sales by Lead Source: Displays the sales from different 

leads sources.  

 Leads by Industry: Displays the leads from different 

industries. 

Accounts & Contacts 

 Sales by Account: Displays the sales revenue generated 

from accounts.  

 Accounts by Industry: Displays the sales revenue 

generated from accounts by industry.  

Potentials 

 Pipeline by Stage: Displays the sales pipeline in various 

stages.  

 Pipeline by Probability: Displays the sales pipeline by 

probability.  

 Potentials by Type: Displays the sales pipeline by type.  

Campaigns 

 Campaign Leads: Displays the leads from different 

campaigns.  

 Campaign Vs Revenue: Displays the sales revenue 

from different campaigns.  

Cases & Solutions 

 Cases by Origin: Displays the cases from different 

sources.  

 Cases by Priority: Displays the cases with different 

priorities.  

 Cases by Status: Displays the cases with different 

status.  

Products 
Products by Category: Displays the products of different 

categories. 
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Inventory Management 

 Vendors Vs Purchases:  

 Sales Orders by Accounts:  

 Contacts Vs Purchases:  

 Purchase Orders by Status:  

 Quotes by Accounts:  

 Quotes by Stage:  

 Invoices by Accounts:  

 Invoices by Status:  

 Sales Orders by Status:  

Note: You cannot modify or delete the standard dashboards. 

To create a dashboard 

1. Click the Dashboards tab.  

2. In the Dashboards Home page, click the Go to Dashboard List link.  

3. In the Dashboard List page, click the Create New Dashboard button.  

4. In the New Dashboard page, specify the following:  

o Name: Specify name of the dashboard  

o Select Dashboard Folder: Select the folder in which the dashboard has to be 

stored.  

o Description: Specify additional details of the dashboard.  

5. Click Save.  

 

Creating Charts 

(Access Privilege: Read/Write access) 

After creating a dashboard you must add components (charts - represent the exact data in 

pictorial form), which includes Bar, Pie, Line, Funnel, or Table type charts. You can select the 

charts to display the data in pictorial form where as table to display the data in tabular format. 

Note: In each dashboard, you can create up to 20 charts. 

List of Standard Charts 

Chart Type Description Example 
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Bar chart 

To display different values of one or more 

items in data, which can be used to 

compare values across categories. 

 

Pie Chart 

To display the data with different parts of 

data into triangular areas (sectors) 

proportional to the percentages of the 

whole data. 

 

Line Chart 

To display a trend over a period with the 

variations in the multiple values in a single 

chart. 

 

Funnel Chart 

To show the convergence of data from the 

entry level to exit level. It is typically used 

show the sales pipeline at any point of 

time. 

 

Table Chart 
To show sum of the values in each 

category of the data. 

 

To create dashboards 

1. Click the Dashboards tab.  

2. In the Dashboards Home page, click the Add Component button.  
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3. In the Add Component page, under the Specify Component Details section specify the 

following:  

o Component Type: Select the component type either Chart or Table.  

o Component Header (Mandatory): Specify the component name.  

o Source Report: Select the custom report to be displayed in dashboard 

component.  

4. Click the Next.  

5. In the Add Component page, under the Specify Chart Details section, select the type of 

chart from the Select Chart Type list box. You can select Vertical Bar, Pie, Line, 

Funnel, or Table.  

6. Click the Finish button. The new chart is displayed under the Dashboard.  

After adding a chart to the dashboard, you can perform the following operations: 

 Change to 2-dimensional or 3-dimensional view  

 Drill-down the chart  

 Zoom out the chart  

 Delete the chart  

Drilling down dashboards 

(Access Privilege: Read access) 

You can view the data underlying each dashboard component. 

To drill-down dashboards 

1. Click the Dashboards tab.  

2. In the Dashboards Home page, select the dashboard from the Switch to Dashboard 

drop-down list.  

3. In the Dashboards Home page, click the dashboard component area for which you would 

like to display the report. The drill-down data is displayed in a report form.  

4. In the Report page, you can perform additional operations, such as Export to 

PDF/XLS/CSV, Save the report, customize further, or refresh the data.  

http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Drilling_down_dashboards
http://zohocrm.wiki.zoho.com/Working-with-Dashboards.html#Zoom_Dashboard
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Drill -down Dashboard 

Zooming out Charts 

You can enlarge the chart for a better visualization of data, which is very useful while working 

with huge data. 

To zoom out chart 

1. Click the Dashboards tab.  

2. In the Dashboards Home page, select the dashboard from the Switch to Dashboard 

drop-down list.  

3. In the Dashboards Home page, under the required chart area click the icon.  

4. The enlarged chart is displayed in a separate Window.  
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Zoom out chart 

Managing Dashboard Folders 

(Access Privilege: Read access) 

Dashboards can be stored in publicly accessible folders for all the Zoho CRM users or private 

folders with a limited access to some of the users. 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

187 ©2007, AdventNet Inc. All rights reserved.  

 

 

Create Dashboard Folder 

Note: System administrators and the users who created the dashboard folder have full 

control on dashboard folders. Other users can access the dashboards only after the owner of the 

folders enables the access rights. 

To create dashboard folder 

1. Click the Dashboards tab.  

2. In the Dashboards Home page, click the Go to Dashboard List link.  

3. In the Dashboard List page, click the Create New Dashboard button.  

4. In the Dashboard Folder Details do the following:  

o Folder Name: Specify name of the folder.  

o Accessibility Details: Select one of the following options:  

 All Users are allowed to view this Dashboard Folder: Select if you 

would like to enable the folder access for all the users.  

 Show this Dashboard Folder only to me: Select if you would like to 

enable the folder access only to you.  
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 Allow the following users to view this Dashboard Folder: Select the 

users or user roles that can access the folder. 

5. Click Save.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

189 ©2007, AdventNet Inc. All rights reserved.  

 

Managing Attachments 
 

File attachments are documents, such as Marketing Collateral, Sales Quotes/Orders/Invoices, 

SLA, and others that can be associated to the CRM modules. 

Notes are the electronic equivalent of paper sticky notes. You can use the notes to write the 

questions, reminders, and anything you would write on notepaper. These are useful for storing 

bits of information related to customers, which you may need later. 

Attachments and Notes modules are available as a related list under detail view of the record. 

You can perform the following operations in Attachments and Notes modules: 

 Attach Files to the Records  

 Delete Attachments  

 Associate notes with records  

 Delete Notes  

Attaching Files to the Records 

You can attach documents to the leads, campaigns, accounts, contacts, cases, products, vendors, 

quotes, orders, and invoices. 

Note: You can upload a file of size less than 2 MB. 

To attach files to the records 

1. Select the record from the required module.  

2. In the Record Detail page, under Attachments section click the New Attachment button.  

3. In the <Module>: File Attachment page, browse the file to be uploaded. You can also 

add some description about the file.  

4. Click the Upload button. The attached file is added under Attachments & Notes list view.  

Deleting Attachments 

Occasionally, you may need to remove the unnecessary files from the Zoho CRM system for a 

better user experience. You may consider removing files that are not useful for future reference. 

http://zohocrm.wiki.zoho.com/Managing-Notes.html#Attach_Files
http://zohocrm.wiki.zoho.com/Managing-Notes.html#Deleting_Attachments
http://zohocrm.wiki.zoho.com/Managing-Notes.html#Creating_Notes
http://zohocrm.wiki.zoho.com/Managing-Notes.html#Deleting_Notes
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Warning: Deleting files is a destructive operation, hence use this option judiciously. 

To delete attachments 

1. In any of the record details view, under Attachments section click Del link.  

2. In the Confirmation dialog, click OK to delete the note permanently.  

Associating Notes with Records 

In Zoho CRM, you can associate notes to the records by specifying the required details in a note. 

List of Standard Note Fields 

In the Note: Edit form, you need to specify the note-related information. The following table 

provides descriptions of the various fields in the form. 

Field Name Description Data Type 

Title* 
Specify the subject of the note. This is a 

mandatory field. 

Text box, alphanumeric 

(50) 

Body Specify details about the note. Text Area (32 KB) 

To create notes 

1. In any of the record details view, click the New Note button.  

2. In the Note: < > page, specify the note-related information. 

Note: Title is a mandatory field. Refer to the List of Standard 

Note-related Fields section for more details. 

3.  

4. Click Save.  

Deleting Notes 

Occasionally, you may need to remove the unnecessary notes from the Zoho CRM system for a 

better user experience. You may consider removing notes that are not useful for future reference. 

http://zohocrm.wiki.zoho.com/Managing-Notes.html#Standard_Notes_fields
http://zohocrm.wiki.zoho.com/Managing-Notes.html#Standard_Notes_fields
http://zohocrm.wiki.zoho.com/Managing-Notes.html#Standard_Notes_fields
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Warning: Deleting notes is a destructive operation, hence use this option judiciously. 

To delete notes 

1. In the Note: <Note Name> page, click Delete.  

2. In the Confirmation dialog, click OK to delete the note permanently.  
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Setting up Personal Information 
 

Users with any role can perform the following operations in the Zoho CRM system: 

 Modify personal information  

 Change password  

 Change date format  

 Change skins  

Modifying Personal Information 

While creating a user in the Zoho CRM system your system administrator add some of the 

mandatory details. You can change your personal information such as, login information, contact 

information, language, date format, time zone, and password protection settings. 

In the User: <User Name> form, you need to specify the user-related information. The 

following table provides descriptions of the various standard fields in the form. 

List of User-related Fields 

Field Name Description Data Type 

First Name Specify the first name of the user. Text box 

Last Name* 
Specify the last name of the user. This field is a 

mandatory field. 
Text box 

Alias Specify the other name of the user. Text box 

Zoho CRM ID* 
Specify the login name of the Zoho CRM user. This is 

a mandatory field. 
Pick list 

Active 

Specify the status of the user. By default, the status is 

active. If required the System Administrator can 

deactivate the user, so that user cannot access the Zoho 

CRM system. 

Check box 

Role* 
Select the user role (for example, Administrator, 

Standard User, and others). This is a mandatory field. 
Pick list 

Email* 
Specify the official E-mail ID of the user. This is a 

mandatory field. 
URL 

Website Specify the website URL of the user. URL 

Phone Specify the official phone number of the user. Pick list 

Mobile Specify the mobile phone number of the user. Text box, integer value 

http://zohocrm.wiki.zoho.com/Setting-up-Personal-Information.html#Personal_Information
http://zohocrm.wiki.zoho.com/Setting-up-Personal-Information.html#Changing_Password
http://zohocrm.wiki.zoho.com/Setting-up-Personal-Information.html#Changing_Date_Format
http://zohocrm.wiki.zoho.com/Setting-up-Personal-Information.html#Changing_Skins
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Field Name Description Data Type 

Fax Specify the FAX number of the user. Text box 

Date of Birth 
Select the date of birth of the user from the 

mm/dd/yyyy drop-down list 
Date box 

Street Specify the primary address of the Zoho CRM user. Text box 

City Specify the name of the city where the user lives. Text box 

State Specify the name of the state where the user lives. Text box 

Zip Specify the postal code of the user's address. Text box, integer value 

Country Specify the name of the user's country. Text box 

Language* 
Select the language. Currently only English language 

is supported. This field is a mandatory field. 
Pick list 

Country Locale* 
Select the country locale to specify your date format. 

This field is a mandatory field. 
Pick list 

Time Zone* 
Select the time zone in which you are working. This 

field is a mandatory field. 
Pick list 

Secret Question* 
Select the secret question for password protection. 

This field is a mandatory field. 
Pick list 

Answer* 
Specify the answer for retrieving the password in case 

you forgot it. This field is a mandatory field. 
Text box 

To change personal information 

1. Click the Setup (top RHS corner) link.  

2. In the Setup page, under the Personal Settings section (Left hand-side tree) click the 

Account Information link.  

3. In the Account Information page, click the Edit button.  

4. In the Edit Account Information page update your personal information and click Save. 

Refer to List of User-related Fields table for more information about  

Changing Password 

For security reasons you are strongly suggested to change your password periodically. 
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Change Password 

To change personal information 

1. Click the Setup (top RHS corner) link.  

2. In Setup page, under Personal Settings section (Left hand-side tree) click the Change 

Password link.  

3. In the Change Password page, specify the old password, new password, and confirm 

password in Old Password, New Password, and Confirm Password fields respectively.  

4. Click Save.  

Changing Date Format 

After logging in first time, you must change the date format as per your organization date & time 

standard. You can select the date format by selecting your country. The date format is 

automatically updated with the country locale. The following international date formats are 

supported: 

 dd-mm-yyyy  

 mm-dd-yyyy  

 yyyy-mm-dd  

 

Date Format 
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To change date format 

1. In Zoho CRM Home page, click the Setup link available at top right corner.  

2. In Setup page, click the Personal Settings link.  

3. In the Personal Settings page, click the Account Information link.  

4. In the Account Information page, click the Edit button.  

5. In the Edit Account Information page, select the date format from Country Locale pick 

list.  

6. Click Save. The date format will be changed for all the date fields in all the modules.  

Changing Skins 

By default, the Metallic skin is enabled for each user in your organization. You can select one of 

the six skins (Metallic, Contemporary, Nature, Elegant, Balmy, or Sunrise) according to your 

wish. 

 

Selecting Skins 

To change skins 

1. Click the Skin link.  

2. In Zoho CRM - Skin Change page, select the required skin and click Apply to view the 

new skin and OK to permanently change the skin.  
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System Administration 
 

As part of the Zoho CRM system administration, users with "Administrator" privilege can 

perform the following operations: 

 Manage users  

 Manage roles  

 Set up company details  

 Import CRM data from other Applications 

 Export Zoho CRM data  

 Customize Zoho CRM  

 Manage Workflow  

 Manage Email Templates  

 Manage Subscriptions  

Note: Ensure that you are logged into Zoho CRM system as a System Administrator, 

otherwise you cannot access the administrator-specific functions. 

Managing Users 

You can perform the following operations in the Users module: 

 Create users  

 Create power users  

 Reset users' password  

 Activate/Inactivate users  

Creating Users 

In the User: <User Name> form, you need to specify the user-related information. The 

following table provides descriptions of the various standard fields in the form. 

List of User-related Fields 

Field Name Description Data Type 

First Name Specify the first name of the user. Text box 

Last Name* 
Specify the last name of the user. This field is a 

mandatory field. 
Text box 

http://zohocrm.wiki.zoho.com/System-Administration.html#Managing_Users
http://zohocrm.wiki.zoho.com/System-Administration.html#Managing_Roles
http://zohocrm.wiki.zoho.com/System-Administration.html#Company_Information
http://zohocrm.wiki.zoho.com/System-Administration.html#Import_History
http://zohocrm.wiki.zoho.com/System-Administration.html#Export_All_Data
http://www.zoho.com/crm/help/customization/customization.html
http://www.zoho.com/crm/help/workflow/managing_workflow.html
http://www.zoho.com/crm/help/email_templates/working_with_email_templates.html
http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html
http://zohocrm.wiki.zoho.com/System-Administration.html#Creating_Users
http://zohocrm.wiki.zoho.com/System-Administration.html#Creating_Power_Users
http://zohocrm.wiki.zoho.com/System-Administration.html#Resetting_Password
http://zohocrm.wiki.zoho.com/System-Administration.html#Inactivating_Users
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Field Name Description Data Type 

Alias Specify the other name of the user. Text box 

Zoho CRM ID* 
Specify the login name of the Zoho CRM user. This is a 

mandatory field. 
Pick list 

Active 

Specify the status of the user. By default, the status is 

active. If required the System Administrator can 

deactivate the user, so that user cannot access the Zoho 

CRM system. 

Check box 

Role* 
Select the user role (for example, Administrator, 

Standard User, and others). This is a mandatory field. 
Pick list 

Email* 
Specify the official E-mail ID of the user. This is a 

mandatory field. 
URL 

Website Specify the website URL of the user. URL 

Phone Specify the official phone number of the user. Pick list 

Mobile Specify the mobile phone number of the user. Text box, integer value 

Fax Specify the FAX number of the user. Text box 

Date of Birth 
Select the date of birth of the user from the mm/dd/yyyy 

drop-down list 
Date box 

Street Specify the primary address of the Zoho CRM user. Text box 

City Specify the name of the city where the user lives. Text box 

State Specify the name of the state where the user lives. Text box 

Zip Specify the postal code of the user's address. Text box, integer value 

Country Specify the name of the user's country. Text box 

Language* 
Select the language. Currently only English language is 

supported. This field is a mandatory field. 
Pick list 

Country 

Locale* 

Select the country locale to specify your date format. 

This field is a mandatory field. 
Pick list 

Time Zone* 
Select the time zone in which you are working. This 

field is a mandatory field. 
Pick list 

Secret 

Question* 

Select the secret question for password protection. This 

field is a mandatory field. 
Pick list 

Answer* 
Specify the answer for retrieving the password in case 

you forgot it. This field is a mandatory field. 
Text box 

To create users 

1. Click the Setup link.  

2. In the Setup page under Admin Settings section, click the Users link.  

3. In the Users page, click the Create New User button.  
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4. In the Create User page, specify the user specific details. Last Name, User ID, Status, 

Role, and Email fields are mandatory. Refer to the List of User-related Fields table for 

more details.  

5. Click the Create New User button. The user login details are sent to the corresponding 

user's e-mail address.  

To modify user details 

1. Click on the Setup link.  

2. In the Setup page under Admin Settings section, click on the Users link.  

3. In the Users page, click the Edit link.  

4. In the Edit User page, modify the user specific details. Refer to the List of User-related 

Fields table for more details.  

5. Click Save.  

Creating Power Users 

Power users can access all the features available in the Zoho CRM system including functions 

under Setup module. By default, user with "System Administrator" role is one of the power 

users. If required, you can enable power user privilege to some of the other users also. 

To create power users 

1. Log in to the Zoho CRM with "Administrator" privilege.  

2. Click the Setup link present at the top right corner.  

3. In the Setup page, under Admin Settings section, click the Users link.  

4. In the Users page, click the Edit link.  

5. In the Edit User page, select the Administrator role from the Role drop-down list and 

click Save. Now the standard user will become one of the System Administrators.  

http://zohocrm.wiki.zoho.com/System-Administration.html#Standard_User_fields
http://zohocrm.wiki.zoho.com/System-Administration.html#Standard_User_fields
http://zohocrm.wiki.zoho.com/System-Administration.html#Standard_User_fields
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Create Administrator User 

Activating/Inactivating Users 

Occasionally, in your organization, the users' roles may change or they may move to some other 

business units. In this case, you have to inactivate those users after changing records ownership 

to other users. 

To inactivate users 

1. Log in to the Zoho CRM with System Administrator privilege.  

2. Click the Setup link present at the top right corner.  

3. In the Setup page, under Admin Settings section, click the Users link.  

4. In Users: page, click the Edit link for the user to be inactivated.  

5. In the User: <User Name> page, clear the Active check box.  

6. Click the Save button. Now the user will be inactivated.  
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Activate/Inactivate Users 

Resetting Password 

When the users are unable to retrieve their password due to some reasons (forgot password or 

unable to provide correct password protection answer) can request the Zoho CRM System 

Administrator to reset their password. After resetting the password, e-mail will be sent to the 

registered e-mail ID of the users. 

To reset password  

1. Click the Setup link.  

2. In the Setup page under Admin Settings section, click the Users link.  

3. In the Users page, select the user checkbox. You can also select multiple users.  

4. Click the Reset Password button. The new password will be notified to the recipients.  

Managing Roles 
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In Zoho CRM, role function provides access privilege to various modules, fields, and special 

functions, such as import, export, merge records, lead conversion, and others. Users associated to 

the specific role can access functions that are assigned to them. 

You can perform the following operations in Roles module: 

 Create roles  

 Control module-level access  

 Control field-level access  

 Associate roles to the users  

Creating Roles 

By default, System Administrator and Standard User roles are provided for the convenience of 

new users. While creating a role, first you have to associate the existing role to the new role and 

later you can change the modules and field-level access control. Users with System 

Administrator privilege can create roles. 

 

Create New Role 

To create roles 

1. Click the Setup link.  

2. In the Setup page under Admin Settings section, click the Roles link.  

3. In the Roles: page, under the Roles List section click the New Role button. 

Note: By default, Administrator and Standard User roles are 

available in Zoho CRM. You cannot modify these standard roles. 

4. In the Create New Role page, enter the role name and select the existing role from the 

Role Name and Existing Role fields respectively.  

http://zohocrm.wiki.zoho.com/System-Administration.html#Creating_Roles
http://zohocrm.wiki.zoho.com/System-Administration.html#Managing_Module_Level_Access
http://zohocrm.wiki.zoho.com/System-Administration.html#Managing_Field_Level_Access
http://zohocrm.wiki.zoho.com/System-Administration.html#Associating_Roles_with_Users
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5. Click Save. The new role is first associated with the existing role. Later you can modify 

the modules and field-level access control list for the new role.  

Controlling Module-Level Access 

After creating a role, you must control the access to the modules (Leads, Accounts, Contacts, 

Potentials, Cases, Solutions, Products, Price Books, Tasks, Events, Forecasts, Vendors, Purchase 

Orders, Sales Orders, and Invoices), import/export, tools, report access, system administration, 

and general permissions to the roles. Users with System Administrator privilege can manage the 

module-level access control lists. 

List of system-level access control functions 

Field Name Description 

Data Level Permissions 
 

Everyone can view/edit all 

users data 
To enable/disable users accessing other users records. 

Admin only can view/edit 

all users’ data. Others can 

only view/edit their data 

alone. 

To specifically enable/disable users with Administrator role to 

access all the users’ records and standard users access their own 

records. If this option is selected standard users cannot access other 

users’ records. 

Entity Level Permissions 
Select the modules (Leads, Accounts, Contacts, Cases, and others) 

to be displayed in users work area. 

Create To create records in a module. 

Edit To modify records in a module. 

Delete To delete records in a module. 

Import Permissions 
 

Import My Records 

To import records pertaining to the individual users. You can 

enable/disable import permission for the Leads, Accounts, 

Contacts, Potentials, Campaigns, Cases, Solutions, Products, Price 

Books, Vendors, and Attachments. 

Import My Organization 

Records 

To import records pertaining to the organization-wide users. You 

can enable/disable import permission for the Leads, Accounts, 

Contacts, Potentials, Campaigns, Cases, Solutions, Products, Price 

Books, Vendors, and Attachments. 

Export Permission 

To export records pertaining to the organization-wide users. You 

can enable/disable export permission for the Leads, Accounts, 

Contacts, Potentials, Campaigns, Cases, Solutions, Products, Price 

Books, and Vendors. 

Tool Permissions 
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Field Name Description 

Mass Transfer 

To transfer records in bulk from one user to another user. You can 

enable/disable mass transfer permission for the Leads, Accounts, 

Contacts, Potentials, Campaigns, Cases, Solutions, Products, Price 

Books, and Vendors. 

Mass Delete 

To delete records in bulk from the Zoho CRM system. You can 

enable/disable mass delete permission for the Leads, Accounts, 

Contacts, Potentials, Campaigns, Cases, Solutions, Products, Price 

Books, and Vendors. 

Report Permissions 
 

Manage Reports & 

Dashboards 

To create/modify/delete reports & dashboards and the folders for 

the reports. 

Schedule Reports To schedule delivery of reports to the intended users. 

Admin Permissions 
 

Manage Users & Roles To manage users and the corresponding roles. 

Change Owner To change owner in each record view page. 

Data Migration To import the complete data from external application. 

View Users Information To view other users details. 

Customize Zoho CRM To customize the pages, fields and others in various modules. 

General Permissions 
 

Mail Server Configuration 

To configure the mail server details. Mail server configuration is 

not available for On-demand Zoho CRM. It is available only in 

Packages product. 

Export Users To export user details into CSV format. 

Export Notes To export all the notes into CSV format. 

Export Competitors To export all the competitors details into CSV format. 

Import My Attachments To import user-specific attachments to the records. 

Import My Organization 

Attachments 
To import organization-specific attachments to the records. 

Convert and Merge Leads To enable convert and merge options in leads details page. 

Mass Change Status Leads To change the status of the leads in bulk. 

Approve Web Leads 
To approve the leads captured from Website using Web-to-lead 

form. 

Web To Lead To create Web-to-lead form for publishing in your Website. 

Manage Lead Assignment 

Rule 
To defile lead assignment rules. 

Mass Email Leads To send mass emails to leads. 

Mass Email Contacts To send mass emails to contacts. 

Web To Case To create Web-to-case form for publishing in your Website. 
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Field Name Description 

Delete Activities To delete activities in bulk. 

Manage Workflow To setup workflow process for your organization. 

Manage Email Templates To setup mass email templates. 

Field Level Access 

Permissions 
To setup field level access permission for the users. 

To control module-level access 

1. Click the Setup link.  

2. In the Setup page, under the Admin Settings section, click the Roles link.  

3. In the Roles page, under the Roles List section, click either the Edit link to modify the 

modules list or the role name to view the module-level access control list. 

Note: You cannot edit the default roles, such as 

"Administrator" and "Standard User". These are provided only for 

your reference. Hence, you are strongly recommended to define 

your own roles based on the existing default roles. 

4. In the Role Details:<Role Name> page, the module-level access permissions are 

displayed.  

5. Click the Edit button to modify the module-level access for the role.  

6. In the Role Information page, specify the access permissions for the following:  

o Data Level Permissions  

o Module Level Permissions  

o Import Permissions  

o Export Permissions  

o Tool Permissions  

o Report Permissions  

o Admin Permissions  

o General Permission  

7. Refer to the List of system-level access control functions table. 

8. Click Save to apply the changes to the role.  

Managing Field-Level Access 

You can also control the access to certain fields for the roles. This will ensure granular security 

and users can see the fields that are relevant to their job. For example, "Sales Stage" and 

"Amount" fields in Potentials module may not be required for a person looking at customer 

support. Similarly, "Status" of the cases can be hidden for the users other than customer support 

http://zohocrm.wiki.zoho.com/Email-Templates.html
http://zohocrm.wiki.zoho.com/System-Administration.html#system_level_access_control
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persons. Users with System Administrator privilege can manage the field-level access control 

lists. 

 

Manage Field-level Access Control 

To manage field-level access control list 

1. Click the Setup link.  

2. In the Setup page go to the User Management section and click the Field Level Access 

Control link. Under the Field Level Access Control section, module-specific (Leads, 
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Accounts, Contacts, Potentials, Helpdesk, Product, Email, Tasks, Events, and others) 

links are displayed.  

3. Click one of the module links (for example, click the Leads link to modify the field-level 

access control for Leads module).  

4. In the <Module>: Role page, click the <role name> link (for example, "Sales Role").  

5. In the <Module>: Field Level Access page, list of field-level access is displayed. Click 

the Edit button.  

6. In the <Module>: Field Level Access page, select or clear the check boxes for the fields 

according to your organization’s field-level access control requirements.  

7. Click Save to update the changes made to the specific module. Follow the same 

procedure for other modules also.  

Associating Users with Roles 

You can associate the role with the users with so that they can access to the modules and fields 

that are assigned to them. Users with System Administrator privilege can associate role with 

user. 

 

Assign Role to the User 
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To associate user with a role 

1. Click the Setup link.  

2. In the Setup page, under the Admin Settings section, click the Users link.  

3. In the Users page, click the Edit link for the specific <User Name>.  

4. In the User: <User Name> page, select the role from the Role pick list.  

5. Click Save.  

Deleting Roles 

You may delete some of the roles from the Roles module that are not required. After deleting a 

role, users associated to the deleted role will be linked to "Standard User" role. You can delete all 

the roles except "System Administrator" and "Standard User" roles. 

Note: If you delete any role without disassociating the users to the other roles, the specific 

user’s role will be changed to Standard User role. 

To delete roles 

1. Click the Setup link.  

2. In the Setup page, under the Admin Settings section, click the Roles link.  

3. In the Roles page, click the Del link for the specific <Role Name>. The role is 

permanently deleted.  

Managing Company Information 

Immediately after signing up with Zoho CRM system, Administrator user is created. With the 

Administrator user login, you can convert the single user edition to a corporate user edition by 

adding additional users. Once second user is added in your system, Company Information link is 

enabled where you can specify your company information. The company information is the 

centralized location where you can specify your organization related information, such as 

company name, number of employees, address, date, currency, time zone, and other details. In 

addition, the company information is used to display the address details in printer friendly 

Quotes, Orders, and Invoices. 
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Company Information 

In the Company Information form, you need to specify your company-related information. The 

following table provides descriptions of the various fields in the form. 

List of Company-related Fields 

Field Name Description Data Type 

Name Specify your company name. Text box 

Primary Contact 
Display the person first registered with the Zoho CRM 

service. 
Text box 

Alias Specify the alias name of the primary contact. Text box 

No. of 

Employees 
Specify the number of employees in your company. Integer 

Role* 
Select the user role (for example, administrator, 

standard user, and others). 
Pick list 

Email* 
Specify the official E-mail ID of the user. This is a 

mandatory field. 
Email 

Phone Specify the official phone number of your company. Text box 

Mobile Specify the mobile number of your company. Text box 

Fax Specify the FAX number of your company. Text box 
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Field Name Description Data Type 

Website URL Specify your company Website URL. URL 

Street Specify the primary address of your company. Text box 

City Specify the city in which your company is located. Text box 

State Specify the state in which your company is located. Text box 

Postal Code Specify the postal code of your company address. Text box 

Country 
Specify the name of the country in which your 

company head quarters is located. 
Text box 

Currency Locale 
Select your country name to display the appropriate 

currency. 
Pick list 

Company Logo 

Upload your company logo, which can be used as 

header in your quotes, orders, and invoices similar to 

letterhead. Maximum allowed size 188 x 80 px. 

Browse Image 

To set up company information 

1. Click the Setup link.  

2. In the Setup page under the Admin Settings section, click the Company Details link.  

3. In the Company Details page, specify the company details. Refer to Company 

Information table for more details:  

4. Click Save.  

Note: Currently multiple currency is not supported. You can configure only a single 

currency. 

 

Frequently Asked Questions 

1. How many users I can add in Zoho CRM system? 

Ans: You can add the first three users free of cost. From fourth user onwards subscribe to service 

at $12 per user per month. For more details, refer to Managing Subscriptions. 

2. I have lost both my password and user ID, how to retrieve my login information? 

Ans: If you are a standard user, contact your Zoho CRM System Administrator for resetting the 

password. If you are administrator, please contact support@zohocrm.com for resetting your 

password. 

3. How to set my language, time zone, date/time formats? 

http://www.zoho.com/crm/help/subscription_management/managing_subscription_license.html
mailto:support@zohocrm.com
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Ans: You can change the organization-wide language, time zone, from the Company Details 

page where as date/time format from the Account Information page. 

6. How to change my fiscal currency? 

By default, the currency is set as US Dollar ($). You can change the currency as per your 

organization's fiscal currency. To change the currency, select the Currency Locale from the 

Company Details page. 
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Customizing Zoho CRM 
 

You can customize the Zoho CRM user interface according to your organization-wide business 

(sales, marketing, support, and inventory management) process. The customization includes the 

following:  

 Renaming of tabs according to industry terminology 

 Modifying standard fields in various modules 

 Adding custom fields to various modules 

 Modifying the page layout 

 Modifying the related list views 

In Zoho CRM, some of the standard fields, pages, related lists, and modules (tabs) are provided 

for the benefit of administrators to jump start customization of the product. You can customize 

these functions as per your business process. Before working with customization you must 

collect your organization-wide sales, marketing, support and inventory management 

requirements. While planning for the product customization, discuss with CRM users in your 

organization and understand their exact requirements before Zoho CRM implementation.  
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In Zoho CRM, you can perform the following operations in product customization module:  

 Rename tabs  

 Create custom fields  

 Add/modify pick list values  

 Customize page layout  

 Change tabs order  

 Change the related list order  

 Modify Default Custom Views  

 

http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Renaming_Tabs
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Creating_Custom_Fields
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Modifying_Picklist_Values
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Modifying_Page_Layout
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Changing_Tab_Order
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Change_Related_Lists
http://zohocrm.wiki.zoho.com/Customizing-Zoho-CRM.html#Modifying_Custom_Views
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Renaming Tabs  

(Access Privilege: Customize ZohoCRM.com permission)  

The aim of the any CRM system is to acquire customers with less expenditure, reduce the churn 

rate, retain customers, and sell more products/services in future. The fundamental philosophy is 

approximately same across the industries but the terminology used in defining sales, marketing, 

and support processes may vary slightly.  

The Zoho CRM system provides an option to change the standard tab names according to your 

industry terminology. For example, if you are planning to use the Zoho CRM for a Real Estate 

business you may change the "Account" tab to "Tenant" where for an Educational Institution 

may rename as "Parents" and so on. After changing the tab name, the changes are reflected in all 

the standard pages in user interface except custom reports and dashboards.  

 

Rename Tabs 

To rename tabs  

1. Click the Setup link.  

2. In the Setup Home page, click the Tab Settings link.  

3. In the Tab Settings page, click the Rename Tabs link.  

4. In the Rename Tabs page, click the Edit link for the tab name to be changed.  

5. In the Change Tab Name page, specify the new name in the New Tab Name field.  

6. Click Save. The tab name and other text will be updated according to your changes.  

Notes: 

 If you revert/rename the tab name to standard name/new name, the new name will not be 

updated in custom views, if the custom view is modified after renaming the tab.  
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 New tab names will not be reflected on Page Layout, Reports, and Dashboards modules. 

Always standard names are displayed.  

 All the field names will also change according to the new name. For example, if you 

change "Account" tab to "Client", the "Account Name" field will be changed to "Client 

Name".  

 If you change a tab name to plural form with suffix "-ies" (last three characters - right to 

left), the singular form will be suffixed with "y". For example, if you change "Potentials" 

to "Opportunities", in all the places the singular form of "Potential" is changed to 

"Opportunity".  

Managing Custom Fields  

(Access Privilege: Customize ZohoCRM.com permission)  

By default, some of the standard fields are available in each module, which helps you to start 

working with the CRM system. You may consider adding more industry-specific custom fields 

according to your business process. You can add custom fields in all the modules except tasks 

and events modules.  

 

Adding Custom Fields 

How many custom fields I can create in each module? 

In each module, you can add up to 120 custom fields. The maximum number fields for each type 

are given below:  
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 text, pick list, multi-select pick list, email, phone, text area, and URL fields - 50  

 integer, percent, and currency - 15  

 date field - 10  

 check-box - 10 

 lookup - 10 

In the Setup: New <Module>Edit form, you need to specify the custom field-related information. 

The following table provides descriptions of the various fields in the form.  

Field Type Description Fields 

Text To add Text type fields. 

Label: Specify the field name 

Length: Specify the field size (number of 

character - Integer) 

Integer To add number type fields. 
Label: Specify the field name 

Length: Specify the field size (Integer) 

Percent To add percentage type fields. 

Label: Specify the field name 

Length: Specify the field size (Integer) 

Decimal Places: Specify the number of decimal 

places 

Currency To add currency type fields. 

Label: Specify the field name 

Length: Specify the field size (Integer) 

Decimal Places: Specify the number of decimal 

places 

Date To add date type fields. 

Label: Specify the field name 

Format: YYYY/MM/DD 

 

Note: Date format will be changed according 

user time zone settings. 

Date & Time  
To add date & time 

combination fields. 

Label: Specify the field name 

Format: YYYY/MM/DD HH:MM  

 

Note: Date format will be changed according 

user time zone settings. 

E-mail 
To add E-mail addresses type 

fields. 

Label: Specify the field name 

Length: Specify the field size (Integer) 

Phone 
To add phone numbers type 

fields. 

Label: Specify the field name 

Length: Specify the field size (Integer) 

Pick list To add pick lists type fields. 
Label: Specify the field name 

Pick List Values: Specify the pick list values 

Multi-select 

Pick list  

To add pick lists with multiple 

selection of values  

Label: Specify the field name 

Pick List Values: Specify the pick list values 
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URL To add Web site addresses. Label: Specify the field name 

Text Area To add long text (size: 32 Kb) Label: Specify the field name 

Checkbox 
To select a true (checked) or 

false (unchecked) type value. 
Label: Specify the field name  

Auto 

Increment  

To add auto-increment type 

fields  

To add custom fields  

1. Click the Setup link.  

2. In the Setup: Home page select the required <Module> Settings link.  

3. In the <Module> Settings page click the Fields link. In the <Module> Fields page all the 

available fields are displayed.  

4. Click the New Custom Field button.  

5. In the Custom Field Settings - New Custom Field page, do the following:  

1. In Select Field Type section, select the field type.  

2. In Provide Field Details section, enter the field name, field size, and decimal 

places in the Label, Length, and Decimal Places fields respectively.  

8. Click Save. The custom field is added to the respective module. To check the field, select 

the corresponding module and add/edit the record. The new field added is displayed 

under Custom Information section to enter the required details. 

Customizing Pick list Values  

(Access Privilege: Customize ZohoCRM.com permission)  

By default, some of the industry standard pick list values are available in each module. You can 

modify the pick list values as per your organization business process and replace the existing 

value with new value so that records will be associated to new values.  
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Customize Pick List Values 

To add/modify pick list values  

1. Click the Setup link.  

2. In the Setup: Home page, under <Module> Settings section, click the Field List link.  

3. In the <Module> List page, edit the field with data type Pick List (For example, Lead 

Source field in the Lead List page).  

4. In the Edit Pick List page, add/modify values in the Values list box. Once you have 

updated the pick list values you can sort the values alphabetically and use the first values 

as the default pick list value.  

5. Click Save.  

Example: If you want to add, modify, or delete the pick list values for Lead Source field in 

Leads module:  

1. Click the Setup link.  

2. In the Setup: Home page, under Lead Settings section, click the Field List link.  

3. In the Lead List page, edit the Lead Source field.  
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4. In the Edit Pick List page, add/modify values in the Values list box. Once you have 

updated the pick list values for Lead Source you can sort the values alphabetically and 

use the first values as the default pick list value.  

5. Click Save.  

Warning: If you delete/modify any of the pick list values, records associated with the values 

are changed to "None" and no longer use the deleted values. Hence, you are strongly 

recommended to first change the values in records to another value and then delete/modify the 

pick lists. 

Customizing Page Layout  

(Access Privilege: Customize ZohoCRM.com permission)  

Page customization is one of the most important administrator functions that should be 

completed before rolling out the CRM system for your organization. You can use the Drag & 

Drop customization to perform the following operations:  

 Show/hide fields in pages: By default all the standard fields are displayed in each 

module page layout. You can hide some of the standard fields, add new custom fields to 

the pages, and move fields from one section to other section.  

 Add/Modify sections in pages: by default, some of the sections are available in each 

module. You can add, modify or delete the sections.  

 Change field navigation: You can use the tab key to navigate the fields while entering 

the field details. In each section, the tab navigation order can be configured either to Left 

--> Right or Top --> bottom.  

 Change field properties: You can change the fields to mandatory or optional (read-

only). However, you cannot change the property of the standard mandatory fields (For 

example, Company name in Leads module is a mandatory field. You cannot change the 

Company field to read-only).  
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Drag & Drop Customization 

To modify the page layout  

1. Click the Setup link.  

2. In the Setup: Home page, under <Module> Settings section, click the Edit Page Layout 

link.  

3. In the Edit Page Layout page, do the following:  

o Show/Hide fields: Drag the field to be hidden from the Page Layout: <Module> 

section and drop to the Field List section. You can also drag the fields to be 

shown from the Field List section to the Page Layout: <Module> section.  

o Create new sections in page: Click the Create New Section button. In the 

Section Information popup box specify the section name and tab order (Left --

>Right or Top -->Bottom) in the Name and Tab Order fields respectively.  

o Change the property of the fields: Select the field to be modified and click the 

Edit Field Properties button. In the Edit Field Properties popup box, change the 

field property to Mandatory or Read-only.  

4. Follow the same procedure until you have completed the page layout customization.  

5. Click Save. The updated the page layout is reflected for all the users in your organization 

according to their field level access.  
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Changing Tab Order  

(Access Privilege: Customize ZohoCRM.com permission)  

You can change the order of the modules according to your organization's business process. You 

can hide all the tabs except Home tab.  

 

Change Tab Order 

To change the tab order  

1. Click the Setup link.  

2. In the Tab Settings section, click the Customize Tabs link.  

3. In the Customize Tabs page, change the tabs order and show/hide some of the tabs.  

4. Click Save. Tab order will be changed for all the users.  

Changing Related Lists  

(Access Privilege: Customize ZohoCRM.com permission)  

In each module, you can change the order of the related list views and show/hide some of the 

related lists as per your requirement.  



ZOHO CRM USER MANUAL 
November 

29, 2007 

 

221 ©2007, AdventNet Inc. All rights reserved.  

 

 

Change Related List Order 

To customize the related lists  

1. Click the Setup link.  

2. In the Setup Home page, click the <Module> Settings link. The module can be Lead, 

Account, Contact, and others.  

3. In the <Module> Settings section, click the Customize <Module> Details link.  

4. In the Customize <Module> Details page, change the related list order from the Selected 

List box or hide related lists that are not required.  

5. Once you have completed the operation, click Save.  

Modifying Default Custom Views  

(Access Privilege: Customize ZohoCRM.com permission)  

By default, some of the standard list views are available in each of the module home pages. You 

can change the default list view as per your requirements. Whenever user accesses a particular 

module Home page, the modified list view is displayed.  
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Modify Default Custom View 

To modify custom views  

1. Click the Setup link.  

2. In the Setup Home page, click the <Module> Settings link. The module can be Lead, 

Account, Contact, and others.  

3. In the <Module> Settings section, click the Custom View Settings link.  

4. In the Custom View Settings page, change the default view to be displayed from the New 

View drop-down list.  

5. Click Save.  
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Managing Workflow Rules 

Workflow management allows you to automate your sales, marketing, support processes, in 

which the records, tasks are assigned or transferred from one user to another for action, 

according to a set of predefined rules. The workflow rule is triggered when record meets the 

specified matching criteria. The key benefits of Workflow are improved efficiency by 

eliminating many unnecessary steps in records and tasks assignment, better process control by 

improved business process through standardizing working methods and reduced operating costs. 

For example, Zoho CRM provides a sample Lead Assignment rule in Leads module (based on 

Workflow rules) for assigning leads generated through import or web integration to lead owners 

(Sales Reps) based on different criteria automatically. The matching criteria can be region, 

country, company, etc. Immediately after matching the criteria, a new task is created and 

assigned to the lead owner according to company's business process. It will also notify the lead 

owner about the new lead assignment in an appropriate E-mail template. 

Another sample workflow rule in the Zoho CRM system is Big Deal Alert. This rule is executed 

when the Sales Amount and probability of winning the business opportunity crosses the 

significant value, which can be notified to the management and other colleagues in your Sales 

team. 

You can associate workflow rules with alerts (e-mail message), tasks, or both. To send a 

notification to the recipients, you must associate an alert to the rule. 

You can perform the following operations in Workflow module: 

 Manage rules  

 Setup alerts  

 Add Tasks  

 Manage e-mail templates  

Note: Workflow rules will be triggered only when you create a new record, update the 

existing record or both depending upon workflow rule settings. 

Managing Workflow Rules 

While setting up Workflow rules, first create a rule with suitable matching criteria. You can 

perform the following operations in Workflow module: 

http://www.zoho.com/crm/help/workflow/managing_workflow.html#Workflow_Rules
http://www.zoho.com/crm/help/workflow/managing_workflow.html#Workflow_Alerts
http://www.zoho.com/crm/help/workflow/managing_workflow.html#Workflow_Tasks
http://www.zoho.com/crm/help/workflow/managing_workflow.html#Email_Templates
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 Create/modify/delete workflow rules  

 Activate/deactivate workflow rule  

To add workflow rule 

1. Click the Setup link.  

2. In the Setup Home page, click the Workflow Settings link.  

3. In the LHS tree expand the Workflow Setting link and click the Workflow Rules link.  

4. In the Workflow Rules page, some of the existing rules are displayed. Click the New Rule 

button.  

5. In the Select Record Type page, select the module from the Module drop-down list. Click 

the Next button.  

6. In the New Rule page, under the Rule Details section, specify the following:  

o Record Type: Display the module selected in the previous page (Select Record 

Type)  

 Rule Name: Specify the name of the rule  

 Description: Specify additional details about rule.  

 Active: Select the Active check box to enable the rule. By default, the 

check box is selected. If you do not want to enable the rule, disable the 

check box.  

 Evaluation Time: Select one of the following options:  

 Evaluate this rule when new records are created: Select this 

option to trigger the rule when a new record is created.  

 Evaluate this rule when new records are created and existing 

records are edited: Select this option to trigger the rule when 

record is created/modified.  

o In the Rule Criteria section, specify the matching criteria. You can select multiple 

criteria.  

7. Click Save. A new workflow rule is displayed where you can add alerts and tasks.  

 

Setting up Workflow Alerts 

Workflow alert comprises of an e-mail template, which is used to send mass e-mail notification 

to all the specified recipients. An E-mail message will be sent to the recipients upon triggering 

the workflow rule. For each workflow rule, you can associate only one alert (E-mail template). 

To add workflow alert 

1. Click the Setup link.  
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2. In the Setup Home page, click the Workflow Settings link.  

3. In the LHS tree expand the Workflow Setting link and click the Workflow Alerts link.  

4. In the Workflow Alerts page, some of the existing alerts are displayed. Click the New 

Alert button.  

5. In the New Alert page, do the following:  

6. In the Alert Details section, specify the name of the alert and select the E-mail template 

from the Name and E-mail fields respectively.  

7. In the Recipient Details section, select the recipients of the alert form the Available 

Recipients list box. You can also notify alert to the other users by specifying E-mail IDs 

in Additional Recipients text box.  

8. Click Save. An E-mail based alert is created, which can be associated to the workflow 

rules.  

Managing Workflow Tasks 

The task can be associated to workflow rule in case you are planning to create a task upon 

triggering a workflow rule. For new records tasks will be created for the users with a default, 

values specified the workflow task. 

To add workflow task 

1. Click the Setup link.  

2. In the Setup Home page, click the Workflow Settings link.  

3. In the LHS tree expand the Workflow Setting link and click the Workflow Tasks link.  

4. In the Workflow Tasks page, some of the existing tasks are displayed. Click the New 

Task button.  

5. In the New Task page, specify the following:  

o Record Type: Select the module.  

o Subject: Specify the subject of the task.  

o Priority: Select the priority of the task.  

o Status: Select the default status of the task while creating it first time  

o Due Date: Specify the date to execute the workflow rule. The due date is a 

combination  

o Assigned To: Select the user to whom the task has to be assigned.  

o Description: Specify additional details of the workflow task.  

6. Click Save. A new workflow task is created, which can be associated to workflow rules.  

Managing E-mail templates 
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As part of the workflow management, notification through E-mail is one of the most important 

tasks. The E-mail notifications can be predefined so that upon triggering a workflow rule, 

predefined E-mail will be sent to all the recipients. 

Warning: If you are creating E-mail template for sending Emails to leads, do not merge the 

contact-related fields and vice a versa. If you are trying to merge both fields, you will experience 

some errors during E-mail creation. 
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Working with Outlook Plug-in 
 

The Zoho CRM Outlook plug-in is productivity-enhancement software that can be used with 

Zoho CRM and Microsoft Outlook. The Outlook Plug-in can be installed on users' MS Outlook, 

which can be used to synchronize the contacts in between Microsoft Outlook and the Zoho CRM 

and add the contact specific e-mail as a Case to the Zoho CRM customer specific cases.  

 Installation Procedure  

 Activating Outlook Plug-in in Zoho CRM  

 Working with Outlook Plug-in  

 Field-Mapping  

Installation Procedure 

 System Requirements  

 Installation Prerequisites  

 Installing Zoho CRM Outlook Plug-in  

 Uninstalling Zoho CRM Outlook Plug-in 

System Requirements 

 Hardware: x486 with 256 MB RAM or higher with a minimum of 10 MB disk space  

 Operating Systems: Windows 2000/XP/2003  

 Software: Microsoft Outlook 2000/2002/2003/2007 and Internet Explorer 6/Internet 

Explorer 7  

Installation Prerequisites 

 You must have administrator privileges on the system.  

 You must have valid login details to connect Zoho CRM server.  

 Microsoft Outlook must be stopped before installing the Outlook Plug-in.  

Installing Zoho CRM Outlook Plug-in  

1. Log in to your Zoho CRM account.  

2. Download the Zoho CRM Outlook Plug-in from the Setup > Personal Settings > 

Outlook Plug-in page. 

http://crm.zoho.com/
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Installation%20Procedure
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Activate-Outlook-Plugin
http://#3._Working_with_Outlook_Plug-in
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Field-Mapping
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#System_Requirements
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Installation_Prerequisites
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Installing_Outlook_Plugin
http://zohocrm.wiki.zoho.com/Working-with-Zoho-CRM-Outlook-Edition.html#Uninstalling_Outlook_Plugin
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3. Run the ZohoCRM_Outlook_Plugin.exe.  

4. In the Welcome to the Installation Wizard dialog, click the Next button.  

5. In the License Agreement dialog, read the license agreement and click the Yes button if 

you accept the license agreement.  

6. In the Directory Choose Destination Location dialog, browse the directory (By default 

the destination directory is C:\AdventNet\ZohoCRM Outlook Plug-in) in which you want 

to install Zoho CRM Outlook Plug-in and click the Next button. Zoho CRM Outlook 

Plug-in installation will take a few seconds.  

7. In the Installation Completed dialog, click the Finish button to complete the installation.  

Uninstalling Zoho CRM Outlook Plug-in 

1. Stop the Microsoft Outlook if it is running.  

2. Select Start > Settings > Control Panel.  

3. In the Control Panel, click the Add/Remove Programs icon.  

4. In the Add/Remove Programs dialog, select the Zoho CRM Outlook Plug-in and click 

the Remove link. It will take a few minutes to uninstall the Zoho CRM Outlook Plug-in. 

Activating Outlook Plug-in in Zoho CRM  

(Access Privilege: Administrator) 

New User: Sign up for Zoho CRM account from: http://crm.zoho.com/crm/signup.sas 

http://crm.zoho.com/crm/signup.sas
http://zoho.com/crm/1549989/AdventNet_ZohoCRM_OutlookEdition.exe
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Existing User: After logging in to Zoho CRM activate your Outlook Account from Setup --

>Subscription Manager --> User Activation page 

 

Working with Outlook Plug-in  

Using the Zoho CRM Outlook Plug-in, you can perform the following operations:  

 Synchronize Contacts, Tasks, and Calendar between Zoho CRM and Microsoft Outlook  

 Resolve conflicts during synchronization  

 Add customers-related emails as cases in Zoho CRM  

 Modify the email message before adding to Zoho CRM  
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Note: Currently Zoho CRM Outlook Plug-in supports Microsoft Outlook 2000, 2002, 2003 

and 2007 versions only. 

Configuring Zoho CRM Server 

Before adding or synchronizing Microsoft Outlook E-mails and contacts to the Zoho CRM, 

specify the Zoho CRM login details in Microsoft Outlook. You can use the Outlook Plug-in to 

connect the Zoho CRM On-demand service.  

To configure Zoho CRM login details  

1. Start the Microsoft Outlook.  

2. Click the Zoho CRM -> Login menu.  

3. In Zoho CRM Login dialog, specify your Zoho CRM login details:  

o Zoho CRM ID: Enter the user name to log in to the Zoho CRM.  

o Password: Enter the password for the user name.  

o Remember Me: Select the check box if you want to remember the login details.  

o Click Login Option link to add the Zoho CRM URL. You can select either On-

demand Service or Installed Zoho CRM Solution option and specify the exact 

URL of the service.  

4. Click Save to apply the changes.  

Synchronizing Outlook Contacts with Zoho CRM  

Synchronization allows you to enter the customer-specific contacts from Microsoft Outlook to 

Zoho CRM and vice-a-versa and update the information in both Zoho CRM and Microsoft 

Outlook. It also eliminates duplication of contacts and resolves conflicts if the data is not in sync.  

To synchronize contacts between Microsoft Outlook and Zoho CRM  

1. Select the Contacts shortcut from the Microsoft Outlook sidebar.  

2. Select the required contact(s) from the Inbox.  

3. Click the Zoho CRM -> Sync Contacts menu.  

4. It takes a few minutes to completely read the contacts in Zoho CRM and Microsoft 

Outlook. Once reading is completed, you have to complete one of the following 

operations:  

a. Add Contacts  

b. Resolve Conflicts  

Adding Contacts  
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If you are synchronizing contacts first time, then follow these steps:  

1. In the Synchronizing Status dialog, contacts added, updated, and deleted are displayed. 

Click the View Details button to view the list of contacts.  

2. In the Sync Changes dialog, list of contacts are displayed. Once you are ensured that all 

the contact details are correct, click the Close button.  

3. In the Synchronizing Status dialog, click the Accept Changes or the Close button to 

complete or abort the synchronization respectively. 

Resolving Conflicts  

Say, after the first time synchronization, you update the contact details in Zoho CRM or in 

Microsoft Outlook. Then there will be differences in contact details present in Zoho CRM and 

Microsoft Outlook. To update the same contact details in Zoho CRM and Microsoft Outlook, 

you have to override the data in other-side.  

To resolve conflict between Microsoft Outlook and Zoho CRM  

1. In the Conflict Resolution dialog, conflicting contact name and the corresponding fields 

are displayed in a table. Select the value to be synchronized (either from MS Outlook 

column or from Zoho CRM). You can select the following options:  

o Update Outlook Details in Zoho CRM: To update the changes made in Outlook 

to Zoho CRM.  

o Update Zoho CRM Details in Outlook: To update the changes made in Zoho 

CRM to Outlook.  

2. Click Save.  

3. Once contacts details are updated click the Accept Changes button. 

Synchronizing Outlook Calendar with Zoho CRM  

Synchronization allows you to enter the customer-specific calendar appointments from Microsoft 

Outlook to Zoho CRM and vice-a-versa and update the information in both Zoho CRM and 

Microsoft Outlook. It also eliminates duplication of appointments and resolves conflicts if the 

data is not in sync.  

To synchronize contacts between Microsoft Outlook and Zoho CRM  

1. Select the Calendar shortcut from the Microsoft Outlook sidebar.  

2. Select the required appointments from the Inbox.  

3. Click the Zoho CRM -> Sync Calendar menu.  
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4. It takes a few minutes to completely read the appointment in Zoho CRM and Microsoft 

Outlook. Once reading is completed, you have to complete one of the following 

operations:  

a. Add Appointments  

b. Resolve Conflicts  

Adding Appointments  

If you are synchronizing appointments first time, then follow these steps:  

1. In the Synchronizing Status dialog, appointments added, updated, and deleted are 

displayed. Click the View Details button to view the list of appointments.  

2. In the Sync Changes dialog, list of appointments are displayed. Once you are ensured that 

all the appointment details are correct, click the Close button.  

3. In the Synchronizing Status dialog, click the Accept Changes or the Close button to 

complete or abort the synchronization respectively. 

Resolving Conflicts  

Say, after the first time synchronization, you update the appointment details in Zoho CRM or in 

Microsoft Outlook. Then there will be differences in appointment details present in Zoho CRM 

and Microsoft Outlook. To update the appointment details in Zoho CRM and Microsoft Outlook, 

you have to override the data in other-side.  

To resolve conflict between Microsoft Outlook and Zoho CRM  

1. In the Conflict Resolution dialog, conflicting appointment name and the corresponding 

fields are displayed in a table. Select the value to be synchronized (either from MS 

Outlook column or from Zoho CRM). You can select the following options:  

o Update Outlook Details in Zoho CRM: To update the changes made in Outlook 

to Zoho CRM.  

o Update Zoho CRM Details in Outlook: To update the changes made in Zoho 

CRM to Outlook.  

2. Click Save.  

3. Once appointment details are updated click the Accept Changes button.  

Synchronizing Outlook Tasks with Zoho CRM  

Synchronization allows you to enter the customer-specific tasks from Microsoft Outlook to Zoho 

CRM and vice-a-versa and update the information in both Zoho CRM and Microsoft Outlook. It 

also eliminates duplication of tasks and resolves conflicts if the data is not in sync.  
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To synchronize tasks between Microsoft Outlook and Zoho CRM  

1. Select the Tasks shortcut from the Microsoft Outlook sidebar.  

2. Select the required task(s) from the Inbox.  

3. Click the Zoho CRM -> Sync Tasksmenu.  

4. It takes a few minutes to completely read the tasks in Zoho CRM and Microsoft Outlook. 

Once reading is completed, you have to complete one of the following operations:  

1. Add Tasks  

2. Resolve Conflicts 

Adding Tasks 

If you are synchronizing tasks first time, then follow these steps:  

1. In the Synchronizing Status dialog, tasks added, updated, and deleted are displayed. Click 

the View Details button to view the list of tasks.  

2. In the Sync Changes dialog, list of tasks are displayed. Once you are ensured that all the 

task details are correct, click the Close button.  

3. In the Synchronizing Status dialog, click the Accept Changes or the Close button to 

complete or abort the synchronization respectively. 

Resolving Conflicts  

Say, after the first time synchronization, you updated the task details in Zoho CRM or in 

Microsoft Outlook. Then there will be differences in task details present in Zoho CRM and 

Microsoft Outlook. To update the task details in Zoho CRM and Microsoft Outlook, you have to 

override the data in other-side.  

To resolve conflict in between Microsoft Outlook and Zoho CRM  

1. In the Conflict Resolution dialog, conflicting contact name and the corresponding fields 

are displayed in a table. Select the value to be synchronized (either from MS Outlook 

column or from Zoho CRM). You can select the following options:  

o Update Outlook Details in Zoho CRM: To update the changes made in Outlook 

to Zoho CRM.  

o Update Zoho CRM Details in Outlook: To update the changes made in Zoho 

CRM to Outlook.  

2. Click Save.  

3. Once contacts details are updated click the Accept Changes button.  
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Adding E-mail Messages as Cases in the Zoho CRM  

You can add customer-specific E-mail messages from Microsoft Outlook to Zoho CRM as a 

Case. Before adding, the E-mail messages make sure the corresponding contact to the E-mail 

exists in Zoho CRM.  

To add E-mail messages from Outlook to Case in Zoho CRM  

1. Select the Inbox shortcut from sidebar.  

2. Select the customer-specific E-mail message from the Inbox.  

3. Click the Zoho CRM > Add Case to Zoho CRM menu. 

Note: If the corresponding contact's E-mail address is not 

available in Zoho CRM, an error message "No matching contacts 

for <Email Address>" is displayed. When this error message is 

displayed, first add the contact in the Zoho CRM before adding the 

E-mail message. 

4. In the Add Selected Message to Zoho CRM dialog, the Contacts tab is displayed where 

the selected E-mail details are displayed.  

5. In the Contacts table, click the View link to view the contact details in Zoho CRM. 

Note: When you click the View link, a default browser is 

displayed. Here, enter the Zoho CRM login details. First time, it 

will not display the appropriate contact details. You have to click 

the View link again to view the selected contact details. 

6. Sometimes you may not require archiving the complete E-mail in Zoho CRM. In this 

case, you can modify the E-mail message before adding it to the Zoho CRM. Follow the 

steps given below to modify the E-mail message:  

1. Select the E-mail message to be modified from the Contacts table.  

2. Click the Edit Message tab.  

3. Modify the content in the Edit Message text area.  

7. You can also attach the files related to the e-mail message. Click the Attachments tab 

and view the list of attached files. You cannot attach files with more than 1 MB and 

delete any attachments.  

8. Click the Add to Zoho CRM button to add the E-mail message to the selected contact in 

Zoho CRM.  

9. Once the E-mail message is added to Zoho CRM, the "Successfully Added" message is 

displayed. Click the Close button to complete the operation. 
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Zoho CRM - Outlook Fields Mapping 

Contact Synchronization - Field Mapping 

Outlook Zoho CRM  Field Length in Zoho CRM 

1. First Name First Name 40  

2. Last Name Last Name 80 

3. Title Job Title 100 

4 . Company Name  Account Name 100 

5. Department Department 50 

6. Business Telephone Number Phone 30 

7. Home Telephone Number Home Phone 30  

8. Other Telephone Number Other Phone 30  

9. Business Fax Number Fax 30 

10. Mobile Telephone Number Mobile  

11. Assistant Name Assistant 50 

12. Assistant Telephone 

Number 

Asst Phone 30 

13. Manager Name Report To 50 

14. Business Address Street Mailing Street 250 

15. Business Address City Mailing City 30 

16. Business Address State Mailing State 30 

17. Business Address Postal 

Code 

Mailing zip 30 

18. Business Address Country Mailing 

Country 

30 

19. Other Address Street Other Street 250 

20. Other Address City Other city 30 

21. Other Address State Other state 30 
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Outlook Zoho CRM  Field Length in Zoho CRM 

22. Other Address Postal Code Other zip 30 

23. Other Address Country Other Country 30 

24. Description Description 3000 

25. Birthday Birthday  

Task Synchronization – Field Mapping 

   

Outlook Zoho CRM Length in Zoho CRM 

1. Subject Subject 120 

2. Due date Due Date  

3. Start date ------------  

4. Priority Priority  

5. Status Status 30 

6. Description  Description 3000 

Calendar Appointments Synchronization – Field Mapping 

Outlook Zoho CRM Length in Zoho CRM 

1. Subject Subject 120 

2. Start Time Start Date and Time  

3. End Time End Date and Time  

4. Location Venue  

5. Description Description 3000 
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Managing Subscriptions 
 

In Zoho CRM, you can add the first three users free of cost. From the FOURTH user onwards 

you have to subscribe for the service. 

In the Subscription Manager section, you can upgrade the free edition (three users) to 

professional edition by ordering more users on per user per year basis. Before subscribing to the 

additional users, accept the subscription agreement. 

If you are using the Zoho CRM On-demand service, you can perform the following operations: 

 Subscribe for more users  

 Activate/Deactivate users  

 View Order history  

Subscribing for more users 

In the Order More Users form, you need to specify your company related information. The 

following table provides descriptions of the various standard fields in the form. 

List of Standard Subscription-related Fields 

Field Name Description Data Type 

No of Additional 

Users* 
Specify the number of users. This field is mandatory. Text box, Integer (100) 

First Name Specify the first name of the contact person. 
 

Last Name* Specify the last name of the contact person. 
 

Website Specify the URL of your company's Website. 
URL, alphanumeric 

(30) 

Phone* 
Specify phone number of your company with 

international code. 

Text box, 

alphanumeric (30) 

Fax Specify fax number of your company. 
Text box, 

alphanumeric (30) 

E-mail * 
Specify the official E-mail address of your company 

or contact person. 

E-mail, alphanumeric 

and special characters 

(100) 

http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#Ondemand_users
http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#Activate_Ondemand_Users
http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#View_Order_History
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Billing Address*  

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the billing address of your company to send 

the invoice for your order. 

 Street, 

alphanumeric 

(250)  

 City, 

alphanumeric 

(30)  

 State, 

alphanumeric 

(30)  

 Postal Code, 

alphanumeric 

(30)  

 Country, 

alphanumeric 

(30)  

Shipping 

Address*  

 Street  

 City  

 State  

 Postal 

Code  

 Country  

Specify the shipping address of your company to 

deliver the service/product. 

-Do- 

Payment Mode 

Select one of the following options: 

 Payment on Wire: To transfer the amount 

through wire  

 Payment by Credit Card: To pay the 

amount immediately using your Credit card.  

 Payment by Cheque: To send a cheque for 

the amount billed for the subscription.  

Radio button 

To order more users 

1. Click the Setup link.  

2. In the Setup page, under the Subscription Manager section, click the Order Users link.  
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3. In the Order More Users page, specify all the mandatory fields. Refer to the List of 

Standard Invoice-related Fields section for more details.  

4. Click Send Mail button to process your order. Immediately after submitting your order, 

the Zoho CRM - Accounting representative will contact you within 24 hr.  

 

Subscription Order Details 

Activating Users 

You can activate/deactivate users in your Zoho CRM system according to maximum number of 

permitted in your subscription. In case you have added more users during evaluation and later 

decided not to subscribe for all the users, you can deactivate some of the evaluation users, 

otherwise some of the users cannot access the Zoho CRM system. 

 

 

http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#Subscription_fields
http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#Subscription_fields
http://zohocrm.wiki.zoho.com/Managing-Subscriptions.html#Subscription_fields
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To activate users 

1. Click the Setup link.  

2. In the Setup page, under the Subscription Manager section, click the Users Activation 

link.  

3. In the Users List page, click Edit.  

4. In the Users List page, change the status of the users (Active/Inactive) according to your 

subscription requirements.  

5. Click Save.  

Viewing Order History 

All your previous orders are archived for a better visibility on your user subscription. 

To view order history 

1. Click the Setup link.  

2. In the Setup page, under the Subscription Manager section, click the Order History link.  

3. In the Order History page, the old order details are displayed with information such as, 

order number, start date/end date, amount, and others.  
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B2C Tutorial 
 

In Zoho CRM, Business-to-Business (B2B) type of business process data is populated. However, 

customers can customize the CRM business process to Business-to-Consumer (B2C) by using 

the Zoho CRM Customization tools.   

In a typical B2C business process, Company Name (Account Name in Zoho CRM) is an 

optional field, hence before using Zoho CRM for B2C type scenario, System Administrator has 

to customize Leads, Contacts, Potentials, Quotes, Orders, and Invoices modules. 

Examples of B2C Companies: amazon.com, ebay.com, or any company directly selling 

products to consumers. 

http://www.amazon.com/
http://www.ebay.com/
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Procedure to customize Zoho CRM for B2C scenario  

 Customize Leads page layout  

 Customize Potentials page layout  

 Customize Quotes, Sales Orders, and Invoices page layout  

Step1: Customize Leads Page Layout  

1. In Zoho CRM, log in with Administrator privilege.  

2. In the Setup -->Lead Settings page, click the Edit Page Layout hyperlink.  

http://zohocrm.wiki.zoho.com/B2C-Tutorial.html#Customize_Leads
http://zohocrm.wiki.zoho.com/B2C-Tutorial.html#Customize_Potentials
http://zohocrm.wiki.zoho.com/B2C-Tutorial.html#Customize_Orders


ZOHO CRM USER MANUAL 
November 

29, 2007 

 

244 ©2007, AdventNet Inc. All rights reserved.  

 

3. In the Edit Page Layout page, click on for the Company field. 

 

 
4. In the Edit Field Properties pop-up page, disable the Mandatory check box for 

Company field and click OK. 

 

 
5. In the Edit Page Layout page, click Save.  

Step 2: Customize Potentials page layout  

1. In Zoho CRM, log in with Administrator privilege.  
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2. In the Setup -->Potentials Settings page, click the Edit Page Layout hyperlink.  

3. In the Edit Page Layout page, click on for the Account Name field.  

4. In the Edit Field Properties pop-up page, disable the Mandatory check box for Account 

Name field and click OK.  

5. In the Edit Page Layout page, click Save.  

Step 3: Customize Quotes, Sales Orders, and Invoices page 

layout  

1. In Zoho CRM, log in with Administrator privilege.  

2. In the Setup -->Quotes/Sales Order/Invoice Settings page, click the Edit Page Layout 

hyperlink.  

3. In the Edit Page Layout page, click on for the Account Name field.  

4. In the Edit Field Properties pop-up page, disable the Mandatory check box for Account 

Name field and click OK.  

5. In the Edit Page Layout page, click Save.  

Once the Account Name field is made an optional field, your Sales Reps can associate business 

opportunities with the Contacts (Consumers) as per B2C process.  

If you are looking for a personalized walk through of Zoho CRM implementation for B2C 

process, please contact us at: support@zohocrm.com  

 

 

 

 

 

 

 

 

 

mailto:support@zohocrm.com
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Personalize your Company Logo 
 

Zoho CRM allows customers to personalize the user interface by replacing the default logo with 

their own company logo, so that employees working with Zoho CRM service will have a 

personalized feel with their CRM service. 

Before Personalization of Company Logo 
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After Personalization of Company Logo 

 
 

How to personalize company logo? 

1. Log in to Zoho CRM with Administrator privileges. 

2. Click on the Setup --> Admin Settings --> Company Details link. 

3. In the Company Details page, change the default Zoho CRM logo with your company 

logo. 

4. Click Save. Now your company logo will be displayed on LHS corner of your CRM 

service.  

Important Note: 

 For a better visibility of the user interface, use 188 x 80 pixels size 

image 

 The file format should be .jpeg, .jpg, .png, or .gif  
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One Step CRM Data Export 
 

No Data Lockup, Export your CRM Data at anytime 

Zoho CRM provides data export (multiple CSV files for modules) functionality for all the CRM 

modules free of cost. After exporting the data, you can perform further analysis or back up in 

your own servers. 

  

Requesting CRM Data Export 

(Available for all editions. Price: USD 10 per request) 

You can use the One-step CRM data Export utility to export your complete CRM data in a 

single step. Your data export request will be processed once your payment is approved. After 

downloading data from your Zoho CRM account, you can back up periodically in your dedicated 

servers. 

Data Export Guidelines 

 CRM Administrator must request for the data export from Zoho CRM account.  

 After receiving the request, Zoho CRM - Representative will verify the request and send 

a confirmation email to CRM Administrator with payment details.  

 After successful payment, data will be uploaded to the Secured Zoho CRM - File 

Server and notification email will be sent to the CRM Administrator within 8 hrs.  
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 After receiving the data export email, CRM Administrator must log in to their Zoho 

CRM account and download the data within 48 hours. 

File Format: CRM data will be in the Comma Separate Value (*.CSV) format compressed in a 

single archive (*.ZIP) file. CSV file can be opened in Text Editor or Spreadsheet program.  

 

How to Order Data Export? 

1. Log in to your Zoho CRM account with Administrator privilege.  

2. Click on the Setup --> Data Administration Tools --> Export All Data link.  

3. In the Data Export Requisition page, your Name, Login ID, and your Email ID are 

displayed (non-editable) based on your Personal Information settings. Please enter No. of 

Export Requests, Contact Number, and Reason for data export for verification 

purpose.  

4. Click on the Submit button. 

 

Zoho CRM - Representative will contact you within 8 hours and send you data export 

procedure email.  
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Zoho CRM - Printing Mailing Labels 
 

Zoho CRM helps you to Print Mailing Labels on-the-fly based on your customer data 

Mailing labels are commonly used on letters and packages to identify the addressee and the 

sender information. These labels are used for various business purposes, such as sending 

monthly billing statement to your customers, sending Greeting Cards during Christmas & New 

Year, or a direct mailer campaign about newly launched customer referral program. In all these 

scenarios, you have to either manually type mailing addresses on a plain paper or use a different 

software to fetch addresses from your customer database, insert addresses in a word processor 

and then use a good quality printer to print the labels.  

Zoho CRM – Print Mailing Labels function helps you to print mailing labels based on the 

existing customer data. You do not require any additional software except Zoho CRM account 

and a good quality laser printer. 

 

To print mailing labels from leads 

1. Click the Leads tab.  

2. In the Lead List view, select the Mailing Labels view.  
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3. In the Lead List view, increase the Records per page to 50, select the leads, and then click 

the Print Mailing Labels button.  

4. In the Print Mailing Labels page, click the Print button.  

If you would like to print labels for more than 50 leads, use the page navigation option in 

list view. 

To print mailing labels from contacts 

1. Click the Contacts tab.  

2. In the Contact List view, select the Mailing Labels view.  

3. In the Contact List view, increase the Records per page to 50, select the contacts, and 

then click the Print Mailing Labels button.  

4. In the Print Mailing Labels page, click the Print button. If you would like to print 

mailing labels for more than 50 contacts, use the page navigation option.  

Important Notes: 

 You can use the default Zoho CRM page settings: A4 size paper, 2-

column layout, and 10 mailing labels per page.  

 Before printing mailing labels, ensure that printer is connected to 

your Computer.  

 Currently default mailing label layout (2 columns, 10 per column) is 

provided, which will be made customizable in future updates.  

 In the current release, Print Mailing Label function is available only 

for leads and contacts modules. In future updates, this function will 

be added in Accounts and Vendors modules, so that you can print 

mailing labels based on your customer companies and suppliers. 

 


